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DANGER

: Indicates that a hazardous situation may arise to cause death or
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procedure is not followed.

CAUTION
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depending on the situation.
The instructions and precautions set forth under the above categories are all important and
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After this instruction manual is read, it must be stored at a predetermined place so that the user
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Usage precautions
DANGER
1. Before operations, provide an emergency stop device and other safeguards because the
servomotor may get out of control or malfunction to create safety hazards due, for
instance, to improper user program debugging.

CAUTION
1. When debugging a user program, you should first debug in relation to the servomotor
before it is mounted in the machine to verify that it does not get out of control, and then
mount it in the machine to conduct a test run.
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CHAPTER 1 INTRODUCTION
This chapter describes the product models and explains how to setup the Programmable
Function.
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1.1

Product Model and Language LEVEL
Note the specification name plate to confirm the model of the servo driver with the
Programmable Function.

Specification
nameplate
(Located on the
front cover for
2kW or more.)

Specification nameplate position
(1.5kW or less)

Drive model
Applicable motor
Maximum capacity
Input rating
Output rating
Production number

Model : ADAX-02LS
kW
:
0.2
Input : 1Ph
V
A 50Hz,60Hz
Input : 3Ph 200-230 V 1.5 A 50Hz,60Hz
Output : 3Ph 230 Vmax 1.7 A
MFG No. 24A T12345 20001
Date: 0204
Hitachi Industrial Equipment
NE17456 -1
MADE IN JAPAN
Systems Co.,Ltd.
Contents of Specification Nameplate

There are two language LEVELs of Programmable Function.They can be distinguished by the
model of servo driver.
In this manual, the new functions of language LEVEL2 are marked as follows. The marked
functions are not available in the old models.
mark
Servo driver model
Versions
Language
LEVEL
(in this manual)
ADAX, ADAX2, ADAX3 Standard version
LEVEL1
Without mark
ADAX4
Enhanced version
LEVEL2
With LEVEL2 mark
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1.2

Installing AHF
The keyword is required for installing AHF with the program editor (Model No. AHF-P02).
Please enter the following keyword into the keyword box.

AHF - P02
Number "0"
Minus sign "-"

For the installation procedure, refer to the instruction manual for Setup Software AHF.
(The keyword input is required in the Step 11[page 1-6 in the AHF instruction manual
NB2711BX].)
Keyword input precautions
1) Enter single-byte alphanumeric characters.
2) If you enter an incorrect keyword, you will be prompted again for keyword input.
3) If the standard AHF-P01 is inadvertently installed, first uninstall it and then install
AHF-P02.
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1.3
1.3.1

Operating the Programmable Function
Enable the Programmable Function
Please change the following parameter to enable the Programmable Function. With the
factory default settings, the Programmable Function is disabled for providing
compatibility with the standard model of the servo drive.
Parameter name
Position command selection

Parameter number

Setting

Default value

FA-22

Pro

PLS

Note 1) When you execute "Offline auto tuning" function, please set FA-22(Position
command selection)="PLS", because the Offline auto tuning function is not
executed correctly when FA-22(Position command selection)="Pro".
Note 2) "Online auto tuning" function cannot be used while executing the
Programmable Function.
Note 3) Please turn the power off after the parameter FA-22(Position command
selection) is changed.

1.3.2

Input/Output terminals and control mode
(1) Digital input/output terminals
When the parameter FA-22(Position command selection) is set to "Pro", some of
the input/output terminals become general-purpose input/output terminals. 12
inputs (X(00)-X(11)) and 8 outputs (Y(00)-Y(07)) can be accessed from the
Programmable Function.
For more details, refer “Section 6.1, Input / Output Terminals”.
The polarities of commands X(00) to X(11) and Y(00) to Y(07), excluding SON and
RS, are "0" in an open state and "1" in a shorted state. Since polarity selections do
not work, make any necessary changes within a user program.
(2) Analog input terminals
When the parameter FA-22(Position command selection) is set to "Pro", the analog
input terminals AI1 and AI2 become general-purpose analog input terminals.
The analog input values (XA(0), XA(1)) can be referred in the program. For more
details, refer “Section 6.6, Input/Output Instructions”.
(3) Control mode
Basically, the drive is operated by the position control mode by the Programmable
Function. When the “speed”, “sync s”, “trq” or “tchg” statement is executed, the
control mode shifts to the speed control mode or the torque control mode. For
more details about those statements, refer “Chapter 6, Instruction Word Reference”.
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(3) Initial Values of variables
The initial values of variables, output terminals and second home position are
shown in the following table.
Item name

From power ON until the first SON

Second SON

P( ), N( ), T( ), U( )
ACC( ), DEC( )

Settings in the Data Window

Previous values
(Can be overwritten with the
value of Data Window if the
data is downloaded.)

Control constants
(J, KFC, etc.)

Settings of parameters Fd-xx.

Previous values (preceding
values in a program)

Output terminals Y( )

All terminals are 0 (OFF).

Second home position

0

LEVEL2 ,The operation of the output terminals Y( ) can be pre-selected by the
parameter FC-46(Output terminal priority function selecting). Don’t use the “chg”
statement with the functionality of FC-46, because the state of terminal becomes
unstable.

FC-45

FC-46

FC-02

Alarm code
output
enable

Output
terminal
priority
function
selecting

Output
terminal
polarity setting

nor

"0"

"0"

"1"

"0"

“chg”
statement

Nonexecution

General-purpose output
terminals
Y(0) – Y(7)
Polarity isn’t changed by FC02.)

Execution

Function selected by “chg”
statement (positive logic)

"1"
"1"

Function selected by “chg”
statement (negative logic)
Nonexecution

"0"
"1"
"0"

output terminal operation

Function selected by FC-46
(positive logic)
Function selected by FC-46
(negative logic)

"1"
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FC-45

FC-46

FC-02

Alarm code
output
enable

Output
terminal
priority
function
selecting

Output
terminal
polarity setting

ALC

"0"

"0"

"1"

"0"

“chg”
statement

Nonexecution

General-purpose output
terminals Y(0) – Y(7)
( Polarity isn’t changed by
FC-02.)

Execution

[Normal status]
Function selected by “chg”
statement
[Trip status]
Alarm code AL1 - AL3
(positive logic)

"1"

Same as above
(negative logic)

"0"

"1"

Non
Execution

"1"
"0"

output terminal operation

[Normal status]
Function selected by FC-46
[Trip status]
Alarm code AL1 - AL3
(positive logic)
Same as above
(negative logic)

"1"
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1.4

Executing the program by SON/RUN terminal
LEVEL2 The program execution function “RUN” can be selected as the second

functionality of SON/RUN terminal. With this function, the program can be executed in the
Servo OFF status (without current supply to the servo motor). Please refer to the
following table.
servo drive type
language
FC-40
start
Method of
LEVEL
program
servo ON/OFF
Input terminal function
terminal
(bit 0)
ADAX,ADAX2,
ADAX3
ADAX4

language
LEVEL 1
language
LEVEL 2

0
Don't set to "1"
0
(SON function)
1
(RUN function)

SON
terminal

SON terminal

SON/RUN
terminal

SON/RUN
terminal

SON/RUN
terminal

“son”, ”soff”
nstruction
statements note2)

Note 1) Please turn off the SON/RUN (LEVEL2) terminal for the urgent stop.
Note 2) For “son”, “soff” statements , see “Chapter 6, Instruction Word Reference”.

1.4.1

Executing the program by SON function (standard function)
(1) Operation overview
As indicated below, the program is executed and the current is supplied to the
servo motor (Servo ON status) by the turn on edge of SON/RUN terminal if the
parameter FA-22(Position command selection)=”Pro”. When the SON/RUN
terminal turns OFF, the program is stopped, and the current to the servo motor is
cut off (Servo OFF status).
Trip

ON

SON terminal

Trip reset

ON

RS terminal
Execution

Stop

Execution

Servo ON

Servo OFF

Servo ON

Stop

Program

Servomotor

Servo OFF

Servo OFF

(2) re-execute the program during servo OFF waiting time
If the parameter FA-24(Servo OFF wait time) is not equal to 0[s], and if the
SON/RUN terminal turns on again during the servo OFF waiting time, the operation
is different by models.
a) Standard version (ADAX,ADAX2,ADAX3)
"Servo off waiting operation" is continued without executing the program again.
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b) Enhanced version (ADAX4)
The program is executed again.
The operation chart is shown in the next page.

Trip

FA-24
SON terminal

ON

Trip reset

ON

Standard model:

RS terminal

non-execution
Execution

Stop

Execution

Stop

Program

Enhancement model:
execution

Servo motor

Servo ON

Servo OFF

Servo OFF

Servo OFF Servo ON

The operation after the execution of motion statements is also different by models.
Refer “1.5 Motion statement executions during servo OFF waiting time”.
Note) If re-execution of program is necessary for the standard model (ADAX, ADAX2,
ADAX3), please turn on the SON terminal after the “servo OFF wait time (FA24)” has passed.
(The operation chart is shown below.)
FA-24
SON/RUN terminal

ON

ON

Stop

Stop

Execution

Execution

Program

Servo operation servo off program operation

1-8
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1.4.2

Executing the program by RUN function terminal (Enhanced version
LEVEL2)
(1) Operation overview
Program is executed without current supply to the motor by turning on the
SON/RUN terminal, if the parameter FA-22(Position command selection)="Pro" and
the parameter FC-40(Input terminal function) bit 0 = "1" (RUN function is assigned
to SON/RUN terminal). The program stops by turning off the SON/RUN terminal.
With this setting, the program doesn't stop in the trip status. While SON/RUN
terminal is on, the current is supplied to the motor by “son” statement (Servo ON
status), and the current is stopped by “soff” statement (Servo OFF status).If the
SON/RUN terminal is turned off during the Servo ON status, the servo motor stops
without control (free run stop).
son
soff
son
command command command trip

son
trip
reset command

ON

RUN terminal
RS terminal

stop

execution

Program
servo motor

servo off

servo off

servo off

servo on

servo off

servo on

servo off

servo on

Note 1) Even if the parameter FC-40(Input terminal function) bit 0 = "1" (to select
RUN function), SON function is selected for the SON/RUN terminal when the
parameter FA-22(Position command selection) = "PLS".
(2) Operation in the trip status
The User program doesn't stop by trips, when RUN function is assigned to the
SON/RUN terminal.
a) During non-motion statements execution
When a trip occurs during a non-motion statement is executed, the current to the
servo motor is stopped (Trip status), but the program is executed even in the trip
status.
During the trip status, a motion statement is ignored (it takes one program step),
and the next statement is executed in the next program step.
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Execution example)
:
:

Processing cycle

Y(01)=1

←a trip occurs !

The program continues.

i

P(00)= P(00)+1000
mov

i+1

P(00) N(00) ACC(0) DEC(0)

The “mov” statement is ignored.

i+2

P(00)= P(00)+1000

i+3

:

For each statement, see “Chapter 6,
Instruction Word Reference”.

:

b) During motion statements execution (non-parallel execution mode )
When a trip occurs during motion statements is executed, except "mov &" and
"imov &" statements , the current to the servo motor is stooped (Trip status) and the
executing motion statement is terminated, and the next statement is executed (in
the next program step).
Execution example)
:
:
mov

Processing cycle
P(00) N(00) ACC(0) DEC(0) ←a trip occurs !

P(00)= P(00)+1000

The program continues.

i~i+n

The following instruction is executed at the next cycle.

i+n+1

Y(00)=1
:

i+n+2
For each statements, see “Chapter 6,
Instruction Word Reference”.

:

n: time of occurring a trip

c) During motion statements execution (parallel execution mode)
When a trip occurs during "mov &" and "imov &" statements is executed, the
current to the servo motor is stopped (Trip status) and the executing motion
statement “mov &” or “imov &” is terminated, and the next statement is executed as
the item a).
Execution example)
:
:
mov

Processing cycle
P(00) N(00) ACC(0) DEC(0)

Y(00)=0
P(00)= P(00)+1000

&

←a trip occurs !

i
"mov &" statement is terminated.

i+1

The program continues.

i+2

Y(00)=1
:

i+3
For each statement, see “Chapter 6,
Instruction Word Reference”.

:

d) Reaction to an Execution Error (E45)
About the reaction to an Execution Error (E45), see the table in the next page.
Please refer the parameter d-46(Program error monitor) to find more details about
the error.

1-10

Chapter 1 Introduction

d-46
value
0
1

2
3
4
5
6
7
8
9
10

11
12
13
14

Contents of Execution Error (E45)

Servo drive's operation when
Execution Error (E45) occurs

Normal status (without any error)

-

After a branch (ex. “goto” statement), the end of nest
(ex. “next” statement) was detected before the start of
nest (ex. “for” statement).
U(xx) was not applicable value for an indirect
reference variable (ex. P(U(xx)) ).
After the “entry” statement, the first motion statement
was executed without required parameters.
The "mov" or "nchg" statement was executed with the
zero speed command ( N(i) = 0 ).
The “mov P(Xn)” statement was executed during all
input terminals were OFF ( Xn = 0 ).
The “smov” statement was executed with the zero
position command ( P(i) = 0 ).
The “trq” or “tchg” statement was executed with the
zero speed limit value ( Ni) = 0 ).
Overflow and underflow occurred in four-arithmeticaloperation commands.
Divide by zero.
The value was out of the numerical value range when
a control variable was overwritten.
The terminal had already been assigned to another
function terminal by the “chg” statement.
COM port wasn’t opened.

The executing statement is
ignored, and the next
statement is executed.

Substitution (operation)
operation is discontinued, and
the next statement is
executed.
(The value of left variable is
not changed)
The executing statement is
ignored, and the next
statement is executed.

The "cam" statement was executed before the
execution of "restore" statement.
A fatal error occurred.
Note 1) For each statement, see “Chapter 6, Instruction Word Reference”.

1.5

Motion statement executions during servo OFF waiting time.
If the parameter FA-24(Servo OFF wait time) is not equal to 0[s], the SON status will be
continued even after the SON (SON/RUN) terminal turns off from on. The actual
operation during the servo OFF waiting time is different by models.
a) Standard version (ADAX,ADAX2,ADAX3)
When the SON terminal is turned off from on, “the operation during servo OFF waiting
time” will be continued during servo OFF waiting time (in only case of FA-24(Servo OFF
waiting time) is not equal to 0[s]). The operation depends on the executed statement as
follows.
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The executing statement
name

Mnemonic

Homing
Positioning instruction
Homing Command
Speed/position control
changeover
Speed control instruction
Motion operation cancellation

hp
mov
ort 0~6
smov

synchronization control
command

sync 1

speed
stop

sync 2
sync s
Torque control

trq

The operation during servo OFF
waiting time
Servo lock under position control
Servo lock under position control
Servo lock under position control
The "smov" instruction continues to
be executed.
Servo lock under speed control
It follows the “operation during servo
OFF waiting time” for the motion
statement that has been stopped.
The "sync 1" instruction continues to
be executed.
The "sync 2" instruction continues to
be executed.
The "sync s" instruction continues to
be executed.
The torque control is executed
continuously with the torque
command value which is specified by
the "trq" statement.

Note 1) For each mnemonic, see “Chapter 6, Instruction Word Reference”.
b) Enhanced version (ADAX4)
When RUN terminal is turned off from on during servo OFF waiting time(in only case of
"FA-24≠0 [s]")(point A in the following chart), you can select the operation of motion
instruction by " Behavior of Servo off selection "(FA-29). The setting parameter and
operation are shown below.
son
soff
son
command command command trip

son
trip
reset command

ON

RUN terminal
RS terminal

stop

execution

Program
servo motor

servo off

servo off

servo on

servo off

servo off

1-12
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The executing instruction
Instruction name
hp statement (return
to home position)
mov statement
(positioning
instruction)
ort statement
(homing)
smov statement
(speed/position
control changeover)
speed statement
(speed control
instruction)
stop statement
(motion operation
stop)
sync statement
(synchronization
control)

Mnemonic
hp

Enbl
dEnbl
Servo lock under position control

mov

Servo lock under position control

ort 0~6

Servo lock under position control

smov

speed

stop

sync 1

sync 2

sync s

cam statement

trq statement (torque
control)

Behavior of Servo off selection (FA-29)

cam s

trq

The position control
Servo lock under position
continues to be executed control
by the value specified by
the "smov" instruction.
Servo lock under speed control

It follows the servo off waiting time operation of motion
instruction that does stop.
The "sync 1" instruction
Servo lock under position
continues to be executed. control
[without the speed bias by
the analog input]
(The position control is
continued according to the
pulse row input.)
The "sync 2" instruction
Servo lock under position
continues to be executed. control
[with the speed bias by
the analog input]
(The position control is
continued according to the
pulse row input.)
The "sync s" instruction
Servo lock under speed
continues to be executed. control
(The speed control is
continued according to the
analog input.)
The "cam" instruction
Servo lock under position
continues to be executed. control
(The electric cam
operation is continued.)
The torque control continues to be executed by the value
specified by the "trq" instruction.

Note 1) For each mnemonic, see Chapter 6, Instruction Word Reference.
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This chapter explains about the procedures for program creation to execution.
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2.1

Language Specifications
The table below shows the language specifications about the Programmable Function for
the Hitachi AC Servo Driver.
Item

Specifications
Standard model

Language
specifications

Enhancement model LEVEL2

Language type

BASIC-like language (homing, position/speed/torque control, synchronized
operation, speed-position control switching operation, speed-torque control
switching operation.)

Input device

IBM PC/AT compatible personal computers (Windows 95/98/Me, Windows
NT4.0, Windows 2000/XP)

Programming
capacity

512 steps (also limited by 6kB)

Programming
support
functions

•
•
•
•
•
•

6KB
(About 1024 step)

Text input
Display (on Windows)
Program syntax check (on Windows)
Program up/down loading and all clear (PC ←→ driver)
Single step
Breakpoints (up to 4 points)

Execution form Interpreter method, 1.12 ms/command
(Subroutine calls available, up to 8 nesting levels)
Input/output
functions

External digital
contact input

For Contact / open-collector circuit (24-VDC internal power supply
provided); servo ON, alarm reset, and general-purpose inputs (12 points,
X(00) to X(11))

External output 8 points (Y(00) to Y(07))

Reserved
words

External
analog input

2 points (XA(0) to XA(1))

Variables

•
•
•
•
•
•
•
•
•
•

Position: P(00) to P(99) (100 points)
Speed: N(00) to N(15) (16 points)
Torque: T(00) to T(15) (16 points)
Acceleration time: ACC(0), ACC(1) (2 points)
Deceleration time: DEC(0), DEC(1) (2 points)
Control mode: MOD
Control gain: KSP, KSI, KP, KFC etc.
Monitor: IFB, IRF, NFB, NRF, POS, PRF, etc.
User-defined variable: U(00) to U(15) (16 points)
Temporary variable: TMP(1) to TMP(8) (8 points)

-

Values can be
stored in
EEPROM

The following are added to the
above-variables.
• Electric cam (MODL,EXD)
• Drive status (STS)
• Free-run timer (TIMER1)
• Capture (PRB1H/L,PRB2H/L)
• Generic parameter (OP0~OP3)
• Electric gear (EGRAN/EGRAND)
• Speed command gain (SPDG)
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Item

Specifications
Standard model

Reserved
words

Commands

1.Program control commands
• Loop (for)
• Unconditional branch (goto)
• Conditional branch
(if, ifs then, select case, until, while)
• Time control (wait)
• Subroutine (call,sub)
• Reading/Writing variables
(load, save)
• Others
entry, end, stop, cont, inc, dec etc.
2.Motion commands
mov, smov, speed, nchg, tchg, trq,
sync, ort, hp, hpset etc.

Enhancement model LEVEL2
The following are added to the
above-commands.
1.Program control commands
• Branch in the trip status
(on trip goto)
2.Motion instructions
• Constant rate of feeding (imov)
• Electric cam (cam,cdata, restore)
3.Input/Output control
• Input/Output priority function
4.Communication control
• MODBUS-RTU(RS-485)
(option )

3.Input/Output control
(Bit number input, Word input, Bit
output, Word output, Change of the
assignment of general input/output )
4.Communication control
(Input/output control of the variable
data from RS-232C port(PC) )
Operator

Calculations : + , − , * , / , Assignment , mod, abs
logical operations : or, and, xor, not
Conditions : =, <, <=, >, >=, <>

Password function

Not supported

Supported
(Alphanumeric character eight
characters or less)
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2.2

Configuration Overview
The program editor function in the setup software AHF various processes for the
Programmable Function; editing/compiling program, downloading/uploading a program
to/from a servo driver, etc.

AHF
Servo amplifier
Program Editor
FUNC
CHARGE

SET

External PC
Uploading and
downloading

Editing and
compiling
User
program

Servomotor

The functions of the program editor are summarized below:
Function

Process performed

Programming/editing

Input, edit, save, load and print a program

Compiling

Compile a edited program

Downloading and Uploading

Download/upload a program to/from a servo driver.

Debugging utility

Execute the downloaded program, 1-step execution, breakpoint
setup, etc.
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2.3

Switching the Instruction Level
(1) AHF version and Instruction Level
The supported Instruction Level is different by the version of AHF as follows. The
setup software AHF automatically switches the Instruction Level according to the
connected servo driver.
Servo driver Type
AHF version

ADAX,ADAX2,ADAX3
Ver.3,
Ver.6 or later
Ver.4,Ver.5
Communication
Connected
Not connected Connected
status
/Not connected
Instruction LEVEL1
O
O note 1)
O note 1)
Level
note 2)
LEVEL2

X

X

X

ADAX4
Ver.6 or later
Connected
/Not connected

O
O

Note1) The setup software AHF (Ver. 6 or later) can be used with the servo driver ADAX,
ADAX2, ADAX3 series. But, please use the Instruction Level 1 only, because the
servo driver doesn’t support the Instruction Level 2.
Note2) The Instruction Level 2 can be selected if the servo driver is not connected. But
please use the Instruction Level 1 only, because the servo driver doesn’t support the
Instruction Level 2.
(2) Manual switching of the Instruction Level (In case the servo driver is not connected )
It is necessary to switch the Instruction Level when the setup software AHF is not
connected with the servo driver. The switching method is described as follows.
1. Select an Instruction Level from the "Setting" menu.
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2.4

Editing a program
A user program can be edited by the Program Editor Function of setup software AHF
witch works on the Microsoft Windows.
The Program Editor has a code region (Code Window) and data region (Data Window).
The Code Window allows you to enter or modify your program source codes to complete
a program. The Data Window permits you to set initial values which are used when a
program starts.
The Program Editor Function provides the syntax checker and the program step counter
before the user program is downloaded into a servo driver. Also the single-step execution
and the break point processing can be set on the Program Editor.

IBM PC/AT compatible
personal computer
Windows GUI
Program Editor
Communication program
(uploading and downloading)

Servo
amplifier
• CodeWindow
Program input
• DataWindow
Data input
• Syntax checkout

• Break
• Single-step execution
• Debug mode

For operating procedures and more detailed instructions, see “Section 5, Program Editor”.
(1) Code Window
The main routine begins
with "entry" statement and
terminates with "end"
statement. Only one main
routine is allowed to exist
in a program.
Subroutines begin with
"sub" statement and
terminate with "end sub"
statement. One or more
subroutines can be written
within a program.

Main routine

Subroutine 1

Subroutine 2
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(2) Data Window
The initial values of variable are defined in the Data Window. The defined values
are used when a program starts. Each variable has one line, which consists of
Variable (variable name), Define (definition formula), Answer (calculation result)
and Comment (user notes). The definition formulas are able to refer the other
variables.
(Example)

P(00)
Variable name

2.5

1000*20+10
Definition formula

20010
Calculation result

Initial Position
User notes

Syntax Checker
The validity of inputted data is checked by every modification on the Code Window.
If there is any syntax error on the entry, an error message appears and the data is not
changed.
The Code Window also checks the numerical range of parameters and the capacity of the
program. After a program is completed, the Code Window generates an intermediate
code for an executable program.
The rules of syntax check;
(1) Label
All alphanumeric characters can be entered.
(2) Mnemonics
Only pre-defined commands and rewritable variables can be entered.
(3) Parameter column (Parm 1 to Parm 6)
The command in the mnemonics column defines the acceptable data type for each
parameter columns. In case the mnemonics column is blank or “<Command group>”,
no data can be inputted into the parameter columns.
(4) Comment column
All alphanumeric characters can be entered.
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The Data Window checks the validity of inputted data in the Define column when the
“calculation” button or “return” key is pressed.
(1) If the inputted data is out of range, a message “xxxxx data range is invalid” appears
and the Answer column reads “<Range invalid>”. The following sample is a case of
the position data.

(2) If the variable to be referenced is illegal, the message "Invalid variable name is used"
appears and the Answer column reads "<Can’t calculate>".

(3) If a reference number of the variable is out of range, the message "Invalid variable
name is used" appears and the Answer column reads "<Can’t calculate>".
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(4) If a character other than an operator (plus, minus, multiply, or divide sign) is
positioned immediately before or after a parenthesis “(“ or “)”, the message "Invalid
computation formula is used!" appears and the Answer column reads "<Can’t
Calculate>".

The acceptable range of variables are indicated below:
Variable

Variable name

Acceptable range

Position variable

P(00) to P(99)

-0x7fffffff to 0x7fffffff (-2147483648 to
2147483647)

Speed variable

N(00) to N(15)

-5000 to 5000

Acceleration variable

ACC(0), ACC(1)

0.00 to 99.99 (when a numerical value is directly
assigned to a variable)

Deceleration variable

DEC(0), DEC(1)

0000 to 9999 1s=100dig (when a value is
substituted from the U() variables etc.) )

Torque variable

T(00) to T(15)

-300 to 300

User variable

U(00) to U(15)

-0x7fffffff to 0x7fffffff (-2147483648 to
2147483647)
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2.6

Program Execution
(1) After an operating program is created with the Code Window, the compiler must be
executed as follows. Then, an intermediate code is generated unless there is any
error in the program.
To execute the compiler, choose “Run”-"Compile" on the menu bar or just click the
“Compile” icon.
Compile

(2) The operating program created with Program Editor can be downloaded into the
servo driver via AHF. To start this download, choose “Run”-"Download" on the menu
bar of Program Editor or just click the “Download (Down)” icon.
(3) The downloaded program is executed when the servo ON terminal is activated while
the servo driver is in the programmed operation mode.

Download
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This chapter shows you how to write a program.

3.1 Coding Form............................................................ 3-2
3.1.1 Line................................................................... 3-2
3.1.2 Label................................................................. 3-2
3.1.3 Mnemonic......................................................... 3-2
3.1.4 Parameters....................................................... 3-2
3.1.5 Comment.......................................................... 3-2
3.2 Data Form ............................................................... 3-3
3.2.1 Variable ............................................................ 3-3
3.2.2 Definition formula ............................................. 3-3
3.2.3 Calculation result.............................................. 3-3
3.2.4 Comment.......................................................... 3-3
3.3 Numerical Values .................................................... 3-4
3.4 Operators ................................................................ 3-5
3.5 Conditions ............................................................... 3-6
3.6 Unit of Position Variables and Speed Variables ..... 3-6
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3.1

Coding Form
Each line consists of a label, an instruction word (mnemonic), instruction word
parameters, and a comment field. However, some instruction words have no parameters.
(Example)

LBL1: mov P(00) N(00) ACC(0) DEC(0) Comment example 2
Comment (Comment)
Parameters (Parm1-6)
Instruction word (Mnemonic)
Label (Label)
The above example shows a case that the motor moves to the target position P(00) with
the speed command N(00).

3.1.1

Line
A line is a unit of program. One instruction word (mnemonic) is written in each line.
Normally, the execution takes 1.12 ms per line. This unit execution time is named “one
step”.

3.1.2

Label
In the label field, any string can be entered as a destination address of branches.
If there is a semicolon (“;”) at the first character of label field, the whole affected line is
commented out. This function helps debugging of a program.

3.1.3

Mnemonic
Write the instruction word to be executed. For more details about on various instruction
words, see “Section 6, Instruction Word Reference”.

3.1.4

Parameters
Write arguments for the execution of the instruction word as needed. Depending on the
instruction word, the arguments exist up to six.

3.1.5

Comment
A comment can be written in the comment field of each line.
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3.2

Data Form
Each variable is defined by one line. Each line consists of variable name, definition
formula, calculation result, and comment fields.
(Example)

P(00)

1000*20+10

20010

Initial position
Comment (Comment)
Calculation result (Answer)
Definition formula (Define)
Variable (Variable)

3.2.1

Variable
In the variable field, the name of a variable to be defined is written. Definable variables
are listed below:
Type

3.2.2

Variable

Position

P(00) to P(99)

Speed

N(00) to N(15)

Torque

T(00) to T(15)

Acceleration time

ACC(0), ACC(1)

Deceleration time

DEC(0), DEC(1)

User-defined variable

U(00) to U(15)

Definition formula
Write a variable definition formula. The other variables are able to be referred from this
definition formula. After formulas are inputted, the answer column leads the value by
the "Calculate" button in the Data Window.
(Example)
20010
P(00) 1000*20+10
P(01) P(00)+100
20110
Definition formula

3.2.3

Calculation result
This column leads the calculation results. The values cannot be overwritten.

3.2.4

Comment
A comment about the variable can be written.
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3.3

Numerical Values
This section shows the numerical values that are applicable to programs and variables.
<Acceptable numerical value range (direct specification)>
Variable name

Variable

Numerical value range

Bit variable

INP etc.

0, 1

User variable

U(00)~U(15)

-2147483648 to 2147483647

Position variable

P(00)~P(99)

-2147483648 to 2147483647

Speed variable

N(00)~N(15)

-5000 to 5000

Acceleration/deceleration time variable

ACC(0), DEC(0)
ACC(1), DEC(1)

0.00 to 99.99

Torque variable

T(00)~T(15)

-300 to 300 Note1)

Control mode variable

MODE

0, 1, 2

Temporary variable

TMP(1) ~TMP(8)

Reserved for the polynomialto-binomial conversion
function.

Note 1) The acceptable numerical value range is from –32768 to 32767, but please do
not exceed the max torque of the servo motor.
< Acceptable numerical value range (indirect specification)>
Variable name
Position variable

Speed variable

Variable

Remarks

P(U(00))~P(U(15))

P(00)~P(99) is indirectly specified by
the value of U(00) ~U(15).(The value
range of U() is "0~99".)

P(Xw),P(Xn)

P(00)~P(99) is indirectly specified by
the value of X(00) ~X(11). For the
detail, see Chapter 6, Instruction Word
Reference.

N(U(00))~N(U(15))

N(00)~N(15) is indirectly specified by
the value of U(00) ~U(15).(The value
range of U() is "0~15".)

<Notation systems>
Symbol

Notation

Remarks

(Omitted)

Decimal

DEC data

&H

Hexadecimal

HEX data
(work in Data Window only)

&B

Binary

BIN data
(work in Data Window only)

• If the calculation result is out of range, the message “xxxxx data range is invalid”
appears and the Answer column reads “<Range invalid>”.
• If a reference number of a the variable is out of range, the message "Invalid variable
name is used" appears and the Answer column reads "<Can’t calculate>".
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3.4

Operators
The following operators can be used within a program:
Format

Operation outline

<Variable 1> = <Variable 2> + <Variable 3>
<Variable 1> = <Variable 2> − <Variable 3>
<Variable 1> = <Variable 2> * <Variable 3>
<Variable 1> = <Variable 2> / <Variable 3>
<Variable 1> = <Variable 2>
<Variable 1> = <Variable 2> mod <Variable 3>
<Variable 1> = <Variable 2> or <Variable 3>
<Variable 1> = <Variable 2> and <Variable 3>
<Variable 1> = <Variable 2> xor <Variable 3>
<Variable 1> = not <Variable 2>
<Variable 1> = abs <Variable 2>

3-5

Addition
Subtraction
Multiplication
Division
Assignment
Modulus
OR logical infix operation
AND logical infix operation
XOR logical infix operation
NOT unary operation
Absolute value operation
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3.5

Conditions
Conditional expressions are used for comparison between two variables. As a result of
operation, either a True value (when a condition is met) or a False value (when a
condition is not met) is obtained.
It’s used for conditional branches such like the "If", "While" statements and so on.
Format
<Variable 1> = <Variable 2>
<Variable 1> < <Variable 2>
<Variable 1> < = <Variable 2>
<Variable 1> > <Variable 2>
<Variable 1> > = <Variable 2>
<Variable 1> < > <Variable 2>

3.6

Operation outline
True when the variables are equal.
True when variable 1 is smaller than variable 2.
True when variable 1 is smaller than or equal to variable 2.
True when variable 1 is greater than variable 2.
True when variable 1 is greater than or equal to variable 2.
True when the variables are not equal.

Unit of Position Variables and Speed Variables
The unit of the position variables and the speed variables is are shown below. It depends
on the type of motor.
Type of the servo motor

Setting unit
Position

Rotation type servo motor ADMG05HPxxxx (Middle inertia type, 500W,
400V class)
Rotation type servo motors other than
the above-type

1dig=1/16384 rotation

1dig=1/32768 rotation

Linear motor

Speed
1dig=1min-1
(changeable
by “SPDG”
variable up to
0.1min-1)

1dig=1pulse
1dig=1mm/s
(The position of a liner
encoder is counted by the 4x
quadrature-count-mode.)
Note1) Please confirm the specification of the encoder in case of a customized model.
Please confirm the resolution of the linear sensor in the 4x quadrature-count-mode
(multiplied by four) in case of a linear motor.
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This chapter explains about the basics of programming with examples.
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The program examples in this section are stored in the "Sample" subfolder under the folder in
which AHF has been installed. The default path is “C:\Program Files\AHF\Sample”.

4.1

Basics of Positioning
(1) Case description
At the first, find the home with the input terminal ORL. Second, move to the position
P(00) when terminal X(00) = 1 (ON). Third, move to the position P(01) when X(00) =
0 (OFF) subsequently.
(2) Terminal connection
Limit switch (home position)
Servo amplifier
Servomotor
P24

U

PLC

V

SON

W

Ball screw

RS
ORG
X(00)

Encoder
ENC
ORL

CM1

Note 1) The connection of the main circuit and the control power supply circuit is omitted.
Please refer to the manual of the “ADAX series with programmable functions” for
details.

(3) Timing diagram
Position:327680pulse

Speed

ACC(0)

DEC(0)
P(00)

Servo lock

0

Position:0pulse

Servo lock

Servo lock

N(02)
ACC(0)

N(00)

ACC(0)

P(01)

DEC(0)

N(01)

SON
ORL

X(00)
(1)

(2)

(3)

(4)
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(4) Program example
• Code Window
Line
001
002
003
004
005
006
007
008
009

Label

LOOP

Numonic
entry
Ort
wait
mov
wait
mov
goto
end

Parm1

Parm2

Parm3

1
X(00)
P(00)
X(00)
P(01)
LOOP

N(00)
=
N(00)
=
N(01)

1
ACC(0)
0
ACC(0)

Parm4

Parm5

ACC(0)

DEC(0)

Parm6
←(1)
←(2)
←(3)
←(4)
←(5)
←(6)

DEC(0)
DEC(0)

• Data Window
Variable Define
P(00) &H8000*10
P(01)

Answer

0

note 1)

Comment
327680

← 10 revolutions=
32768 × 10

0

Variable Define
N(00)
N(01)

1000
3000

Answer

Variable Define
ACC(0)

1.0

Variable Define
DEC(0)

1.0

note 1)

Comment
-1

1000
3000

Answer

←1000min
-1
←3000min

Comment

Answer

Comment
1.00

note 2)

← Time of acceleration
from zero speed to
the maximum
speed
-1
of 5000 min

1.00

note 2)

← Time of deceleration
from the maximum-1
speed of 5000 min to
zero speed

Note 1) The unit of the position and speed changes depending on the type of the servo
motor. Please see section “3.6 Unit of Position and Speed“.
Note2) The maximum speed depends on the specification of each servo motor. Here it
indicates the case of 5000min-1.
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(5) Operation and program descriptions
The program is executed by the terminal SON = ON.
(1) A low-speed homing (reverse) operation is performed with the acceleration time
ACC(0) and the speed command N(00) to find the home position.
When the terminal ORL turns from OFF to ON, the motor stops quickly, and that
position is detected as the home position.
(2) The program waits until the terminal X(00) turns ON.
(3) Move to the position P(00) with the speed command N(00), the acceleration time
ACC(0) and the deceleration time DEC(0). (The ACC(0) and DEC(0) are not the
time to finish the acceleration or deceleration. It’s the ratio to change the speed
between the zero speed and the maximum speed of the motor.
(4) The program waits until the terminal X(00) turns OFF.
(5) Move to the position P(01) with the speed command N(01), the acceleration time
ACC(0) and the deceleration time DEC(0).
(6) The program returns to Step (2).
Note 1) In the line 002, the “ort 1” statement (reversal Low-speed homing) is
executed with the speed command N(00) =1000min-1. However, the maximum
value of parameter Fb-13 (Homing speed 2 (low speed)) is 999 min-1 , so it will
be limited to 999min-1 automatically. If you set high speed for homing, the
position of motor might undershoot during deceleration and the home position
might get error. Therefore, please set the speed around 30~100 min-1.
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4.2

Multistage Positioning (By Bit command Xn)

(1) Case description
At the first, find the home with the input terminal ORL. After that, if the terminal X(11)
= 1 , the servomotor moves to the position P(Xn) witch is selected by the one of the
terminals from X(00) to X(07). If, for instance, the terminal X(07) = ON, the
servomotor moves to the position P(07). If the terminals X(07) and X(01) are
simultaneously ON, the servomotor moves to the position P(01) because the “mov
P(Xn)” statement puts the higher priority on the lower number.
(2) Terminal connection
Limit switch
(home position)
Servo amplifier
Servomotor
P24

U

PLC

V

SON

W

Ball screw

Encoder

RS
X(00)

ENC
ORL

X(07)
ORG
X(11)
CM1

Note 1) The connection of the main circuit and the control power supply circuit is omitted.
Please refer to the manual of the “ADAX series with programmable functions” for
details.
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(3) Timing diagram
Position :327680 pulses

Speed

ACC(0)
Servo lock

0

N(00)

N(00)

P(00)

P(01)

DEC(0)

ACC(0)
N(01)

655360 pulses

0 pulse

DEC(0)
ACC(0)

P(11)
DEC(0)

ACC(0)
N(00)

SON
ORG
ORL
ON

X(11)
ON
OFF

X(00)

OFF

ON
OFF

X(01)

OFF

OFF

X(02)

OFF

OFF
ON

X(07)

OFF

OFF

(1)

(2)

(3)

(2)'
(4)
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(4) Program example
• Code Window
Line
001
002
003
004
005
006
007

Label

LOOP

Numonic
entry
chgORG=
ort
wait
mov
goto
end

Parm1

Parm2

Parm3

default
1
X(11)
P(Xn)
LOOP

N(01)
=
N(00)

1
ACC(0)

Parm4

Parm5

ACC(0)

DEC(0)

Parm6

←(1)
←(2) note 1)
←(3)
←(4)

DEC(0)

• Data Window
Variable
P(00)
P(01)
P(02)
P(03)
P(04)
P(05)
P(06)
P(07)
P(11)

Define
&H8000*10
&H8000*20
&H8000*30
&H8000*40
&H8000*50
&H8000*60
&H8000*70
&H8000*80

Answer

0

←10 revolutions=32768 × 10
←20 revolutions=32768 × 20
←30 revolutions=32768 × 30
←40 revolutions=32768 × 40
←50 revolutions=32768 × 50
←60 revolutions=32768 × 60
←70 revolutions=32768 × 70
←80 revolutions=32768 × 80
← Returns to the home
position if no terminal
input is provided.

0

Variable Define
N(00)
N(01)

1000
30

Variable Define
ACC(0)

1.0

Variable Define
DEC(0)

1.0

note 2)

Comment
327680
655360
983040
1310720
1638400
1966080
2293760
2621440

Answer

Comment

Answer

←1000min
-1
← 30min

Comment

Comment
1.00

note 2)

← Time of acceleration from
zero speed to the
maximum
speed of 5000
-1
min

1.00

Answer

note 2)
-1

1000
30

note 3)

← Time of deceleration from
the maximum
speed of
-1
5000 min to zero speed

Note 1) Please connect a stable switching circuit (i.e. transistor) for the terminal X(11). If
there is chattering on the signal, it cause an execution error (E45) because the value
of P(Xn) becomes illegal in the step (3). In case chattering can’t be avoided, please
replace the step (2) by the following instructions.
wait X(11)=0
wait X(11)=1
Note 2) The unit of the position and speed changes depending on the type of the servo
motor. Please see section “3.6 Unit of Position and Speed".
Note 3) The maximum speed depends on the specification of each servo motor. Here it
indicates the case of 5000min-1.
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(5) Operation and program descriptions
The program is executed by the terminal SON = ON.
(1) A low-speed homing (reverse) operation is performed with the acceleration time
ACC(0) and the speed command N(00) to find the home position.
When the terminal ORL turns from OFF to ON, the motor stops quickly, and that
position is detected as the home position.
(2) The program waits until the terminal X(11) turns ON.
(3) Move to the position P(00), since only X(00) is ON among the terminals X(00)X(07).
(4) The program returns to Step (2).
(2)’ The program waits until the terminal X(11) turns ON.
(3)' Move to the position P(01), since X(00) = OFF, X(01) = ON, X(02) to X(06) =
OFF, and X(07) = ON (Even the terminal X(07)=ON, the lower number terminal
X(01)=ON has higher priority.)
(4)' The program returns to Step (2).
(2)'' Move to the position P(11), since X(00) to X(07) = OFF and X(11) = ON.
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4.3

Multistage Positioning (By Binary command Xw)
(1) Case description
At the first, find the home with the input terminal ORL. After that, when X(11) = 0 the
servomotor moves to the position P(Xw) which is selected by the binary input value
“Xw” on the terminals X(00) to X(03).
(2) Terminal connection
Limit switch
(home position)

Servo amplifier
Servomotor
P24

U

PLC

V

SON

W

Ball screw

Encoder

RS
X(11)
X(00)

ENC
ORL

X(03)
ORG
CM1

Note 1) The connection of the main circuit and the control power supply circuit is omitted.
Please refer to the manual of the “ADAX series with programmable functions” for
details.
Note 2) Please keep OFF the unused terminals X(07) ~X(10). An execution error (E45)
occurs if the binary input Xw becomes more than 99 (= maximum reference number
of the position variable P()).
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(3) Timing diagram

Position :327680 pulses
N(00)

Speed

P(00)

0

N(00)

ACC(0)

P(01)

1310720 pulse

N(00)
DEC(0)

DEC(0)

ACC(0)

655360 pulses

DEC(0)

ACC(0)

P(03)

Servo lock
ACC(0)
N(01)

SON
ORG
ORL
X(11)
ON

ON

X(00)

OFF
(4)'

ON

X(01)

OFF

OFF

X(02)

OFF

OFF

OFF

X(03)

OFF

OFF

OFF

(1)

(2)

(3)

(2)'
(4)
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(4) Program example
• Code Window
Line
001
002
003
004
005
006
007

Label

LOOP

Numonic
entry
chgORG=
ort
wait
mov
goto
end

Parm1

Parm2

Parm3

default
1
X(11)
P(Xw)
LOOP

N(01)
=
N(00)

0
ACC(0)

Parm4

Parm5

ACC(0)

DEC(0)

Parm6

←(1)
←(2) note 1)
←(3)
←(4)

DEC(0)

• Data Window
Variable
P(00)
P(01)
P(02)
P(03)
P(04)
P(05)
P(06)
P(07)
P(08)
P(09)
P(10)
P(11)
P(12)
P(13)
P(14)
P(15)

Define
&H8000*10
&H8000*20
&H8000*30
&H8000*40
&H8000*50
&H8000*60
&H8000*70
&H8000*80
&H8000*90
&H8000*100
&H8000*110
&H8000*120
&H8000*130
&H8000*140
&H8000*150
&H8000*160

Answer

Variable Define
N(00)
N(01)

1000
30

Variable Define
ACC(0)

1.0

Variable Define
DEC(0)

1.0

note 2)

Comment
327680
655360
983040
1310720
1638400
1966080
2293760
2621440
2949120
3276800
3604480
3932160
4259840
4587520
4915200
5242880

Answer

←10 revolutions=32768 × 10
←20 revolutions=32768 × 20
←30 revolutions=32768 × 30
←40 revolutions=32768 × 40
←50 revolutions=32768 × 50
←60 revolutions=32768 × 60
←70 revolutions=32768 × 70
←80 revolutions=32768 × 80
←90 revolutions=32768 × 90
←100 revolutions=32768 × 100
←110 revolutions=32768 × 110
←120 revolutions=32768 × 120
←130 revolutions=32768 × 130
←140 revolutions=32768 × 140
←150 revolutions=32768 × 150
←160 revolutions=32768 × 160

Comment

Answer

←1000min
-1
← 30min

Comment

Comment
1.00

note 3)

← Time of acceleration to a
maximum
speed of 5000
-1
min

1.00

Answer

note 2)
-1

1000
30

note 3)

← Time of deceleration to a
maximum
speed of 5000
-1
min

Note 1) Please connect a stable switching circuit (i.e. transistor) for the terminal X(11). If
there is chattering on the signal, it cause an execution error (E45) because the value
of P(Xn) becomes illegal in the step (3). In case chattering can’t be avoided, please
replace the step (2) by the following instructions.
wait X(11)=0
wait X(11)=1
Note 2) The unit of the position and speed changes depending on the type of the servo
motor. Please see section “3.6 Unit of Position and Speed".
Note 3) The maximum speed depends on the specification of each servo motor. Here it
indicates the case of 5000min-1.
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(5) Operation and program descriptions
The program is executed by the terminal SON = ON.
(1) A low-speed homing (reverse) operation is performed with the acceleration time
ACC(0) and the speed command N(00) to find the home position.
When the terminal ORL turns from OFF to ON, the motor stops quickly, and that
position is detected as the home position.
(2) The program wait until the terminal X(11) turns OFF.
(3) Move to the position P(00), since X(00) to X(11) = OFF.
(4) The program returns to Step (2).
(2)' The program waits until the terminal X(11) turns OFF.
(3)' Move to the position P(01), since X(00) = ON and X(01) to X(11) = OFF.
(4)' The program returns to Step (2).
(2)“ The program waits until the terminal X(11) turns OFF.
(3)'' Move to the position P(03), since X(00) and X(01) = ON and X(02) to X(11) =
OFF.
(4)'' The program returns to Step (2).
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4.4

Multistage Positioning (Input Terminal Conditions)
(1) Case description
At the first, find the home with the input terminal ORL. After that, when X(11) = 1, the
servomotor moves to the following position depending on the status of the terminals
X(00) to X(03).

X(03)
0
0
0
0
1
1

Input terminal
X(01)
0
0
1
1
0
1
Other

X(02)
0
0
0
1
1
1

X(00)
0
1
1
0
1
1

Data
0
1
3
6
13
15

Target
position
P(00)
P(01)
P(02)
P(03)
P(04)
P(05)
P(06)

(2) Terminal connection
Limit switch
(home position)

Servo amplifier
Servomotor
P24

U

PLC

V

SON

W

Ball screw

Encoder

RS
X(11)
X(00)

ENC
ORL

X(03)
ORG
CM1

Note 1) The connection of the main circuit and the control power supply circuit is omitted.
Please refer to the manual of the “ADAX series with programmable functions” for
details.
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(3) Timing diagram
Position :327680 pulses

Speed
0

655360 pulses

N(00)

N(00)

N(00)

P(00)

P(01)

P(02)

ACC(0)

ACC(0)

983040 pulse

0 pulse

DEC(0)

Servo lock
ACC(0)

ACC(0)

DEC(0)

DEC(0)

N(02)

ACC(0)

P(06)

DEC(0)

N(01)

SON
ORG
ORL
X(11)
ON

X(00)

ON
OFF

OFF
ON

X(01)

ON

OFF

OFF

ON

X(02)

OFF

OFF

OFF
ON

X(03)

OFF

OFF

(11)
(1)

(2)

(3) (4)

(2)'
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(4) Program example
• Code Window
Line
001
002
003

Label

LOOP

Numonic
entry
chgORG=
ort
wait
U(00)=
select
case
mov
case
mov
case
mov
case
mov
case
mov
case
mov
case else
mov
end select
goto
end

Parm1
default
1
X(11)
Xw
U(00)
0
P(00)
1
P(01)
3
P(02)
6
P(03)
13
P(04)
15
P(05)
P(06)

Parm2

Parm3

N(02)
=
and

1
15

Parm4

Parm5

ACC(0)

DEC(0)

Parm6

←(1)
←(2)

←(3)
←(4)
←(5)
←(6)
←(7)
←(8)

N(00)
N(00)
N(00)
N(00)
N(00)
N(00)

←(9)
←(10)

N(01)

LOOP

←(11)

• Data Window
Variable
P(00)
P(01)
P(02)
P(03)
P(04)
P(05)
P(06)

Define
&H8000*10
&H8000*20
&H8000*30
&H8000*40
&H8000*50
&H8000*60
0

Answer

Variable Define
N(00)
N(01)
N(02)

1000
3000
30

Variable Define
ACC(0)

1.0

Variable Define
DEC(0)

1.0

note 1)

Comment
327680
655360
983040
1310720
1638400
1966080
0

Answer

←10 revolutions=32768 × 10
←20 revolutions=32768 × 20
←30 revolutions=32768 × 30
←40 revolutions=32768 × 40
←50 revolutions=32768 × 50
←60 revolutions=32768 × 60

Comment

Answer

←1000min
-1
←3000min
-1
← 30min

Comment

Comment
1.00

note2)

← Time of acceleration to a
maximum
speed of 5000
-1
min

1.00

Answer

note 1)
-1

1000
3000
30

note 2)

← Time of deceleration to a
maximum
speed of 5000
-1
min

Note 1) The unit of the position and speed changes depending on the type of the servo
motor. Please see section “3.6 Unit of Position and Speed ".
Note 2) The maximum speed depends on the specification of each servo motor. Here it
indicates the case of 5000min-1.
4-15

Chapter 4 Basics of Programming

(5) Operation and program descriptions
The program is executed by the terminal SON = ON.
(1) A low-speed homing (reverse) operation is performed with the acceleration time
ACC(0) and the speed command N(00) to find the home position.
When the terminal ORL turns from OFF to ON, the motor stops quickly, and that
position is detected as the home position.
(2) The program waits until the terminal X(11) turns ON.
The information of terminals X(11) to X(04) is masked with the &H000F. Only
the information of terminals X(03) to X(00) will be handed to the following steps.
(3)(4) Move to the position P(00), since X(00) to X(3) = OFF.
(11) The program returns to Step (2).
(2)’ The program waits until the terminal X(11) turns ON.
(5)(6) Move to the position P(01), since X(00) = ON and X(01) to X(03) = OFF.
(11)' The program returns to Step (2).
(2)’’ The program waits until the terminal X(11) turns ON.
(7)(8) Move to the position P(02), since X(00) = ON, X(01) = ON, and X(02) to X(3) =
OFF.
(11)'' The program returns to Step (2).
(2)’’’ The program waits until the terminal X(11) turns ON.
(9)(10) Move to the position P(06), since X(00) = OFF and X(01) to X(3) = ON.
(11)’’’ The program returns to Step (2).
(2)’’’’ The program waits until the terminal X(11) turns ON.
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This chapter describes the Program Editor functions and the way to use.
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5.1

Launching and Exiting
This section shows how to launch and exit the Program Editor.
(1) Launching
(1) From the start menu on the taskbar, choose [All Programs (P)], point to [AHF],
and then click [AHF].
(2) The following “AHF opening window” opens when it starts up.

(3) If you use the Program Editor with the connection between PC and the driver,
click the [Connect (C)] button.
(4) Click the [Program (P)] button in the opening window to start the Program Editor.
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(2) Exiting
(1) Click [Exit (E)] on the [File] pull-down menu or click
of the window.

in the upper right corner

(2) If an edited program is not saved yet, the following message appears:

Yes (Y): Saves the edited program and exits.
No (N): Exits without saving the edited program.
Cancel: Cancels the exiting process of the Program Editor.
(3) If no program is being edited, the following message appears:

Yes (Y): Exits Program Editor.
No (N): Cancels the exiting process of the Program Editor.
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5.2

Program Creation Flow
The program creation flowchart for the Programmable Function is shown below:

START

Creating a new program (5.3 (1))

Assigning a file name (5.4 (1))

Writing a program in the Code Window (5.4 (2)) or (5.5)

Setting the variables' initial values in the Data Window (5.6)

Temporary Saving the created program (5.3 (2))

Editing (5.5)

Compiling (5.7)

Compiling
completed?

No

Yes

Downloading (5.8)

Operational checkout (5.11)

Operations
normal?

No

Yes
Saving the created program (5.3 (4))

* Parenthesized numbers indicate the
sections you should refer to.

END
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5.3

File Management
This section shows how to save or load a program that is created by the Program Editor.
(1) Creating a new program
1) On the [File] pull-down menu, click [New (N)]. (Pressing the [Ctrl] and [N] keys
simultaneously performs the same action.)

2)

Discard the currently edited program and begins to edit a new program.

(2) Saving a new program file
To save a new program, perform the following procedure:
1)

On the [File] pull-down menu, click [Save As (A)]. (Pressing the [Ctrl] and [A]
keys simultaneously performs the same action.)

2)

The [Save As] dialog box opens.

3)

Click the [Save (S)] button to save the currently edited program. The “file name”
is identical with the “program name” in the point 1). You can select either "acs"
or "csv" as a file type.

NOTE: You should normally choose "acs" as a file type. Choose "csv" only when you use
the Microsoft Excel or similar software for editing purposes.
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(3) Opening an existing file
1)

On the [File] pull-down menu, click [Open program (O)]. (Clicking the
button or simultaneously pressing the [Ctrl] and [O] keys performs the same
action.)

2)

The [Open] dialog box opens.

3)

Click the [Open (O)] button to load a selected program. Either "acs" or "csv" can
be chosen as a file type.

(4) Saving a file (overwriting the previous file )
1)

On the [File] pull-down menu, click [Save program (S)]. (Clicking the
button or simultaneously pressing the [Ctrl] and [S] keys performs the same
action.)

2)

The program file is then saved with the name in the program name field.
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5.4

Code Window Input Procedures
If the Data Window is open, click the Code Window tab to switch to the Code Window.

 The program name is displayed.
 It shows the last line of editing program.

 In the Comment column, you can enter remarks about coding. Although the
comment entry is saved into the source file, it will not be included in the compiled
executable file. Therefore, comment entry will be lost when the program is
uploaded from a servo driver.
 In the Parm1 to Parm6 columns, enter parameters as appropriate for each
statement in the Mnemonic column.
 In the Mnemonic column, enter a pre-defined statement or a variable that stores the
result of computation.
 In the Label column, enter the name of the label that points to the current line. This label
name entry specifies the jump destination for IF statements or GOTO statements. The
label name needs to be unique. If the same label name is entered in two or more lines, an
error occurs at the time of compiling.
 Up to 6KB (about 1024 steps) of instructions can be entered in the Code Window. The total
number of steps appears on the display when compilation finishes successfully.
 The validity of statements and parameters are checked when they are entered. If there is an invalid
entry, an error message appears, and the entry is cancelled. You are not allowed to enter any data into
cells that require no entry.
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(1) Entering a file name
The Program Name field shows the file name of the program. (The default value is
"NewFile" when Program Editor starts up or when a new program is created.)
To prevent careless overwriting on the saved programs, assign a name to a program
at the beginning.

(The [Save as (A)] procedure (see Section 5.3.(2)) allows you to use a file name
which is different from the program name.)
(2) Writing a program
A) Making entries from the Code Input Tab
The Program Editor enables you to enter statements easily with the Code Input
Tab. If you are not familiar with the syntax, it’s better to use this input method.
Click the Line column or Mnemonic column, and choose a button from the Code
Input Tab with the mouse, then a line is inserted with a statement or a variable
before the selected line in the Code Window.
If a cell of Parm1 - Parm6 column is selected, only the cell is overwritten.
<Operating example>
(1) Click the [structr if] (structure if) button on the code input tab.
(2) A “ifs” (structure if) statement is inserted before the currently selected line in the
Code Window.

(1)
(2)

(3)
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(3) After the insert of a new line, please replace the messages with the angle
brackets “<” and “>” by proper statements, variables, operators, values or
characters.
(If the blanketed message is not replaced by the user, the cell is treated as an empty cell
by the compiler. )
Example)
<Conditional variable>,
<Conditional variable/numerical value>........Variable or numerical value (-128 to +127)
<Comparative mark>....................................."=", "<", "<=", ">", ">=", "<>"
<Instructions>................................................Various instructions or computation variables
* Some buttons on the Code Input Tab are grayed-out when those statements/variables
don’t fit in the selected cell.
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B) Making entries from a pull-down list
When you select a cell that accepts an entry, the button
may appear at the
rightmost end of the cell. It means that you can choose an entry from a list.
(1) Click the button

or press the [Space] key.

(1)

(2) A pull-down list opens to indicate the available data set for the cell.

(3)
(2)

(3) Only a part of the list can be indicated at once. Adjust the vertical scroll bar
at the rightmost end of the list to see the other part of list.
(4) Find out an entry you want to use, and then click it with the mouse. (The
same action will be performed when you search a parameter with the [↑] or
[↓] keys and select it with the [Enter] key.)
(5) The selected entry is assigned to the cell.
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C) Making entries from the keyboard
You can also type entries directly from the keyboard.
(1) Select a cell with the mouse.
(2) Type entry from the keyboard.

(1)
(2)

(3) Then, press the [Tab] key or [→] key.
(4) The cell in the next column is selected.

(4)
*

If there is an invalid entry, an error message appears, and the entry is
cancelled.

<--Replaced
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(3) Polynomial computation
The Programmable Function cannot handle polynomials in one line. The “polynomialto-binomial conversion function” helps users to convert a polynomial into binomials
which can be handled by the Programmable Function. The temporary variables
TMP(1) to TMP(8) (reserved by system) are used for buffering by the polynomial-tobinomial conversion function.
* The variables TMP(1) to TMP(8) are reserved by system. Users are not allowed to
refer/overwrite them.
1) On the [Run] menu, click [Polynomial Expression]. The polynomial-to-binomial
conversion dialog box then opens. (The same action will be performed when
you simultaneously press the [Ctrl] and [T] keys.)

2) On the left-hand side, choose a variable for the answer. Just click the button
and choose a variable from the list.

(2)

3) On the right-hand side, type a polynomial.

(3)

The typed polynomial is cleared by the [Clear] button.
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4)

Click the [Execute] button. Then, the converted binomials are inserted into the
Code Window.

(4)

* If the given polynomial is too long, an error occurs due to the short of temporary
variable.
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5.5

Editing a Program
This section explains about the editing functions which support a programming activity.

The editing functions can be utilized not only in the Code Window but also in the Data
Window (see Section 5.6).
(1) Undo
This function is operative after any modification on the program. It arrows to cancel
the last action you performed. (But the action to select a mnemonic from the pulldown list is not recorded.) To use this function, click [Undo] on the [Edit] menu. (The
same action will be performed when you click the
press the [Ctrl] and [R] keys.)
<Operating example>
(1) Initial state
(2) Click the [Structure if] button
on the code input tab.

button or simultaneously

(3) Execute the "Undo"
function.

(2) Redo
This function is operative after the execution of the "Undo" function. It restore the
last cancelled action. To use this function, click [Redo] on the [Edit] menu. (The
same action will be performed when you click the
press the [Ctrl] and [U] keys.)
(1) In the initial state, click the
[Structure if] button.

(2) Execute the
"Undo" function.
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(3) Cut
This function cuts one or more selected lines. You can use this function to delete
unnecessary program by lines.
(1) Select the lines you want to cut.
(1) Left-click on the first line to be
cut.

(2) Drag the mouse to the last line to
be cut.
(3) The green colored lines are
selected.

(2) On the [Edit] menu, click [Cut]. (The same action will be performed when you
click the

button or simultaneously press the [Ctrl] and [X] keys.)

(3) The selected lines are then cut and retained until the "Paste" function is
executed later. The lines below the cut lines are then shifted upward.
Cut

Shifted
upward
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(4) Copy
This function copies one or more selected lines.
(1) Select the lines you want to copy.
(2) On the [Edit] menu, click [Copy]. (The same action will be performed when you
click the

button or simultaneously press the [Ctrl] and [C] keys.)

(3) The selected lines are then copied and retained until the "Paste" function is
executed later.

(1)

(3)

(5) Paste
This function is operative after the "Cut" or "Copy" function is executed. The Paste
function pastes cut or copied lines.
(1) Select the line you want to paste the cut or copied data.
(2) On the [Edit] menu, click [Paste]. (The same action will be performed when you
click the

button or simultaneously press the [Ctrl] and [V] keys.)

(3) The selected cut/copied lines are then inserted before the selected line. (When
more than one lines are selected in the step (1), the cut or copied lines overwrite
the selected lines.)

(1)
Paste
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(6) Insert
This function inserts a blank line.
(1) Select a line.
(2) On the [Edit] menu, click [Insert]. (The same action will be performed when you
simultaneously press the [Ctrl] and [I] keys.)
(3) A blank line is then inserted just before the selected line.
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(7) Find
This function searches selected lines for a search string.
(1) On the [Edit] menu, click [Find (F)]. (The same action will be performed when
you click the

button or simultaneously press the [Ctrl] and [F] keys.)

(2) The "Find" dialog box opens.

(3) Enter the search string. Click the "Find" button to search it.
(4) If you click the [Cancel] button, the Find dialog box closes.
(5) If you click the [Replace] button, the system switches to the Replace function
(see Section 5.5.8).
(8) Replace
This function searches selected lines for a search string and then replaces it with a
replace string.
(1) On the [Edit] menu, click [Replace (H)]. (The same action will be performed
when you simultaneously press the [Ctrl] and [H] keys.)
(2) The [Replace] dialog box opens.

(3) Enter the search string and the replace string. Click the [Replace] or [All
Replace] button to replace strings. The [Replace] button allows single
replacement only.
(4) If you click the [Cancel] button, the Replace dialog box closes.
(5) If you click the [Find Next] button, a found string will be high-lighted. Please
confirm whether the high-lighted string should be replaced or not by [Replace] or
[Find Next] button.
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Since AHF Ver.6
(9) Cut & Paste function between program editors
A part of program can be cut and pasted between files, if two or more editor windows
are opened. It is possible to paste it on other Windows applications via clipboard.
(1) Select the copy area. Click on the first line of copy area, and click again on the
last line of copy area while pushing the SHIFT key, then the copy area is
selected and greens.

(2) On the [Edit] menu, click [Copy (C)]. (The same pull-down menu is displayed by
a right-click on the code window.)

The program in the clipboard can be pasted on other text editors or MS-EXCEL.
If the program written in the text editor or MS-EXCEL is copied to the clipboard, it can
be pasted on the editor window.
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(3) Open another program editor window, set the cursor on the paste position, and
click [Paste] on [edit] menu. (The same pull-down menu is displayed by a rightclick on the code window.)

(4) The copied data on the clipboard is inserted before the cursor position.
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Since AHF Ver.6
(10) Program insert function
The program can be inserted before the cursor position.
(1) Set the cursor on the insert position, click [Insert Program] on [edit] menu. (The
same pull-down menu is displayed by a right-click on the code window.)

(2) Select an inserted file in the file selection dialog box.

Note 1) Only the CSV files saved by this editor can be inserted.
Note 2) If the specified file isn't the program data, or it’s not a CSV format, an error
message is displayed as follows.
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5.6

Data Window Input Procedures

The Data Window (data area input window) define the default value of variables. The
variables are initialized at the beginning of program execution.
In case the Code Window is displayed, click the Data Window tab to switch to the Data
Window.

 Variables are switched by the Variable tab P() / N()ACC()DEC() / T() / U().
 Click the [Calculate] button to calculate and set results into variables.

 In the Comment column, you can enter remarks about coding. Although
the comment entry is saved into the source file, it will not be included in
the compiled executable file. Therefore, comment entry will be lost when
the program is uploaded from a servo driver.
 The Answer column shows the default value at the beginning of program execution.
 In the Define column, not only values but also formulas can be used for variables.
 The Variable column shows the names of variables. Adjust the vertical scroll bar at the right
end of the window to see the other part of list.
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(1) Entering variables
Here, default values of the variables are defined. In the Define column, not only
immediate data but also formulas can be used.
(1) Enter an immediate value or a formula into each cell of the Define column.
The formulas can contain plus, minus, multiply, divide signs and parentheses “(”
and ”)”. Immediate values and calculation results must be inside upper and
lower limits of the variable.
(2) Click the [Calculate] button, after entry.

(2)
(1)

(3) The calculation results appear in the Answer column.

(3)
* If a referred variable is defined by another reference to a variable, an error
message appears and the Answer column reads “Can’t calculate”.

* If a calculation result is outside the variable's upper or lower limit, an error
message appears and the Answer column reads “<Range invalid>”.
The upper and lower limits on the variables are shown below:
Item
number

Variable

Upper and lower limit values

1

Position variable (P(00) to P(99))

+2147483647 to –2147483648

2

Speed variable (N(00) to N(15))

5000 to 0

3

Acceleration time (ACC(0) to ACC(1))

99.99 to 0

4

Deceleration time (DEC(0) to DEC(1))

99.99 to 0

5

Torque variable (T(0) to T(15))

+300 to –300

6

User variable (U(0) to U(15))

+2147483647 to -2147483648

note 1)

Note 1) The acceptable numerical value range is from –32768 to 32767, but please
do not exceed the max torque of the servo motor.
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(2) Teaching
Using the teaching function, you can actually operate the servomotor to find the
proper position data for each motion of the application. Teaching can be conducted
by AHF or Digital Operator or an optional Teaching Unit. For the operating
procedures by Digital Operator, see “Chapter 4, Operation” of the servo drive
instruction manual. For the optional Teaching Unit, see “Chapter 10, Optional
Function” of the servo drive instruction manual.
 In the Feed Pulse field, enter a position command value for the servo motor. It always
displays that “1rev./32768”, but some motors require different pulses for one rotation. See “3.6
Unit of position variables and speed variables”.
 The Actual Position field shows the actual position of the servomotor.
 In the Speed Command field, enter a speed command value for the teaching
operation.
 In the Teaching Position field, select a position variable to save the
actual position after the teaching operation.

 By the [Teach] button, the actual position is saved into the selected position
variable.
 By the [Reverse] button, the servomotor rotates backward by the amount of the
Feed Pulse setting.
 By the [Stop] button, the servomotor stops at the current position.
 By the [Forward] button, the servomotor rotates forward by the amount of the Feed Pulse
setting.

(1) Make sure that the servo drive is connected, and enter a value in the [Feed
Pulse] field.
(2) Click the [Forward] button if the target position is in the forward direction. On the
other hand, click the [Reverse] button if the target position is in the backward
direction.
(3) The servomotor rotates according to the setting.
(4) The servomotor stops after it travels the distance of the [Feed Pulse] setting.
(5) Repeat steps (1) through (4) until the servomotor reaches at the target position.
(6) In the [Teaching Position] field, select a position variable in which the actual
position will be stored.
(7) Click the [Teach] button. The [Actual Position] is then stored into the Define
column of the selected position variable.
(8) Click the [Stop] button to shift to the Servo OFF status.
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5.7

Compiling a Program
After a program is completed, the program should be compiled.
(1) On the [Run] menu, click [Compile]. (The same action will be performed when you
click the

button or simultaneously press the [Shift] and [F9] keys.)

(2) The compiling function is then executed. If there is no error, a message appears to
indicate a normal end so that you can download it into the driver.
[For AHF Ver.5 or older]

[For AHF Ver.6 or later]

Note 1) The progress bar in the figure below is
displayed while compiling process runs. The
compiling process can be terminated by the [Cancel]
button.

If [Show program nest at compiling] is checked on the [View] menu, the LABEL field
shows a color-identified nesting level. It helps to understand the nesting structure
easily.
* If there is an error, an message appears to indicate the reason of error. In that
case, correct the program in accordance with the message.
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5.8

Downloading a Program
If the compiling process finishes without any error, download the compiled program to a
servo driver. A program can be downloaded only when the “SON” terminal is OFF. The
download is not allowed while the “SON” terminal is ON.
(1) On the [Run] menu, click [Download]. (The same action will be performed when you
click the

button or simultaneously press the [Shift] and [F11] keys.)

(2) The Program Download dialog box opens.

(3) Check a check box to select the contents.
[Code&Data] . . . both of the program and the data are downloaded
[Data]
. . . only the data is downloaded
(4) Press the [OK] button to start to download contents.
[For AHF Ver.5 or older]
[For AHF Ver.6 or later ]

(5) When the downloading process is completed, a dialog box opens., And it asks
whether you want to save the downloaded program into the EEPROM inside driver or
not. Normally, choose [YES].

* If [Connect] was not clicked at the AHF startup window, an error occurs. Therefore,
establish the connection (see Section 5.1.1).

* If a download process cannot be performed due to a Servo ON status, for
instance, a dialog box opens to display the following message. In this case, check
the suggested points in the dialog box.
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5.9

Batch Execution of Compile/Download/Start Functions
The compile, download and start functions can be executed by one step of action.
Batch execution of compile and download functions
From the [Run] menu, choose [Compile & Download]. (The same action will be
performed when you click the

button.)

The downloading process will be executed continuously as far as there is no compile
error.
If there is a compile error, an error message appears. In this case, correct the program in
accordance with the message.
Batch execution of compile, download and start functions
From the [Run] menu, choose [Compile & Download & Start].
The downloading and starting process will be executed continuously as far as there is no
compile error.
If there is a compile error, an error message appears. In this case, correct the program in
accordance with the message.

5-27

Chapter 5 Program Editor

5.10 Uploading a Program
A program can be uploaded from a servo driver by the following procedure:
(1) On the [Run] menu, click [Upload]. (The same action will be performed when you
click the

button or simultaneously press the [Shift] and [F12] keys.)

(2) The Program Upload dialog box opens.

(3) Check a check box to select the contents.
[Code&Data] . . . both of the program and the data are uploaded
[Data]
. . . only the data is uploaded
(4) Press the [Start] button. A dialog box then opens, if the currently editing program has
not compiled yet.

(5) Click the [Yes] button to upload the contents.

(6) When the upload ends, a message appears to indicate a normal end.
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(7) You are then asked whether you want to finalize the uploaded contents.
[For AHF Ver.5 or older]

[For AHF Ver.6 or later]

(8) When you click the [Yes] button, the uploaded contents are finalized and displayed.
• The Comment column are all blank.
• The label and subroutine names are automatically re-generated as indicated below
so that they differ from the original source codes.
Label names:
The first label is named LBL0. The number is incremented in
order of line number.
Subroutine names: The first subroutine is named SUB0. The number is
incremented in order of line number.
(9) If you click the [No] button instead of the [Yes] button, the system discards the
uploaded contents and the currently editing program is not overwritten.

5-29

Chapter 5 Program Editor

5.11 Debugging/Executing a Program
(1) Main debugging functions
The following debugging functions are available. Use the debugging functions as
needed.
Debugging
function name

Function description

Program Checks

Breakpoint

Halt a program execution at a pre-defined
point. Up to four breakpoints can be set.
(The value of variables can be watched.)

• Check the program flow.
• Check the value of variables.

Single step

Execute a program one line at a time.

• Check the program flow.
• Check the value of variables.

Executing step
monitor

Enable to see the currently executed line
on the Program Window.

• Check the program flow roughly.

Variable watch

Enable to check the value of a variable by
pointing the mouse cursor at it while the
execution is halted by breakpoints or
single-step function.

• Check the value of variables.

In the Variable Watch Window, you can
check the values of up to four variables
during the execution.
Nest display
(during compiling)

Displays the nest of the structure
instructions.

• Check the structure visually.

Communication
debug window

Check the operations of a user program if
the communication functions are used.
(The input/output data for “print#” and
“input#” statements can be controlled from
the communication debug window.)

• Check the outputs to the communication
port (for “print# “ statement) .
• Simulate inputs from the communication
port (for “input#” statement) for checking
the response in a program.
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(2) Breakpoint setup
You can set breakpoints on a downloaded program inside a servo driver. The
breakpoints are the points to halt the program execution. They are used to check the
flow of the program execution.
(1) On the [Run] menu, click [Breakpoint]. (The same action will be performed when
you click the

button or simultaneously press the [Ctrl] and [B] keys.)

(2) The breakpoint dialog box opens.
 The check boxes "Valid" must be checked when each breakpoints are
needed. The program does not halt at invalid breakpoints.
 By the [BP 1-4 Line Setup] buttons in the "Get selected line No." row, a
breakpoint is set on the selected line in the Code Window.
 The "Set Line" row display the line number of breakpoints. You
can directly enter the line number of breakpoints.
 By the [BP1-4 display] buttons in the "Set Line Display" row,
the breakpoint line is selected in the Code Window.

 Click the [Cancel] button to closes the breakpoint dialog
box.
 Click the [Set] button to transfer the breakpoints information into the
servo driver.

NOTE 1: At a breakpoint or in the single-step mode, the statement under the cursor
has not been executed yet. The statement is executed when the cursor is
passed to the next line.
NOTE 2: Even at a breakpoint or in the single-step mode, the motion instructions
(e.g. “mov” statement) are executed continuously.
NOTE 3: At a breakpoint, the cursor turns yellow. While this status, you can check
the value of a variable by pointing the mouse cursor at it.
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(3) Start and executing step monitor
The downloaded program inside the servo driver will be executed from the beginning
with "entry" statement to the ending with "end" statement or to the first breakpoint.


On the [Run] menu, click [Start]. (The same action will be performed when you
click the

button or press the [F5] key.)

If [Show executing step] is checked on the [View] menu, a blue cursor shows the
currently executing line. If you do not need the blue cursor, check [Not show
executing step] on the [View] menu.
When program execution starts, the window looks like the figure below and the
"On Line" sign appears.

NOTE 1: Since the monitoring period of executing step monitor is long, it might look
as if some instructions are skipped.
NOTE 2: If you disconnect the power supply cable to servo driver or the PC cable
during monitoring ("On Line" state), a message appears to indicate the
communication error. In this instance, exit AHF, restart AHF, turn the
power supply to servo driver OFF and then turn it ON again.
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(4) Halt
The currently executed program can be halted at a position at which a halt request is
received.
 On the [Run] menu, click [Stop]. (The same action will be performed when you
click the

button or press the [F6] key.)

Make sure that the "Off Line" state is indicated as below:

(5) Continue
If a program is halted at a breakpoint, the halted program can be resumed.
 On the [Run] menu, click [Continue]. (The same action will be performed when
you click the

button or press the [F7] key.)

(6) Single step
If a program is halted at a breakpoint or after the single step execution, a halted
program can be resumed only one step.
 On the [Run] menu, click [Single Step]. (The same action will be performed
when you click the
NOTE:

button or press the [F8] key.)

The single-step mode also allows you to check the value of a variable by
pointing the mouse cursor at it.

(7) Step over
If a program is halted at a breakpoint or after the single step execution, a halted
program can be resumed only one step. Note that there is no break inside subroutines in case a “call” statement is executed.
 On the [Run] menu, click [Step Over]. (The same action will be performed when
you click the

button or simultaneously press the [Shift] and [F8] keys.)

NOTE: The step-over mode also allows you to check the value of a variable by
pointing the mouse cursor at it.
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(8) Step out
If a program is halted at a breakpoint or after the single step execution, a halted
program can be resumed. If the step out function is executed inside a subroutine, the
program is executed until the next step of the “call” statement in the main routine. If
the step out function is executed in the main routine, the program is executed without
any scope.
 On the [Run] menu, click [Step Out]. (The same action will be performed when
you click the
keys.)

button or simultaneously press the [Shift], [Ctrl], and [F8]

NOTE: The step-out mode also allows you to check the value of a variable by
pointing the mouse cursor at it.
(9) Variable watch
The state of the variable can be checked during the program execution.
 On the [View] menu, click [Variable watch]. Variable watch window is opened.

Please select the variables to monitor the value from the list.
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The value of the selected variables are displayed in decimal and hexadecimal during
the program is executed. The value of variables can be monitored during "Program
start waiting…", "Program running…" and "Break stop" status.

Note) You can check the value of a variable by pointing the mouse cursor at it while
the cursor line is yellow at a breakpoint or in the single-step mode. At this time, the
display of the variable watch window is not updated. The value is updated when the
mouse cursor is moved from the variable.



The variable watch window is closed if you uncheck the [Variable watch] on the [View
menu]. (The same action will be performed when you click the
button.)

5-35

Chapter 5 Program Editor

(10) Nest display
If the [Show Program Nest at Compiling] on the [View] menu is checked before
compiling, the LABEL column shows nesting levels as above.
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(10)

Communication debug window
While the communication is established between AHF and a servo driver, it is
possible to execute "open com" statement and control the “print#” and “input#”
instructions from AHF. This function is available when you check the
[Communication debug] on the [View] menu.
When you use the communication functions, AHF is not connectable because the
CNPC connector is occupied with an upper control device as shown in the Figure (a).
Consequently, the program debugging becomes more difficult and time-consuming
because you cannot easily determine which unit makes the trouble; an upper control
device, the RS-232C connection or the user program in the servo driver. When the
Communication Debug Window is used as shown in Figure (b), the Communication
Debug Window can exchange the communication data instead of the upper control
unit, and it helps to debug an user program only. After finish the debugging of the
user program, you can connect the upper control device to debug the combined
operation. Thereby it’s possible to reduce the required debugging time.

AHF

RS-232C
FUNC
CHARGE

RS-232C

SET

Communication
Debugging

Window

FUNC
CHARGE

PC
Host device

SET

PC
PC

Servo amplifier
Servo amplifier

(a) Conventional debugging

(b) Communication Debugging Window

<Usage example 1>
To monitor the transmitted data from a servo driver, see the print# area on the
Communication Debug Window.
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<Usage example 2>
To transmit some data to a servo driver for the operation check purposes, enter some
value into the input# area on the Communication Debug Window, click the [Transmit]
button.
Then the PC transmits data to the servo driver. This function makes it easier to check the
operation of the communication program.

<Using the Communication Debugging Window>
(1) Create a program with the communication statements “open com”, “print#”, “input#”
and “LOC”.
Compile the program by choosing the [Compile] on the [Run] menu. Correct the
program until it becomes error-free.
(2) Download the program to a servo driver by choosing the [Download] on the [Run]
menu.
(3) Check Communication debug] on the [View] menu.
(4) Execute the program from AHF by choosing [Start] on the [Run] menu. The following
Communication Debug Window then opens:
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(5) To transmit data to a servo driver (the driver receives data by “input#” statement ),
enter a numerical value into the input# area and click the [Transmit] button.

NOTE 1: A data is transmitted to a servo driver just after clicking the [Transmit]
button. Each data is transmitted individually in each allocated button. (The
[Transmit] button next to the input #1 transmits the input #1 data only.)
NOTE 2: Put "&H" symbol (single-byte character string) on the hexadecimal number.
Example) For 12345678 hexadecimal, enter &H12345678.

(6) When the PC receives data (which is transmitted by “print#” statement ) from the
servo driver, the data is displayed on the print# area in decimal and hexadecimal.
NOTE: The display operation is slow. Therefore, if the servo drive transmits data at
a high speed, it might look as if data is not received.
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5.12

Printing a Program

You can print out the currently editing program.
(1) On the [File] menu, click [Print]. (The same action will be performed when you click
the

button or simultaneously press the [Ctrl] and [P] keys.)

(2) The Print dialog box opens.
(3) You can print out source and data by checking their check boxes.

(4) Click the [OK] button to start printing.
(5) If you click the [Cancel] button, the Print dialog box closes.
(6) If you click the [Options] button, the "Page Setup" dialog box opens.
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Since AHF Ver.6

5.13 Password Function

LEVEL2

The program inside a servo driver can be protected by a password if the servo driver
supports the language LEVEL2 and AHF is Ver.6 or later.
If the program is protected by a password, the following functions in AHF are prohibited.
● Download ● Upload ● Program erasure
Only if the protection is released with the right password, those functions are enabled.
Note 1) Please preserve the password carefully (e.g. leaving a note etc.). Please inquire
of our company in case you forget the password.
The user's operation is as follows.
<Without password>
The mentioned above functions are enabled always.
<With password>
(1) The password is set and released from the [Password set and release] on the
[Setting] menu. A different window appears depending on the state.
[in case there is no connection]

[in case a password has already set]

[in case no password is set]

Password ٠٠٠ Input the password.
It should be eight characters including "a~z", "A~Z", "0~9".
New password confirmation ٠٠٠ Input the same password again.
Note 2) The upper or lower case are distinguished. Please use just eight characters as a
password. Seven or less, nine or more are both prohibited.
The buttons [Set], [Release] and [Quit] are used in these window.
[Set] button ٠٠٠ Password and New password confirmation are required.
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(The string "00000000" cannot be used as a password.)
(Re-try is possible even after a conflict is found between the password and the new
password confirmation or the entered password is detected as a wrong one. )
A message "Set one's password correctly!" is displayed if there is a conflict.
[Release] button ٠٠٠ Password is required.
(The string "00000000" cannot be used as a password.)
(If the entered password has a conflict with the stored password, an error message is
displayed and the dialog box is closed)
A message "Unmatched password!" is displayed if there is a conflict.
[Cancel] button ٠٠٠ The dialog box is closed.
(2) If a password has been set successfully, neither up-loading, downloading nor the
program deleting are possible. Release the password and set it again, if you enable those
functions temporally or if you change the password.
Note 1) The password can not be changed by When the [Set] button if the password has
already been set. Please release the password by the [Release] button. A new password
can be set after it.
< Operation of password at each combinations between AHF and servo driver>
The table below shows the operation of the password function at each combination of
versions between AHF and the servo driver.
Operation of password at each combination between AHF and servo driver
Servo driver type
AHF
Version

Ver.5
or
older

Ver.6
or
later

ADAX,ADAX2,ADAX3
Without Password function

Without Password function
(When the language level is
switched to language LEVEL1,
upload, download, and the
program erasure are possible.)
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ADAX4
When the password has already been set to
the servo driver:
Update AHF to Ver.6 or later, otherwise the
program cannot be uploaded, downloaded or
erased.
When the password has not been set to the
servo driver yet:
The program can be uploaded, downloaded
or erased. （ only language LEVEL1 is
supported.）
Password function is supported.
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Since AHF Ver.6

LEVEL2

5.14 Displaying the error step
The line number of error step can be displayed if the servo amplifier supports the
language LEVEL2( LEVEL2 ) and AHF is Ver6 or later. If an execution error (E45) or other
trips occur, the line number of the executing step is stored into the parameter “d47”(execution error line monitor). The line number of the last trip can be checked via the
digital operator or AHF. By inputting the line number into the program editor, the line
where the corresponding error occurs is displayed.
The operating procedure is shown as follows.
(1) If an error occurs, check the content of "d-47".
(2) Open the program editor, open the saved program (program file saved beforehand) in
which the error occurs, compile it.
Note 1) If there is no source list, connect to the servo drive, and upload the program.

(3) On the [View] menu, click [Error step].
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(4) The below dialog box opens. Input the Error address which is read from the
parameter “d-47”(execution error line monitor) in the operation (1), and click the [OK]
button.

(5) The cursor is jumped to the error step.
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5.15 Viewing Help
On the [Help] menu, click [Help]. (The same action will be performed when you press the
[F1] key.)
The following message appears.

5.16 Version Information
You can view the version information about Program Editor.
(1) On the [Help] menu, click [About AD series Program Editor].
(3) A dialog box opens to display the version information.
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CHAPTER 6 INSTRUCTION WORD
REFERENCE
This chapter describes the functions of the instruction words for programming and shows how to
use them.
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6.1

Input/Output Terminals
The functions assigned to the input terminals for programmed operations differ from those
assigned for normal operations. The functions assigned to the input/output terminals are
listed below:
During
programmed
operations

During normal
operations

Normal instruction
Input

SON

terminal

RS
MOD/PRB1*

NOTE5

TL

SON

SON

RS

RS

X(00)

X(00)

X(01)

X(01)

FOT

NOTE5

X(02)

X(02)

ROT

NOTE5

X(03)

X(03)

*

SS1/EGR2

NOTE5

X(04)

X(04)

SS2/ECLR*

NOTE5

X(05)

X(05)

PPI/GCH

X(06)

X(06)

SRZ/EOH*

NOTE5

X(07)

X(07)

ORL

NOTE5

X(08)

ORL

ORG/PRB2*

NOTE1,5

PEN/FWD
CER/REV
Output
terminal

During homing

X(09),(ORG)

NOTE2

NOTE3

X(09) (ORG)

X(10)

X(10)

X(11)

X(11)

SRD

NOTE1

Y(00)

Y(00)

ALM

NOTE1

Y(01)

Y(01)

INP

NOTE1

Y(02)

Y(02)

NOTE1,4

Y(03)

Y(03)

SZD

NOTE1

Y(04)

Y(04)

BRK

NOTE1

Y(05)

Y(05)

TLM/AL2

NOTE1,4

Y(06)

Y(06)

OL1/AL3*

NOTE1,4

Y(07)

Y(07)

SA/AL1*

Analog

AI1

XA(0)

XA(0)

input

AI2

XA(1)

XA(1)

NOTE2

NOTE1) The functions assigned to the FOT, ROT, ORL, ORG, and all output terminals can be changed by executing a special
terminal assignment change instruction (chg instruction) within a program. Such a function assignment change takes effect
when the chg instruction is executed. In enhancement driver (ADAX4), these terminals can be set special terminal as initial
function to use parameter FC-41 and FC-46 without chg instruction.
NOTE2) This terminal is for ORG function only, when [chg ORG = default] is implemented. This terminal can use X(09) in the case
of homing instruction (ort instruction) without [chg ORG =default]
NOTE3) This terminal is to be ORL, the servo driver is in homing.
NOTE4) * mark function available in ADAX3 and ADAX4.
NOTE5) PRB1 and PRB2 available in ADAX4.
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6.2

Reserved Variables
The table below shows the reserved variables that can be used within a program:

Category
Setting
memorization

User-defined
variable

Item name
Position
command
Speed
command
Torque
command
Acceleration
time
Deceleration
time
User variable
Acceleration
time setting
LED character
display
LED display
attribute
Deceleration
time setting
LED display
data
Electric gear
numerator

Variable name

Size

Unit

R/W

P(00) to P(99)

Signed, 2 w

(NOTE1)

R/W

N(00) to N(15)

Signed, 1 w

( NOTE1)

R/W

T(00) to T(15)

Signed, 1 w

%

R/W

ACC(0) to ACC(1) Signed, 1 w

0.01s

R/W

DEC(0) to DEC(1) Signed, 1 w

0.01s

R/W

U(00) to U(15)

Signed, 2 w

ACCEL

Signed, 1 w

−

CHR1 to 5

−

−

−

−

Indicates an acceleration time setting.
1dig=0.01s
Not available.

DATR

−

−

−

−

Not available.

R/W

Fb-05

DECEL

Signed, 1 w

0.01s

R/W

Associate
d
Description
parameter
−
Indicates a position command.
32768dig=1 rotation
−
Indicates a speed command.
1dig=1min-1
−
Indicates a torque command.
1dig=1%
−
Indicates an acceleration time.
1dig=0.01s
−
Indicates a deceleration time.
1dig=0.01s
−
User-defined variable.

0.01s

R/W

Fb-04

Indicates a deceleration time setting.
1dig=0.01s
Not available.

−

−

−

−

EGRAN LEVEL2

Unsigned
1W

−

R/W

FA-12

Electric gear
denominator

EGRAD LEVEL2

Unsigned
1W

−

R/W

FA-13

External
encoder ratio
for electric cam
Home position

EXD

−

−

R/W

−

HPOS

Signed, 2 w

(NOTE 1)

R

−

Current
feedback
Positioning
complete

IFB

%

R

d-02

INP

Unsigned, 1
w
0.1

R

−

Current
command
Moment of
inertia

IRF

Signed, 1 w

%

R

d-03

R/W

Fd-00

Load's moment of inertia.(rotary)
-4
1dig=0.01 (greater or equal 400 W)
-5
1dig=0.01 (less or equal 200 W)
Mass of mover (Linear)
1dig=0.01× 10 (greater or equal 400 W)
1dig=0.001× 10 ((less or equal 200 W)

DISP

LEVEL2

J

−

−

0.01 × 10-4
(0.01 × 10-5)
0.01 × 10
(0.01 × 10)

Speed control
cut-off
frequency
Position control
cut-off
frequency
Position control
FF gain
ASR integral
gain
ASR
proportional
gain
Control mode

Setting electric gear numerator in the
case of use sync1,sync2 and cam
instruction
Setting electric gear denominator in the
case of use sync1,sync2 and cam
instruction
Set encoder ratio using electric cam.
0,1,2,8,16 effects only.
Indicates the second home position,
which differs from the first home position
(zero position prevailing upon power
ON).
Indicates a current feedback.
50dig=1%
Output when the deviation between the
position command value and position
detection value is within the positioning
detection range (Fb-23) (0: positioning in
progress; 1: positioning complete).
Indicates a current command.
50dig=1%

KFC

−

0.1Hz

R/W

Fd-01

ASR response frequency.
1dig=0.1Hz

KP

−

0.01Hz

R/W

Fd-09

ASR response frequency.
1dig=0.1Hz

KPF

−

0.01

R/W

Fd-10

KSI

−

0.01%

R/W

Fd-03

KSP

−

0.01%

R/W

Fd-02

Tolerates the APR feed forward gain 0
state. 1dig=0.01
Proportional gain for ASR PI control.
1dig=0.01%
Proportional gain for ASR PI control.
1dig=0.01%

R

−

MODE

−

0 to 2

NOTE1) Refer to section 3.6 for UNIT

6-3

Selects a control mode
(0: torque control; 1: speed control; 2:
position control).
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Category
Monitoring/
setting
(continued)

Variable name

Size

Unit

R/W

Electric cam
modulo

MODL LEVEL2

−

−

R/W

Associated
parameter
−

Present speed

NFB

Signed, 1 w

(NOTE1)

R

d-01

Speed limit

NLM,
NLM(0),
NLM(1)

Unsigned,
1w

(NOTE1)

R/W

−
Fb-21
Fb-22

Present speed
command

NRF

Signed, 1 w

(NOTE1）

R

d-00

Multipurpose
parameter

OP0 - OP4
LEVEL2

−

−

R/W

Fb-50
Fb-54

Position
command bias

PBIAS

-128 to 128

1pulse

R/W

−

Position
command filter
time constant

PFILT

−

0.1ms

R/W

Fd-36

Present
position

POS

Signed, 1 w

215 rev/pls

R/W

d-08

Capture
variable

PRB1H
PRB1L
PRB2H
PRB2L
LEVEL2

Unsigned,
2w

1 pulse

R/W

−

Actual position
command

PRF

Signed, 2 w

(NOTE1)

R
(R/W)

S-curve ratio

SCV

−

−

R/W

Fb-30

Speed
command filter
time constant

SFILT

−

R/W

Fd-20

Zero speed
detection

SZD

Speed
command gain

Item name

1ms

0.1

−

R

−

SPDG LEVEL2

−

−

R/W

−

Drive status

STS

−

−

R

−

Torque output

TFB

R

d-04

Torque
command filter
time constant

TFILT

0.01ms

R/W

Fd-06

Free run timer

TIMER1
LEVEL2
TLM,
TLM(0) to
TLM(3)

Unsigned,
2w
Signed, 1 w

4msec

R/W

%

R/W

−
Fb-07 to
Fb-10

TRF

Signed, 1 w

%

R

−

Torque limit

Present torque
command

LEVEL2

Signed, 1 w
−

%

NOTE1) Refer to section 3.6 for UNIT
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Description
Setting modulo value in
electric cam mode.
(Set value is from 1 to 3072 )
Indicates the present speed.
1dig=1min-1
Limits the speed. Selecting
NLM simultaneously writes
NLM(0) and NLM(1).
NLM(0): Forward
NLM(1): Reverse
1dig=1min-1
Indicates the present speed
command.
1dig=1min-1
This variable can read and
write digital operator too.
These are user free
parameter, setting range is
from -9999 to 99999
When the sync instruction is
issued, the position command
bias adds a preselected pulse
count to the position
command at 140 µs intervals.
The position command is
invalid when the filter time
constant is 0.
1dig=0.1ms
Indicates the present position.
The first home position, which
prevails upon power ON, is
regarded as the zero position.
32768dig=1 rotation
Capturing actual position at
on edge and off edge of
terminal PRB1/2
PRB1H:On edge of PRB1
PRB1L ;OFF edge of PRB1
PRB2H:ON edge of PRB2
PRB2L:OFF edge of PRB2
Indicates the actual position
This variable can be write in
the case of don't executing
motion command.
S-curve ratio (0: none; 1:
sharp; 2: medium; 3: gentle).
The speed command is
invalid when the filter time
constant is 0.
1dig=1ms
Output when the speed
command value is smaller
than the zero speed setting
(Fb-22) (0: non-zero speed; 1:
zero speed).
Multiply Speed command by
Speed gain 0.1 to 1.
Setting range is 1 to 10.
Indicates the internal drive
status.
Indicates the present output
torque.
50dig=1%
The torque command is
invalid when the filter time
constant is 0.
1dig=0.01ms
Indicates the timer count.
1dig = 4msec
Limits the torque. Selecting
TLM simultaneously writes
TLM(0), TLM(1), TLM(2), and
TLM(3).
50dig=1%
Indicates a torque command
(the value prevailing before
torque limitation and torque
command filtering).
50dig=1%
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Category
Input/output

Variable name

Size

Unit

R/W

Bit input

X(00) to X(11)

0,1

−

R

Associated
parameter
−

Word input

Xw

0 to 1024

−

R

−

Bit number
input

Xn

0 to 15

−

R

−

Bit output

Y(00) to Y(07)

0,1

−

R/W

−

Word output

Yw

Unsigned, 1
byte

−

R/W

−

Analog input

XA(0) to XA(1)

Signed, 1 w

0.10%

R

−

0,1

−

R

−

−

−

R

d-11
d-12

Item name

Communication Communication LOC(0) to
data input
LOC(2)
status
Error
information

Trip cause
code

ERR(0) to
ERR(3)

Description
Provides bit input for contact
input purposes.
Provides word input for
contact input purposes.
X(00)=b0 ….X(11)=b11
Inputs a bit number for
contact input purposes. Only
the mov instruction is
available.
Provides bit output for contact
output purposes.
Provides word output for
contact output purposes.
Y(00)=b0 ….Y(07)=b7
Provides analog input. The
full scale is considered to be
100%.
1dig=0.01%
Checks whether data is
entered via the RS232C
interface (PC) (0: not
received; 1: received).
Error cause code.

• Variables available within a program vary with the selected instruction word.
• In Program Editor, the operative buttons automatically change when an instruction word is set.

6-5

Chapter 6 Instruction Word Reference

6.3

List of Instruction Words
(1) Program control

Instruction
name

Mnemonic

First
argument

Instruction format
Second
Third
argument argument

Fourth
argument

Fifth
argument

entry statement entry
end
sub statement

sub

<subroutine
name>

end sub
call statement

call

<subroutine
name>

cont statement

cont

on

off
for loop

goto statement
ifs (structure if)

for

<variable>

<start
value>

<end
value>

[step
<incremental
value>]

<instructions>
Next
goto
<label
name>
Ifs

<condition>

[then]
<instructions>

[else]
<instructions>

end if
if statement

if

<condition>

load statement
(variable read)

load

[P]

[N)]

[T]

on trip goto

on LEVEL2

trip

go to

<label
name>

rs statement
save statement
(variable
storage)

rs
save

[P]

[N)]

[T]

6-6

then

<label
name>

[ACC]

[DEC]

[ACC]

[DEC]

Description
Indicates the beginning of the
main program.
Indicates the end of the main
program.
Indicates the beginning of a
subroutine.
Indicates the end of a
subroutine. (Returns to the
calling routine.)
Branches to a subroutine having
the <subroutine name>. The
return to the main routine is
invoked by "end sub".
Selects the operation to be
performed when the program is
interrupted.
on = Resumes execution at the
point of PC interruption.
off = Resumes execution at the
beginning.
An <incremental value> loop
occurs between the <start
value> and <end value>. By
default, the <incremental value>
is 1.
Repetition instructions for a loop.
"for" loop ender.
Performs an unconditional
branch to the program's <label>
position.
Starts the “structure if”
statement.
Starts the instructions that are to
be executed when the
<condition> is met.
Instructions to be executed when
the <condition> is met.
Starts the instructions that are to
be executed when the
<condition> is not met.
Instructions to be executed when
the <condition> is not met.
Ends the "structure if" statement.
Branches to the <label name>
position when the <condition> is
met.
Reads specified parameters.
Reads P(), N(), T(), ACC(), an
DEC() by default.
Branch <label> line when a trip
occurred.
Cancellation of trip
Saves specified parameters.
Saves P(), N(), T(), ACC(), an
DEC() by default.
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Instruction
name

Mnemonic

select case
syntax

select

case

First
argument
<branch
variable>

Instruction format
Second
Third
argument argument

Fourth
argument

Fifth
argument

Executes an instruction under
"case" when the variable
indicated by <branch variable>
is the <condition value>
indicated by "case".
Starts writing the <condition
value> and the instruction to be
executed.
Writes the instructions to be
executed when the <condition
value> is other than above.
String of "case" instructions.
Indicates the end of "select
case" nesting.
Executes <instructions> until the
<condition> is met. Runs a
condition check after instruction
execution.
Writes the instruction to be
executed.
Indicates the end of "until".
Stands by for a period of iii.ii (s).
Stands by until the <condition>
is met.
Executes the <instructions>
while the <condition> is met.
Runs a condition check prior to
the instructions.
Instructions to be executed while
the <condition> is met.
Indicates the end of "while".
The <variable> add 1dig.
The <variable> reduce 1deg.

<conditional
value>

[case else]
……
end select
until loop

Until

<condition>

<instructions>
wait statement
(time control)
while loop

loop
wait

iii.ii
<condition>

while

<condition>

<instructions>
inc statement
dec statement

wend
inc
dec

Description

<variable>
<variable>

(2) Motion control
Instruction
name

Mnemonic

cam
statement

cam

cdata
statement

cdata

First
argument
r

Instruction format
Second
Third
Fourth
argument argument argument

Fifth
argument

Sixth
argument

Description
The end command cam control.

LEVEL2
LEVEL2
LEVEL2

s
<cam
name>
val1

val2

val3

N(i)

[ACC(k)]

[DEC(m)]

val4

end cdata

LEVEL2
hp statement hp
(return to
home
position)
hpset
hpset
statement
(home
position
setup)

6-7

val5

val6

The start command cam control
Start of electric cam data
statement. Define the cam name
order of electric cam data.
End of electric cam data
statement.
N(i) invokes a return to the home
position. The parameters are
used to specify the
acceleration/deceleration time.
Marks the current position as the
home position (invokes no
movement).
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Instruction
name
imov
statement
(constant
rate of
feeding)
mov
statement
(positioning
instruction)

nchg
statement
(speed
change)

Mnemonic
imov

Instruction format
First
Second
Third
Fourth
argument argument argument argument
P(i)
[N(j)]
[ACC(k)]
[DEC(m)]

Fifth
argument
[;&] (note)

Description

P(i)

[N(j)]

[ACC(k)]

[DEC(m)]

[;&] (note)

P(Xn)

[N(j)]

[ACC(k)]

[DEC(m)]

[;&] (note)

P(Xw)

[N(j)]

[ACC(k)]

[DEC(m)]

[;&] (note)

Z

[N(j)]

[ACC(k)]

P(i)

[N(j)]

[ACC(k)]

0
1
2 to 5
6
<cam
name>
P(i)

[N(j)]

LEVEL2

mov

nchg

ort statement ort
(homing)
restore
statement
smov
statement
(speed/positi
on control
changeover)
son
statement
soff
statement
speed
statement
(speed
control
instruction)

restore

stop
statement
(motion
operation
stop)

stop

smov

[N(j)]

[N(k)]

[;&] (note)

[DEC(m)]

[ACC(m)]

[DEC(n)]

[ACC(m)]

[DEC(n)]

Servo on command in the case of
using RUN terminal function.
Servo off command in the case of
using RUN terminal function.
Accelerates/decelerates in
accordance with the parameterspecified
acceleration/deceleration time
setting and performs a constantspeed operation at N(i).
Ends a motion operation. Invokes
deceleration and stop after
instruction issuance. Invokes an
immediate stop during a sync
operation.
Ignore inposition signal at the end
of motion movement
1: starts sync control (no speed
bias); 2: starts sync control (speed
bias provided); s: speedcontrolled operation upon receipt
of analog input 1.
The stop instruction is used to
clear the sync statement.
Effects a torque control change or
torque command change from the
P(i) position.

soff

LEVEL2
[ACC(k)]

[DEC(m)]

[i]

LEVEL2
sync
statement
(synchroniza
tion control)

sync

tchg
tchg
statement
(torque
command
change)
trq statement trq
(torque
control)

1
2
s

P(i)

Invokes high-speed homing 1/2.
Invokes homing as desired.
Invokes rotation at N(i) and
accomplishes positioning to arrive
at P(i) from the smov execution
position.

LEVEL2
N(j)

Accomplishes positioning in the
relative P(i) position + actual
position at a speed of N(j). The
parameters are used to specify
the acceleration/deceleration time.
Accomplishes positioning in the
P(i) position at a speed of N(j).
The parameters are used to
specify the
acceleration/deceleration time.
Accomplishes positioning in the
P(Xn) position having the number
specified by X(i) at a speed of
N(j). The parameters are used to
specify the
acceleration/deceleration time (Xn
= 7 and P(7) when X(7) = 1).
Accomplishes positioning in the
P(Xw) position having the number
specified by X(w) at a speed of
N(j). The parameters are used to
specify the
acceleration/deceleration time
(P(5) when Xw = 5).
Invokes rotation at a speed of N(j)
from the current position and
accomplishes positioning to arrive
at the first phase Z. The
parameters are used to specify
the acceleration/deceleration time.
Specifies a speed change in the
mov/speed execution sequence
subsequent to this instruction.
The acceleration/deceleration
time parameters are used to
change the speed command to
N(j) from the P(i) position.
Invokes low-speed homing.

Assign use cam.

son

speed

Sixth
argument

T(k)

T(j)

Uses T(j) as a torque command to
exercise torque control.

(note): Detail of [;& ] , please refer explanation of mov statement in chapter 6
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(3)
Instruction
name
X() (contact
input)

Y() (contact
output)
chg statement
(special
terminal
assignment
change)

Input/output control

<variable>=

First
argument
X(i)

<variable>=

XW

Y(i)=

<variable>

YW=

<variable>

chg FOT=
ROT=

X(i)

Mnemonic

Instruction format
Second
Third
argument argument

Fourth
argument

Fifth
argument

Acquires contact input
information and stores it in the
<variable> (0 = off, 1 = on).
Acquires contact input
information as word data and
stores it in the <variable>.
Outputs to the contact output bit
by bit (0 = off, 1 = on).
Outputs word data to the contact
output.
Changes the FOT and ROT
terminal assignments.
Invalidates the FOT and ROT
terminal assignments.
Changes the ORL and ORG
terminal assignments.
Returns the ORL and ORG
terminal assignments to the
default values.
Changes the output terminal
assignments.
Invalidates the output terminal
assignments.

non
chg ORL=
ORG=

X(i)
default

chg SRD=
ALM=
INP=
SA=
SZD=
BRK=
TLM=
OL1=

Description

Y(i)
non

(4) Communication control
Instruction
name

Mnemonic

open com
open com
statement
(communication
port use
declaration)
print statement print #0
(communication
#1
port output
#2
instruction)
input statement input #0
#1
(communication
#2
port input
instruction)

First
argument

Instruction format
Second
Third
argument argument

Fourth
argument

Fifth
argument

Description
Declares the use of the RS232C port (PC).

<variable>

Outputs the <variable> data from
the RS-232C port (PC).

<variable>

Inputs the <variable> data from
the RS-232C port (PC). Does
not proceed to process the next
line until communication data is
entered.
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6.4

Program Control Instructions
This section explains in detail about program control instructions.

entry/end statement

Main program start/end

• Format
Format

Operation overview

entry

Indicates the start of the main program. (This statement needs
to be placed at the beginning of the main program.)

end

Indicates the end of the main program. When the "end"
statement is executed, the program stops, causing the servo to
abort the execution of a motion instruction and enter the servo
lock state.

• Description
Indicates the start/end of the main program.

• Usage example
entry
mov
……
end

Start of the main program
P(00) N(00) ACC(0) DEC(0)
End of the main program

sub/end sub statement

Subroutine program start/end

• Format
Format

Operation overview

sub <subroutine name>

Indicates the start of a subroutine program.

end sub

Indicates the end of a subroutine program. Invokes a return to
the calling subroutine.

• Description
Indicates the start/end of a subroutine program.
<subroutine name>: Indicates the name of a subroutine, which becomes the first parameter
(branch destination) of the call instruction.
NOTE: Permissible subroutine nesting is up to 8 levels deep. The "sub", "for", "while", "until",
"select", and "ifs" structure instructions are counted as one nesting level. Therefore, if
the "for" statement is used with the "sub" statement, the depth of nesting is considered
to be 2 levels deep.

• Usage example
sub sub1
mov
……
end sub

Start of a subroutine program
P(00) N(00) ACC(0) DEC(0)
End of a subroutine program
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call statement

Unconditional subroutine call

• Format
Format
call <subroutine name>

Operation overview
Issues an unconditional subroutine call to the <subroutine
name>.

• Description
Issues an unconditional subroutine call to the <subroutine name>. Passes control to the next
line upon subroutine completion. The "end sub" instruction ends the subroutine and passes
control to the line next to the call instruction.
<subroutine name>: Specify the name of a subroutine that is defined by the "sub" instruction.
NOTE: Permissible subroutine nesting is up to 8 levels deep, including structure instructions.

• Usage example
call SUB1
……
sub
SUB1
……
end sub

cont statement

Issues a subroutine call to SUB1.

Program resumption mode selection

• Format
Format

Operation overview

cont on

Resumes execution with the line next to a halted line.

cont off (default)

Resumes execution from the beginning of a halted program.

• Description
This statement defines the operation that is to be performed when the SON signal turns OFF
and then back ON during a programmed operation. By default, the "cont off" operation is
performed; that is, if the program is halted upon SON signal turn-OFF, execution is resumed
from the beginning of the program when the SON signal turns back ON.

• Usage example

Servo
OFF

Servo
OFF

Example 1)
cont on
……
mov P(00)
Yw=1
Example 1)
entry
cont off
……
mov P(00)

Selects a mode in which execution is resumed with the line next to a halted line.
The SON signal turns OFF while this instruction is being executed.
When the SON signal turns back ON, execution is resumed with this instruction.

Start of execution
When the SON signal turns back ON, execution is resumed with this instruction.
Selects a mode in which execution is resumed from the beginning of a halted program.
When the SON signal turns back ON, execution is resumed with this instruction.

Start of execution
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for loop statement

for loop

• Format
Format

Operation overview

for <variable><start value>
<end value>
[<incremental value>]
<instructions>
next

An <incremental value> loop occurs between the <start value>
and <end value>. The loop continues until the variable
exceeds the end value.

• Description
When the execution repetition count is predetermined, processing can be effectively written with
"for". The <instructions> are first executed and then the <variable> is increased [decreased] in
units of the specified <incremental value> from the <start value> (the square brackets are used
to indicate the situation where the <incremental value> is a negative quantity). When the
resulting variable is greater than [smaller than] the <end value>, the loop ends. If not, the loop
continues. Consequently, the <instructions> are executed at least once. The flowchart is
shown below:

<variable> ← <start value>

Execution of instructions

<variable>←<start value>+<incremental value>

N

Greater than
<end value>?

(Or "smaller than <end value>?" when the
<incremental value> is negative)

Y

<variable>:
<start value>:

<end value>:

Specify the name of the variable to be used for a loop. The P(), N(), T(), ACC(),
DEC(), and U() variables are selectable.
Specify the initial value of the <variable> for entering the loop. This initial value
can be specified by entering a variable name or an immediate value that can be
directly entered. The immediate value is an integer between -128 and 127.
Greater numerical values need to be placed within a variable beforehand and
you have to specify the name of that variable.
Specify the value for exiting the loop. The program exits the loop when the
<variable> exceeds the <end value>. The end value can be specified by
entering a variable name or an immediate value that can be directly entered.
The immediate value is an integer between -128 and 127. Greater numerical
values need to be placed within a variable beforehand and you have to specify
the name of that variable.
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<incremental value>: Enter a positive or negative value to specify the units in which the
<variable> is to be increased or decreased for loop repetition. By default,
the incremental value is 1. The incremental value can be specified by
entering a variable name or an immediate value that can be directly
entered. The immediate value is an integer between -128 and 127.
Greater numerical values need to be placed within a variable beforehand
and you have to specify the name of that variable.
<instructions>:
Write the instructions that are to be executed during a loop. You may
write two or more lines as indicated in the usage example. Note,
however, that one line is executed per cycle.

• Processing cycle
The usage example presented later is used for explanation purposes.
(1):
The "for" line is executed only once. (In the subsequent loop cycles, only the
<instructions> and "next" are executed.)
(2) to (4): The instructions are executed.
(5):
In the cycle subsequent to the cycle of the last instruction execution in the loop, the
variable is incremented to check whether or not to exit the loop ("next" execution).
When the loop continues, the program moves within this cycle to the beginning of the
instructions within the loop.
(6):
Execution takes place in the next cycle.
(7) to (13):
Repetition occurs in the same manner as explained above.
(14):
The instruction in the line next to "next" is executed.

• Usage example
Example) The instructions within the loop are executed three times.
Order of execution
for
U(00) 0 2
'(1)
U(00)=0 to 2 step 1
mov P(U(00))
'(2)
(6)
(10)
Y(00)=1
'(3)
(7)
(11)
Y(00)=0
'(4)
(8)
(12)
next
'(5)
(9)
(13)
hpset
'(14)
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goto statement

Unconditional branch

• Format
Format
goto <label name>

Operation overview
Performs an unconditional branch to the <label name>.

• Description
The goto statement is used when processing needs to be unconditionally branched. This
statement performs an unconditional branch to the <label name>.
<label name>: Enter a line name that is defined in the label column.

• Usage example
goto LBL1
……
LBL1:hpset

Performs an unconditional branch to LBL1.
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if statement

Conditional branch

• Format
Format
if <condition> then <label
name>

Operation overview
When the <condition> is met: Performs a branch to the <label
name> position.
When the <condition> is not met: Moves to the next line.

• Description
Use the "if" statement when processing needs to be branched depending on the condition. The
"if" statement performs a conditional branch to the line having the <label name> written after
"then" when the <condition> is met.
<condition>: Write a conditional expression in the format stated in Section 3.5, Conditions, of
Section 3, Syntax.
<label name>: Enter a line name that is defined in the label column.

• Processing cycle
The condition check and branching processes are performed within the same cycle. The
branch destination and next line will be executed in the next cycle.
For your reference, circled numbers are used in the comment column of the usage example
below to indicate the order of execution in different situations.

• Usage example
Yw=0
if POS=0
then LBL1
if POS=P(00) then LBL2
Y(00)=1
goto LBL3
LBL1: Y(01)=1
goto LBL3
LBL2: Y(02)=1
LBL3: Y(03)=1

Turns OFF the Y(00) to Y(07) terminals.
(1) Performs a branch to LBL1 when the condition is met.
(2) Performs a branch to LBL2 when the condition is met.
(3)
(4)
(2)
(3)
(3)
(5)
(4)
(4)
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ifs-then-else-end if
statement

Structure if

• Format
Format
Ifs <condition>
[then]
<instructions 1>
[else]
<instructions 2>
end if

Operation overview
When the <condition> is met: Executes <instructions 1> between
"then" and "else".
When the <condition> is not met: Executes <instructions 2>
between "else" and "end if".

• Description
This statement changes the process to perform depending on whether the condition is met. It
executes <instructions 1> when the condition is met and executes <instructions 2> when the
condition is not met.
<condition>:

Write a conditional expression in the format stated in Section 3.5, Conditions,
of Section 3, Syntax.
<instructions 1>: Write the instructions to be executed when the <condition> is met. You may
write two or more lines as indicated in the usage example. Note, however,
that one line is executed per cycle.
<instructions 2>: Write the instructions to be executed when the <condition> is not met. You
may write two or more lines as indicated in the usage example. Note,
however, that one line is executed per cycle.
NOTE: Permissible nesting is up to 8 levels deep, including subroutines and other structure
instructions.

• Processing cycle
This statement runs a condition check in the first cycle. In the second cycle, it processes the
first instruction of <instructions 1> or <instructions 2>. In the third cycle, it executes the next
instruction within the condition or, if the next instruction does not exist, it jumps to "end if".
Therefore, if only one instruction is to be executed, the if-end if portion is processed within three
cycles.
For your reference, circled numbers are used in the comment column of the usage examples
below to indicate the order of execution in different situations.

• Usage example
Example 1) When the entire statement is written

Ifs
then

When the condition is not met

When the condition is met

‘(1)
‘
‘(2)
‘
‘
‘(3)

(1)

POS=0
hpset

else
ort 0 N(00) DEC(0)
end if
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Example 2) When "then" is omitted (the same process as indicated in Example 3 below)

Ifs
else

When the condition is not met

When the condition is met

‘(1)
‘
‘(2)
‘(3)

(1)

POS=0
ort 0 N(00) DEC(0)

end if

(2)

Example 3) When "else" is omitted (the same process as indicated in Example 2 above)

Ifs
then

When the condition is met

When the condition is not met

‘(1)
‘
‘(2)
‘(3)

(1)

POS<>0
ort 0 N(00) DEC(0)

end if
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load statement

Variable loading

• Format
Format
load [P] [N] [T] [ACC] [DEC]
load [P(i)] [N(j)] [T(k)] [ACC(l)] [DEC(m)]

Operation overview
Loads specified variables from the EEPROM.

• Description
This statement loads the P(), N(), T(), ACC(), and DEC() variables from the EEPROM. By
default, the statement loads all the above variables. Execute this statement when the variables
need to be restored after power ON to the values prevailing upon first servo ON.
P:
P(i):
N:
N(j):
T:
T(k):
ACC:
ACC(l):
DEC:
DEC(m):

Loads all the P() variables between P(00) and P(99).
Loads only one specified P() variable. If, for instance, P(01) is specified, this
statement loads the P(01) variable only.
Loads all the N() variables between N(00) and N(15).
Loads only one specified N() variable. If, for instance, N(01) is specified, this
statement loads the N(01) variable only.
Loads all the T() variables between T(00) and T(15).
Loads only one specified T() variable. If, for instance, T(01) is specified, this
statement loads the T(01) variable only.
Loads both the ACC(00) and ACC(01) variables.
Loads either the ACC(00) variable or ACC(01) variable. If, for instance, ACC(01) is
specified, this statement loads the ACC(01) variable only.
Loads both the DEC(00) and DEC(01) variables.
Loads either the DEC(00) variable or DEC(01) variable. If, for instance, DEC(01) is
specified, this statement loads the DEC(01) variable only.

• Usage example
Example 1)
load

Loads all the variables.

Example 2)
load
P N ACC DEC

Loads the P, N, ACC, and DEC variables.

Example 3)
load
P(00)

Loads the P(00) variable.
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LEVEL 2
on trip goto statement

Trip conditional branch

• Format
Format
on trip goto <label>

Operation overview
when a trip occurred, branch to the <label name>
position.

• Description
When RUN terminal function is enabled, the user program is running in spite of the servo driver
is in trip status. If you write [on trip goto <label>], the program is branch to the label at a trip
occur. A <label> that is executed this statement at last is effective.
The branch timing is the end of executed statement at when a trip is occurred.
However, in the case of executing motion command (e.g mov statement and so on), the
command is aborted.
Using this statement, the branch program can cancel a trip by refer to ERR variable, running
specific program and so on.

NOTE1) If RUN terminal is not assigned, this statement do not effective.
NOTE2) Implement this statement in header part of user program recommended, for sure
to be effective it.
NOTE3) Do not execute this statement over and over. The user program will be hanged up with
the result that a trip occurs interrupt.
NOTE4) The branch <label> is memorized after RUN terminal off and on.
NOTE5) In case of SON terminal effective and [on trip goto <label>] statement is executed,
the <label> memorize. At that result, the branch label to be effective when turn off
SON terminal and switch over RUN terminal
NOTE6) Take care the case of cancel a trip to use rs statement in branch program
by [on trip goto] statement. Because following continuous loop may be occurred.
(i) A trip occurred. And branch by [on trip goto]
(ii) Cancel a trip by rs statement
(iii) A trip occurred again. and return (i).
The above means program deadlock!
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• Usage example
By use [on trip goto <label>] statement and ERR variable, change operation when a trip is
occurred.
<Code Window>
entry
on trip goto ALARM
Y(00)=0
Y(01)=0
START: U(00)=0
ort 0 N(01) ACC(0) DEC(0)
U(00)=1
MAIN: wait X(11)=1
mov P(01) N(00) ACC(0) DEC(0)
mov P(02) N(00) ACC(0) DEC(0)
hp N(00) ACC(0) DEC(0)
goto MAIN
;
; Trip operation
ALARM: U(01)=ERR(0)
Y(00)=1
select U(01)
case 5
Y(01)=1
wait 10
case 6
Y(01)=1
case else
Y(01)=0
end select
wait STS=1
rs
son
Y(00)=0
Y(01)=0
ifs U(00)<>0 then START
hp N(02) ACC(0) DEC(0)
goto MAIN
end

;before homing
TRIP!
;after homing

;Overload trip Y(01)=1
; Wait until thermal integrated value came down

;BRD trip Y(01)=1
;Others trip Y(01)=0 and trip cancel
;wait trip cancel
;trip cancel
;servo on again

;homing if did not it
;return home position by low speed
;return MAIN

<Data Window>
P(01) = 32768*10[pls], P(02)=32768*(20)[pls], N(00)=3000[min-1]
N(01) = 100[min-1], N(02)=50[min-1]
ACC(0)=0.1[s] , DEC(0) = 0.1[s]
<code description>
In the case of no executed homing, try homing again.
In the case of occurred trip after homing, return home position by low speed.
When load is heavy and Overload, BRD and other trip occurred, output Y(01) = 1.
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LEVEL 2
rs statement

Trip cancel command

• Format
Format

Operation overview
Do cancel a trip

rs

• Description
This statement can cancel a trip when RUN terminal assigned. Because the user program run
continue after occur a trip in the case of RUN terminal assigned. There is delay time between
execute rs statement and next statement. This delay time is about 25msec(Trip cancel) +
1.12msec ( one program cycle ).
Servo drive state is servo off after trip cancel by rs statement. For again servo on, implement
son statement.
rs statement ignore when no trip.
NOTE1) For trip cancel, SON terminal turn off when SON terminal assigned.
When RUN terminal assigned, trip cancel can execute rs statement without turn off
RUN terminal.

• Usage example
<Code Window>
entry
MAIN: STS =1
;Wait servo on ready
son
NMOV: mov P(00) N(00) ACC(0) DEC(0) ;Check normally running.
if STS=3 then NORMAL
;If trip state, cancel trip
rs
goto MAIN
NORMAL:P(00) = -1*P(00)
; In the case of normally running, change
goto NMOVE
; position and remove.
end

<code description>
In the case of a trip occur in executing mov statement, the program execute cancel trip, servo
on again by son statement, calculate next position and move.

NOTE2 ) Please take care of following case.
In the case of execute rs statement just execute mov statement, a trip that occurred
in moving is canceled immediately. It looks like correctly move but it is not correctly
always.
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save statement

Variable saving

• Format
Format
save [P] [N] [T] [ACC] [DEC]
save [P(i)] [N(j)] [T(k)] [ACC(l)] [DEC(m)]

Operation overview
Saves variables into the EEPROM.

• Description
This statement saves the P(), N(), T(), ACC(), and DEC() variables into the EEPROM. By
default, the statement saves all the above variables. When the power turns ON next, you can
redefine the variables that prevail upon first servo ON.
P:
P(i):
N:
N(j):
T:
T(k):
ACC:
ACC(l):
DEC:
DEC(m):

Saves all the P() variables between P(00) and P(99).
Saves only one specified P() variable. If, for instance, P(01) is specified, this
statement saves the P(01) variable only.
Saves all the N() variables between N(00) and N(15).
Saves only one specified N() variable. If, for instance, N(01) is specified, this
statement saves the N(01) variable only.
Saves all the T() variables between T(00) and T(99).
Saves only one specified T() variable. If, for instance, T(01) is specified, this
statement saves the T(01) variable only.
Saves both the ACC(00) and ACC(01) variables.
Saves either the ACC(00) variable or ACC(01) variable. If, for instance, ACC(01) is
specified, this statement saves the ACC(01) variable only.
Saves both the DEC(00) and DEC(01) variables.
Saves either the DEC(00) variable or DEC(01) variable. If, for instance, DEC(01) is
specified, this statement saves the DEC(01) variable only.

NOTE 1: The EEPROM has a limited life. It permits up to 100,000 writes. If you frequently
write into the EEPROM, the EEPROM fails to save variables. You should make
efforts to minimize the number of times the EEPROM is written into.
NOTE 2: Do not shut off the control power supply while the save instruction is being executed.
If the control power is insufficient during a write, the write is not properly performed.

• Usage example
Example 1)
save

Loads all the variables.

Example 2)
save P N ACC DEC

Loads the P, N, ACC, and DEC variables.

Example 3)
save P(00)

Loads the P(00) variable.
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select case syntax

Multiple conditional branch

• Format
Format
select <conditional variable>
case <condition value 1>
<instructions 1>
[case <condition value 2>
<instructions 2>
…
[case else]
<instructions n>
end select

Operation overview
Executes <instructions 1 to n-1> within the "case" when
the variable written as the <conditional variable> is
<condition value 1 to n-1> indicated by "case".
The <condition value> must be an immediate value
between -128 and 127. A greater value needs to be
specified with the U() variable or the like. When "case
else" is written, this syntax executes <instructions n> if the
resulting value is other than <condition values 1 to n-1> of
all cases.

• Description
When the variable written as the <conditional variable> is <condition value 1 to n-1> indicated
by "case", this syntax executes <instructions 1 to n-1> within the "case". When "case else" is
written, this syntax executes <instructions n> if the resulting value is other than <condition
values 1 to n-1> of all cases.
<conditional variable>:
You can specify a loadable variable such as P(), N(), or T().
<condition value 1 to n-1>: You can directly enter a numerical value (immediate value)
between -128 and 127. A greater value must be specified with a
U() variable.
<instructions 1 to n>:
Write the instructions to be executed when the condition is met.
You can write one or more lines of instructions. Up to 30 or so
instructions can be written depending on the types of the
instructions.
NOTE 1: If there is no case where the <conditional variable> corresponds to <condition value 1
to n-1> and if "case else" is not written, the execution error (E45) occurs. In such an
instance, write "case else", run a prior check to prevent the input of an irrelevant
<condition value>, or take other appropriate measures.
NOTE 2: When you increase the number of cases, branching takes a considerable amount of
time, thereby decreasing the processing speed. The <condition value> to be executed
rapidly and frequently should be written immediately after "select" to increase the
processing speed.

• Processing cycle
The <conditional variable> is acquired in the first cycle. A "case" condition check is conducted
in the next cycle. When the condition is met, the first instruction in the "case" is executed within
the same cycle. The second and subsequent instructions among the <instructions> are
executed, line by line, in the next cycle. In the cycle subsequent to the cycle of the last
instruction execution in the "case", a jump to "end select" occurs. If the "case" condition is not
met, a jump to the next "case" statement occurs in the next cycle to run a condition check.
For your reference, circled numbers are used in the comment column of the usage example
below to indicate the order of execution in different situations.
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• Usage example
When Xw = 1

select Xw
case 0
Yw=0
speed N(00)
case 1
Yw=1
speed N(00)
case 4
Yw=2
speed N(00)
case else
Yw=3
end select

Order of execution
"case 1" execution
'
(1)
'
(2)
'
'
'
(3)
'
(3)
'
(4)
'
'
'
'
'
'
(5)
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until loop statement

Looping while a condition is not met (post-checkout)

• Format
Format
until <condition>
<instructions>
loop

Operation overview
Executes the <instructions> while the <condition> is not
met. Runs a <condition check> after execution of the
<instructions>.

• Description
This statement executes the <instructions> until the <condition> is met (while the condition is
not met). It runs a <condition check> after execution of the <instructions>. (See the flowchart
below.)

Execution of instructions

Condition check

Y

N

<condition>:

Write a conditional expression in the format stated in Section 3.5, Conditions, of
Section 3, Syntax. You can write an immediate value by directly entering a
numerical value instead of a variable name.
<instructions>: Write the instructions to be executed when the <condition> is not met. You may
write two or more lines as indicated in the usage example. Note, however, that
one line is executed per cycle.

• Processing cycle
The first instruction in the loop is executed in the cycle subsequent to the "until" execution cycle.
The second and subsequent instructions are executed, line by line, in the next cycle. A
condition check is performed in the cycle subsequent to the last instruction execution cycle (in
the "loop" execution cycle). In the next cycle, the program returns to "until". In the cycle that
follows, the first instruction is executed.
For your reference, circled numbers are used in the comment column of the usage example
below to indicate the order of execution in different situations.

• Usage example
until
hpset
Y(00)=1
loop
Y(01)=1

X(00)=1

Order of execution
'(1)
(5)
'(2)
(6)
'(3)
(7)
'(4)
(8)
'
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wait statement

Time control instruction/standby instruction

• Format
(1)
(2)

Format
wait ii.ii
wait <condition>

Operation overview
Stands by for a period of iii.ii [s] (i: integer).
Stands by until the <condition> is met.

• Description
Format (1):

Stands by for a preselected period of time. When the preselected time elapses,
the next line is executed. You can enter a time setting between 000.00 [s] and
999.99 [s].
Format (2): Stands by until the <condition> is met. When the <condition> is met, the next line
is executed.
ii.ii:
Directly enter a numerical setting between 000.00 [s] and 999.99 [s].
<condition>: Write a conditional expression in the format stated in Section 3.5, Conditions, of
Section 3, Syntax.

• Usage examples
Example 1)
wait 1.0

Stands by for 1.0 [s].

Example 1)
wait X(00)=1

Stands by until X(00) = 1.
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while loop statement

Looping while a condition is met (pre-checkout)

• Format
Format
while <condition>
<instructions>
wend

Operation overview
Executes the <instructions> while the <condition> is met.
Runs a <condition check> prior to execution of the
<instructions>.

• Description
This statement executes the <instructions> while the <condition> is met. It runs a <condition
check> before executing the <instructions>. It jumps to "wend" without executing the
<instructions> if the condition is not met.
(See the flowchart below.)

Condition check

N

Y
Execution of instructions

<condition>:

Write a conditional expression in the format stated in Section 3.5, Conditions, of
Section 3, Syntax. You can write an immediate value by directly entering a
numerical value instead of a variable name.
<instructions>: Write the instructions to be executed when the <condition> is not met. You may
write two or more lines as indicated in the usage example. Note, however, that
one line is executed per cycle.

• Processing cycle
The condition check is executed in the first cycle. In the next cycle, the first instruction in the
loop is executed. The second and subsequent instructions are executed, line by line, in the
next cycle. When this statement exits the loop, it executes the instruction subsequently to
"wend" in the cycle next to the condition check cycle.
For your reference, circled numbers are used in the comment column of the usage example
below to indicate the order of execution in different situations.

• Usage example
until

loop
Y(01)=1

X(00)=1
hpset
Y(00)=1

Order of execution
'(1)
(5)
'(2)
(6)
'(3)
(7)
'(4)
(8)
'
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inc statement

Increment command

• Format
Format
inc <variable>

Operation overview
Addition 1dig to value of <variable>

• Description
Addition 1digit to value of <variable>
<variable> = <variable> + 1
NOTE) In execute inc statement at the <variable> is positive maximum value
(e.g 7FFFFFFF:HEX), over flow error occur and E45(execution error ) occur.

• Usage examples
<Code Window>
entry
LOOP : inc U(00)
U(00) = U(00) and U(15)
Yw=U(00)
wait 0.5
goto LOOP
end
<Data Window>
U(15)=255

;Increment U(00)
;Mask low 8bit
;Output U(00) to Yw
;Wait 0.5sec

<code description>
Each 0.5sec, increment U(00) and output low 8bit of the value to Yw.
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dec statement

Decrement command

• Format
Format
dec <variable>

Operation overview
subtract 1dig to value of <variable>

• Description
Subtract 1digit to value of <variable>
<variable> = <variable> - 1
NOTE) In execute dec statement at the <variable> is negative minimum value
(e.g 80000000:HEX), under flow error occur and E45(execution error ) occur.

• Usage examples
<Code Window>
entry
LOOP : dec U(00)
U(00) = U(00) and U(15)
Yw=U(00)
wait 0.5
goto LOOP
end
<Data Window>
U(15)=255

;decrement U(00)
;Mask low 8bit
;Output U(00) to Yw
;Wait 0.5sec

<code description>
Each 0.5sec, decrement U(00) and output low 8bit of the value to Yw.
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6.5

Motion Instructions

LEVEL 2
cam

Simple electric cam control command

• Format
Format

Operation overview
Start electric cam control
Stop electric cam control

cam s
cam r

• Description
This statement commands start and stop electric cam control. Simple electric cam control is
started when input external encoder signal to position command input terminal (PLUSP-PULSN,
SIGP-SIGN) and execute cam s statement. In this case pulse train input mode(FA-11) is set to
A-b or b-A.
Electric cam data defines on code area by cdata statement. cdata can define any number.
It is select a cdata by restore statement. Simple electric cam control is started by cam s
statement after clear previous calculated data for cam.
Simple electric cam position data is multiply position command input terminal (PLUSP-PULSN,
-EXD
SIGP-SIGN ) counts by 2
, and execute modulo calculation use MODL variable.
Simple electric cam command and speed command are can execute at the same time.
In this case, execute speed command at first. After execute simple electric cam command.
Simple electric cam commands diagram shown below.

restore
cdata CAM0
data xxxx
data xxxx
data xxxx
data xxxx
data xxxx
end cdata

module
MODL

2-EXD

cam s

sync

cdata CAM1
data xxxx
data xxxx
data xxxx
data xxxx
data xxxx
end cdata

PULS,SIG
(External encoder)

Positional command
generation

cam r,
mov and so on
EGRAN

Positional
control

EGRAD

sync
cam s
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(i)cam s
This instruction is started simple electric cam control and read electric cam data specified by
restore instruction.
Execute restore instruction before cam s or the cam data is misaligned.
The cam position data are cleared when read the number of MODL.
Simple electric cam control can stop "cam r" or "stop" instruction.
(ii)cam r
This instruction is stopped simple electric cam control.
A driver dose not stop only "cam r" instruction, when the driver controlled both "speed" and
"cam s" instruction. The driver can stop "stop" instruction.
NOTE1) Execute restore instruction and defines MODL and EXD variables before
execute cam s instruction.
NOTE2) Path of simple electric cam shifts by the cause of cam data number and
resolution of external encoder. Evaluate the influence between the shifts and machine
accuracy.

• Usage example
Example 1 : This example is change cam data by input signal.
<Code Window>
entry
EXD=0
MODL=200
MAIN: wait X(11) = 0
wait X(11) = 1
;Wait X(11) on edge
U(00) = Xw
U(00) = U(00) and 3
;Select cam data by X(00) and X(01)
select U(00)
case 0
restore CAM0
case 1
restore CAM1
case 2
restore CAM2
case 3
restore CAM3
end select
cam s
wait X(11) = 0
cam r
goto MAIN
end
cdata CAM 0
300,310,320,330,340,350
…………
end cdata
cdata CAM 1
400,410,420,430,440,450
…………
end cdata
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cdata CAM 2
500,510,520,530,540,550
…………
end cdata
cdata CAM 3
600,610,620,630,640,650
…………
end cdata
Example 2 : Example in Pick and Place machine on belt conveyer
< Code Window >
entry
EXD = 0
MODL = 200
MAIN: wait X(11)=0
wait X(11)=1
speed N(00) ACC(0) DEC(0)
wait X(10) =1
restore CAM0
cam s
wait X(10) = 0
stop
mov P(01) N(01) ACC(0) DEC(0)
goto MAIN
end
cdata CAM 0
300,310,320,330,340,350
………………………
end data
< Data Window >
P(00) = 0[pls], N(00)=1000[min-1], N(01)=3000[min-1],ACC(0)=0.1[s],DEC(0)=0.1[s]
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LEVEL 2
cdata statement

Simple electric cam data define command

• Format
Format
cdata <cam data name>
val1,val2,val3,val4,val5,val6
….
…, …, …, …, …, val*
end cdata

Operation overview
Start electric cam data define.
Define cam data value from val1 to val* .
( max 6 data in a line )
End electric cam data define.

• Description
This instruction defined electric cam data. These data in cdata that is define by the <cam name>
of restore instruction are read as cam when cam s is executed.
These data are in order of the definition. Max 6 number can set in a line of program editor.
It is necessary that the data number in cdata is equal MODL value. if it is not equal the driver
behavior will be incorrect.
val1 - val* is signed 1w value (to -32768 from 32767)
NOTE1) cdata - end cdata instruction has to write outside entry - end instruction.
NOTE2) Execute restore instruction before cam s instruction.
NOTE3) Take care of the data number of c data instruction. Because data number of c data and
MODL variable can not refer.
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hp statement

Homing

• Format
Format
hp N(i) [ACC(k)] [DEC(m)]

Operation overview
Invokes a move to the home position.

• Description
The "hp" statement invokes a move to the home position (second home) at a specified speed of
N(i). Specify the acceleration/deceleration time with ACC(k)/DEC(m). If the ACC(k) and
DEC(m) parameters are not specified, the current settings take effect. As is the case with the
"mov" statement, the "hp" statement can provide an S-curve for acceleration/deceleration. For
details, see the information on the "hpset" statement. Note that the "hp" statement does not
proceed to the next processing line until the positioning detection range (Fb-23) is reached. If
the next line needs to be processed to advance the program during a return to the second home,
use the parallel execution function of "mov".
N(j):

ACC(k):

DEC(m):

-1

Specify the move speed on the presumption that 1 dig = 1 min . The direction of
rotation is unaffected by the N(j) sign and opposite to the sign of the present position
POS.
Specify the time of acceleration from zero speed to N(j) on the presumption that 1
dig = 0.01 s. Set this setting as the time required to reach the maximum speed
Nmax as indicated above and not as the 0-to-N(j) time setting Ta.
Specify the time of deceleration from N(j) to zero speed on the presumption that 1
dig = 0.01 s. Set this setting as the time required to complete deceleration from the
maximum speed Nmax as indicated above and not as the N(j)-to-0 time setting Td.

NOTE 1: If the [N(j)], [ACC(k)], or [DEC(m)] parameter is not specified for the first motion
instruction after "entry", the execution error (E45) occurs. Therefore, you must specify
the [N(j)], [ACC(k)], and [DEC(m)] parameters at least once.
NOTE 2: If N(j) = 0, the execution error (E45) occurs.
NOTE 3: If the distance between the present stop position and home position is short, the
speed may not thoroughly increase to the preselected level so that deceleration
occurs prematurely to terminate the positioning operation.
NOTE 4: As indicated in the operation diagram, the hp statement performs a trapezoidal
acceleration/deceleration process and issues a position command to manage the stop
position. Therefore, if a low gain is selected for speed control or position control, a
deviation may occur so that the resulting acceleration/deceleration process is not
trapezoidal.
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• Usage example
<Data Window>
ACC(0)=50[s] , DEC(0)=50[s] ,
1
-1
-1
N(00)=50 [min- ] , N(01)=5[min ] , N(02)=20[min ] ,
P(00)=100[pls] , P(01)=200[pls] , P(02)=600 [pls]
<Code Window>
entry
ort 3 N(02) N(01) ACC(0) DEC(0)
mov P(00) N(00) ACC(0) DEC(0)
mov P(01)
mov P(02)
hp
N(00) ACC(0) DEC(0)
end

… (1)

'
'Homing
'Positioning at P(00)
'Positioning at P(01)
'Positioning at P(00)
'Moving to the home position
'

… (2)
… (3)
… (4)
… (5)
… (6)

Performing the above process invokes the following position changes (from home position) and
speed changes:
Speed
mov P(00)

mov P(01)

mov P(02)

N(00)
P(02)=300
Home position

P(00)=100

Position

P(01)=200

"hp" instruction execution
Speed
-1

50[min ]
0.5s

100 pls

200 pls

300 pls

-20[min-1]

100+200+300=600 pls
0.5s

0.5s 0.5s

0.5s 0.5s

0.5s

SON

ORL

Instruction executed

ort

mov P(0)

mov P(1)

mov P(1)

mov P(1)

Servo lock
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hpset statement

Home position (second home) alignment

• Format
Format

HPOS ← POS

hpset

Operation overview

• Description
The "hpset" statement registers the present position as the home position (second home).
When the second home is set up in this manner, the same processing operations can be
performed even if the work position changes each time due to relative position selection.
The home differs from the home position. In the initial state prevailing upon program startup,
the home coincides with the home position. However, the use of the "hpset" instruction makes it
possible to define the present position as the home position. Therefore, even if the "mov"
instruction for the same setup position is executed before and after "hpset" instruction execution,
different positions result from positioning. See the figure below. It is also well to remember that
the second home can be confirmed with HPOS.
<Home position (second home)>
The home position (second home) differs from the home. In the initial state prevailing
immediately after the program starts upon power ON, the home coincides with the home
position. However, the use of the "hpset" instruction makes it possible to define the present
position as the home position. As a result, the relationship between the home position and
home changes after "hpset" instruction execution. The resulting change in the positional
relationship is shown in the figure below. The figure below relates to situations where an
incremental encoder is used. If an absolute position encoder is used, the stop or equivalent
position is reached when POS ≠ 0 upon power ON.

Second home position
HPOS=
POS=
10000
10000

Home position
POS=0

POS=
20000

mov P(00)
(P(00)=10000)
Before "hpset"
(Upon power ON)

mov P(00)
(P(00)=10000)

hpset

After "hpset"
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• Usage example (incremental encoder used)
The figure below summarizes the positional relationship among the program's home, second
home, and positioning point.
<Data Window>
P(00)=10000
P(01)=9000
P(02)=8000
ACC(0)=50
<Code Window>
entry
ort 3
nchg
mov
hpset
mov
end

: N(00)=3000
: N(01)=30
: N(02)=8000
: DEC(0)=50

' Position relative to the second home

N(01) N(01) ACC(0) DEC(0)
P(01) N(01)
P(00) N(00) ACC(0) DEC(0)
P(02) N(02)

'(1)
'(2)
'
'(3)
'(4) Sets the second home.
'(5) Specifies the position relative to the second home.

Home
Home limit
switch
(ORL)

Second home

Position
12000
10000
(1)Power ON
POS=0
HPOS=0

(2)Homing
POS=0
HPOS=0

(3)mov P(00)
POS=10000
HPOS=10000

(4)hpset
POS=0
HPOS=0
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LEVEL 2
imov statement

constant rate of feeding

• Format
Format
imov P(i) [N(j)] [ACC(k)] [DEC(m)][;&]

Operation overview
Accomplishes positioning at a specified speed of
N(j) to reach the position specified by adding
actual position PRF and P(*). ACC(k) and
DEC(m) are used to specify the
acceleration/deceleration time as the time
required to attain the maximum speed

• Description
The "imov" statement achieves positioning at a specified speed of N(j) to reach the position
specified by adding actual position PRF and P(*). Use ACC(k) and DEC(m) to specify the
acceleration time and deceleration time as the time required to reach the maximum speed. If the
[N(j)], [ACC(k)], and [DEC(m)] parameters are not specified, the current settings take effect. If
[;&] is not specified, the statement does not process the next line until the positioning detection
range (Fb-23) is reached. To process the next line while performing a positioning process, it is
necessary to specify [;&] for each "imov" (parallel execution). In this instance, however, a user
program is required for monitoring the INP variable to determine whether positioning is
completed.
Positioning by "imov" is linear acceleration/deceleration. However, a pseudo-S-curve can be
specified for vibration reduction purposes. The S-curvature can be varied over three steps by
specifying the S-curve ratio (Fb-30) or SCV variable. For the S-curve ratio (Fb-30), refer to
Section 6, Details of Parameters, of the instruction manual for the servo main unit. For the SCV
variable, see the SCV variable description in this document.
P(i):

N(j):

ACC(k):

DEC(m):

;&:

Specify the position to reach on the presumption that encoder pulse resolution.
Refer to chapter 3.6 about this unit. Positioning to reach the position specified by
adding actual position PRF and P(i). You must specify the position relative to the
home position (second home).
A set unit at a specified speed is different depending on the model. refer to chapter
3.6 at unit. The direction of rotation is unaffected by the N(j) sign and in agreement
with the sign of the value obtained by subtracting the present position POS from the
preselected position P(i).
Specify the time of acceleration from zero speed to N(j) on the presumption that 1
dig = 0.01 s. Set this setting as the time required to reach the maximum speed
Nmax as indicated above and not as the 0-to-N(j) time setting Ta. The expression of
the relationship between Ta and ACC(k) is indicated in the following figure.
Specify the time of deceleration from N(j) to zero speed on the presumption that 1
dig = 0.01 s. Set this setting as the time required to complete deceleration from the
maximum speed Nmax as indicated above and not as the N(j)-to-0 time setting Td.
The expression of the relationship between Td and DEC(m) is indicated in the
following figure.
You can specify the parallel execution mode. In the parallel execution mode, the
"mov" statement begins to process the line next to the "mov" line in the cycle next to
the start of positioning. If the parallel execution mode is not specified, the statement
does not process the next line until the positioning detection range (Fb-23) is
reached.
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Shown the "imov" example following.
Format (1):

imov P(00) N(00) ACC(0) DEC(0)

Maximum speed Nmax

DEC(0)

ACC(0)

Preselected Acceleration
time
speed

Deceleration
time

N(00)

ACC(k)=Nmax/N(j) × Ta
DEC(m)=Nmax/N(j) × Td
Preselected
position

P(00)

Td

Ta

NOTE 1: If the [N(j)], [ACC(k)], or [DEC(m)] parameter is not specified for the first motion
instruction after "entry", the execution error (E45) occurs. Therefore, you must specify
the [N(j)], [ACC(k)], and [DEC(m)] parameters at least once.
NOTE 2: If N(j) = 0, the execution error (E45) occurs.
NOTE 3: Ensure that the amount of movement per instruction is within the range from 2147483647 to 2147483647 pulses (-65535 to 65535 revolutions). If any greater
value is given, the servomotor reverses.
Example) If you select a position setting of 2147483647 while the present position is 10000, the servomotor reverses until the position counter overflows once and then
reads 2147483647.
NOTE 4: If the distance between the present stop position and preselected position is short, the
speed may not thoroughly increase to the preselected level so that deceleration
occurs prematurely to terminate the positioning operation.
NOTE 5: As indicated in the operation diagram, the hp statement performs a trapezoidal
acceleration/deceleration process and issues a position command to manage the stop
position. Therefore, if a low gain is selected for speed control or position control, a
deviation may occur so that the resulting acceleration/deceleration process is not
trapezoidal.
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• Usage example
Example1:
<Data Window>
ACC(0)=50[s], DEC(0)=50[s]
N(00)=500[min-1], N(01)=50[min-1],N(02)=20[min-1]
P(00)=6000[pls], P(01)=-5000[pls]

<Code Window>
entry
MAIN: imov
P(00) N(00) ACC(0) DEC(0)
wait
0.1
imov
P(01) N(01) ACC(0) DEC(0)
wait
0.1
goto MAIN
end

……(1)

;6000pulses advancement …(2)
…(3)
;5000pulses return
…(4)
…(5)
…(6)

[code description]
Following description is in case of actual position command PRF=0.
(1) Setting variables in <Data Window> to use program editor.
(2) Moving forward 6000pls at 500min-1.
It positions it in PRF+6000 pulses. New PRF=PRF+6000.
(3) Wait 0.1sec
(4) Moving reverse 5000pls at -50min-1. It positions it in PRF-5000 pulses.
(5) Wait 0.1sec
(6) Return MAIN.
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Example2: Index table control (nearly path).
<Data Window>
ACC(0) = 50[s], DEC(0)=50[s]
N(00)=500[min-1], N(01)=50[min-1], N(02)=20[min-1]
U(15)=32768 * 10[pls]
;pulse number of 1 revolution of index table.
U(13)=359
;Limit value
<Code Window>
entry
ort 4 N(00) N(01) ACC(0) DEC(0)
U(14)=U(15)/2
P(00)=0
MAIN: wait X(11)=0
wait X(11)=1
U(00)=Xw
U(00)=U(00) and 511

;homing
;180 degree
; P(00) initialize
;
; Wait input on edge of X(11)
; Input to U(00) all X() terminal state
; Input to U(00) X(0) - X(8)

ifs U(00) >= U(13)
then
U(00)=U(13)
end if

; The data U(00) is limited from 0 by 359

U(01)=U(15)*U(00)
P(01)=U(01)/360

; Data is converted into the
;
number of servo pulses.

if P(01)=P(00) then MAIN

;If the value and the last value is equal,
;
return MAIN.
;U(01) = new position - last position
;U(02) is absolute of travel distance.
; P(00) is new position for next step.

U(01)=P(01)-P(00)
U(02)=abs U(01)
P(00)=P(01)
ifs U(02)>U(14)
then
ifs U(01) >0
then
P(02)=U(01)-U(15)
else
P(02)=U(01)+U(15)
end if
else
end if

;select near path.
; If U(02) > 180 deg, this is long path.
; so change near path.

imov P(02) N(00) ACC(0) DEC(0)
goto MAIN
end

; move to a specified angle.

NOTE ) When "imov " is used, the operation overflow is not occurred
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[code description]
Get the state X(0) - X(08) at binary, when X(11) change 0 to 1. Input X(0) - X(8) change to
specified degree for index table angle.
This sample is controlled so that the direction of the rotation may become a shortcut.
Loop
number
initial
(1)
(2)
(3)
(4)
(5)
(6)
(7)

input
position
X(00)-X(08)
30
300
90
250
350
90
180

A last position
32768*10/360
P(00)
0
0
30
300
90
250
350
90

New position
32768*10/360
P(01)
30
300
90
250
350
90
180

travel distance
32768*10/360
P(02)
30
-90
150
160
100
100
90

Actual position
32768*10/360
POS
30
-60
90
250
350
450
540

350
Limit sensor

0

30

(5)

(1)

Index table
300
(2)

(3)

Gear 1/10

(6)
90

SERVO MOTOR

250

(4)

180
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mov statement

Positioning instruction

• Format
(1)
(2)
(3)

Format
mov P(i) [N(j)] [ACC(k)] [DEC(m)][;&]
mov P(Xn) [N(j)] [ACC(k)] [DEC(m)][;&]
mov P(Xw) [N(j)] [ACC(k)] [DEC(m)][;&]
mov Z [N(j)] [ACC(k)][;&]

Operation overview
Accomplishes positioning at a specified speed of
N(j) to reach the position specified by P(*).
ACC(k) and DEC(m) are used to specify the
acceleration/deceleration time as the time
required to attain the maximum speed. If Z is set
instead of P(*), positioning is accomplished to
arrive at a Phase Z position. (* = i, Xn, Xw)
N(j)

Preselected
position

Preselected DEC(m)
speed
Acceleration
Deceleration
time
time

ACC(k)

(4)

P(*)

• Description
The "mov" statement achieves positioning at a specified speed of N(j) to reach the position
specified by P(*). Use ACC(k) and DEC(m) to specify the acceleration time and deceleration
time as the time required to reach the maximum speed. If Z is set instead of P(*), positioning is
accomplished to arrive at the phase Z position. If the [N(j)], [ACC(k)], and [DEC(m)] parameters
are not specified, the current settings take effect. If [;&] is not specified, the statement does not
process the next line until the positioning detection range (Fb-23) is reached. To process the
next line while performing a positioning process, it is necessary to specify [;&] for each "mov"
(parallel execution). In this instance, however, a user program is required for monitoring the
INP variable to determine whether positioning is completed.
Positioning by "mov" is linear acceleration/deceleration. However, a pseudo-S-curve can be
specified for vibration reduction purposes. The S-curvature can be varied over three steps by
specifying the S-curve ratio (Fb-30) or SCV variable. For the S-curve ratio (Fb-30), refer to
Section 6, Details of Parameters, of the instruction manual for the servo main unit. For the SCV
variable, see the SCV variable description in this document.
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The common precautions for all the "mov" formats are described below:
NOTE 1: If the [N(j)], [ACC(k)], or [DEC(m)] parameter is not specified for the first motion
instruction after "entry", the execution error (E45) occurs. Therefore, you must specify
the [N(j)], [ACC(k)], and [DEC(m)] parameters at least once.
NOTE 2: If N(j) = 0, the execution error (E45) occurs.
NOTE 3: Ensure that the amount of movement per instruction is within the range from 2147483647 to 2147483647 pulses (-65535 to 65535 revolutions). If any greater
value is given, the servomotor reverses.
Example) If you select a position setting of 2147483647 while the present position is 10000, the servomotor reverses until the position counter overflows once and then
reads 2147483647.
NOTE 4: If the distance between the present stop position and preselected position is short, the
speed may not thoroughly increase to the preselected level so that deceleration
occurs prematurely to terminate the positioning operation.
NOTE 5: In the initial state prevailing upon program startup, the home coincides with the home
position (second home). However, the use of the "hpset" instruction makes it possible
to define the present position as the home position. Therefore, even if the "mov"
instruction for the same setup position is executed before and after "hpset" instruction
execution, different positions result from positioning.
NOTE 6: As indicated in the operation diagram, the hp statement performs a trapezoidal
acceleration/deceleration process and issues a position command to manage the stop
position. Therefore, if a low gain is selected for speed control or position control, a
deviation may occur so that the resulting acceleration/deceleration process is not
trapezoidal.
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(Continued from the previous page on the "mov" instruction)

Format (1): Positioning instruction for direct selection (mov P(j))
This format is used to directly specify the position to reach with P(i) and achieve
positioning at a speed of N(j). Use ACC(k) and DEC(m) to specify the acceleration
time and deceleration time. The resulting operating waveform is shown below.
Format (1): mov P(00) N(00) ACC(0) DEC(0)
Maximum speed Nmax

DEC(0)

ACC(0)

Preselected Acceleration
time
speed

Deceleration
time

N(00)

ACC(k)=Nmax/N(j) × Ta
DEC(m)=Nmax/N(j) × Td
Preselected
position

P(00)

Td

Ta
P(i):

Specify the position to reach on the presumption that 1 dig = 1/32768 revolution.
You must specify the position relative to the home position (second home).
P(U(j)):
P() is indirectly specified by U(j). At U(j)=80, P(80) is specified.
In this case, U(j) has to be 0 to 99. If it is not, E45 execution error occur.
-1
N(j):
Specify the move speed on the presumption that 1 dig = 1 min . The direction of
rotation is unaffected by the N(j) sign and in agreement with the sign of the value
obtained by subtracting the present position POS from the preselected position P(i).
N(U(j)):
N() is indirectly specified by U(j). At U(j)=12, N(12) is specified.
In this case, U(j) has to be 0 to 15. If it is not, E45 execution error occur.
ACC(k): Specify the time of acceleration from zero speed to N(j) on the presumption that 1
dig = 0.01 s. Set this setting as the time required to reach the maximum speed
Nmax as indicated above and not as the 0-to-N(j) time setting Ta. The expression of
the relationship between Ta and ACC(k) is indicated in the above figure.
DEC(m): Specify the time of deceleration from N(j) to zero speed on the presumption that 1
dig = 0.01 s. Set this setting as the time required to complete deceleration from the
maximum speed Nmax as indicated above and not as the N(j)-to-0 time setting Td.
The expression of the relationship between Td and DEC(m) is indicated in the above
figure.
;&:
You can specify the parallel execution mode. In the parallel execution mode, the
"mov" statement begins to process the line next to the "mov" line in the cycle next to
the start of positioning. If the parallel execution mode is not specified, the statement
does not process the next line until the positioning detection range (Fb-23) is
reached.
NOTE 1: When the preselected position value is increased or decreased with the P() variable, it
increases or decreases even after the 2147483647 or -2147483647 limit is exceeded
(in cases where a fixed-length feed or like operation is performed).
Example) If the specified position is -2147418112 while the present position is
2147418112, the servomotor will be moved by +131072 in the forward direction and
stopped. The resulting stop position is -214741811.
NOTE 2: Since the common precautions for "mov" use are presented earlier, you should also
refer to them.
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Format (2): Positioning instruction for input terminal bit indirect selection (mov P(Xn))
This format provides positioning at a speed of N(j) to reach the P(Xn) position that
has the number indicated by Xn. Use ACC(k) and DEC(m) to specify the
acceleration time and deceleration time. If the X(j) terminal is ON at the time of
instruction execution, the position setting is P(j) (the position setting is P(7) when
X(7) = 1). When two or more X() terminals are used for signal input, the signal
having the smallest number becomes the associated number. The resulting
operating waveform is shown below.
Maximum speed Nmax

DEC(0)

ACC(0)

Preselected Acceleration
time
speed

Deceleration
time

N(00)

ACC(k)=Nmax/N(j) × Ta
DEC(m)=Nmax/N(j) × Td
Preselected
position

P(00)
When X(7) = 1
↓
P(Xn) = P(7)

Td

Ta
P(Xn):

N(j):

ACC(k):

DEC(m):

;&:

Use the P() variable to specify the position to reach on the presumption that 1 dig =
1/32768 revolution. You must specify the position relative to the home position
(second home).
-1
Specify the move speed on the presumption that 1 dig = 1 min . The direction of
rotation is unaffected by the N(j) sign and in agreement with the sign of the value
obtained by subtracting the present position POS from the preselected position P(i).
Specify the time of acceleration from zero speed to N(j) on the presumption that 1
dig = 0.01 s. Set this setting as the time required to reach the maximum speed
Nmax as indicated above and not as the 0-to-N(j) time setting Ta. The expression of
the relationship between Ta and ACC(k) is indicated in the above figure.
Specify the time of deceleration from N(j) to zero speed on the presumption that 1
dig = 0.01 s. Set this setting as the time required to complete deceleration from the
maximum speed Nmax as indicated above and not as the N(j)-to-0 time setting Td.
The expression of the relationship between Td and DEC(m) is indicated in the above
figure.
You can specify the parallel execution mode. In the parallel execution mode, the
"mov" statement begins to process the line next to the "mov" line in the cycle next to
the start of positioning. If the parallel execution mode is not specified, the statement
does not process the next line until the positioning detection range (Fb-23) is
reached.

NOTE 1: When this format is used, the execution error (E45) if no signal is input to X(j).
Therefore, check in advance that a signal is input to X() or take other appropriate
measures.
If instruction level2 ( LEVEL 2 ), Input terminal can be masked Xn mask bit(FC-43).
Refer to example 6 for this details.
NOTE 2: It is recommended that the "wait X(j)" or "wait Xw" instruction be inserted prior to
"mov" execution to finalize the signal input to X().
NOTE 3: Since the common precautions for "mov" use are presented earlier, you should also
refer to them.
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Format (3): Positioning instruction for input terminal binary indirect selection (mov P(Xw))
This format provides positioning at a speed of N(j) to reach the P(Xw) position that
has the number indicated by Xw. Use ACC(k) and DEC(m) to specify the
acceleration time and deceleration time. When the instruction is executed, the ON
states of all X() terminals are subjected to binary input, and the P(j) position having
the same number as the input value is selected as the position setting (the position
setting is P(5) when Xw = 5). The resulting operating waveform is shown below.
Format (3): mov P(Xw) N(00) ACC(0) DEC(0)
Maximum speed Nmax

DEC(0)

ACC(0)

Preselected Acceleration
time
speed

Deceleration
time

N(00)

ACC(k)=Nmax/N(j) × Ta
DEC(m)=Nmax/N(j) × Td
Preselected
position

P(00)
When Xw = 5
↓
P(Xn) = P5)

Td

Ta
P(Xw):

N(j):

ACC(k):

DEC(m):

:&:

Use the P() variable to specify the position to reach on the presumption that 1 dig =
1/32768 revolution. You must specify the position relative to the home position
(second home).
-1
Specify the move speed on the presumption that 1 dig = 1 min . The direction of
rotation is unaffected by the N(j) sign and in agreement with the sign of the value
obtained by subtracting the present position POS from the preselected position P(i).
Specify the time of acceleration from zero speed to N(j) on the presumption that 1
dig = 0.01 s. Set this setting as the time required to reach the maximum speed
Nmax as indicated above and not as the 0-to-N(j) time setting Ta. The expression of
the relationship between Ta and ACC(k) is indicated in the above figure.
Specify the time of deceleration from N(j) to zero speed on the presumption that 1
dig = 0.01 s. Set this setting as the time required to complete deceleration from the
maximum speed Nmax as indicated above and not as the N(j)-to-0 time setting Td.
The expression of the relationship between Td and DEC(m) is indicated in the above
figure.
You can specify the parallel execution mode. In the parallel execution mode, the
"mov" statement begins to process the line next to the "mov" line in the cycle next to
the start of positioning. If the parallel execution mode is not specified, the statement
does not process the next line until the positioning detection range (Fb-23) is
reached.

NOTE 1: Since the position variable ranges from P(00) to P(99), the execution error (E45)
occurs if the Xw value exceeds 99.
If instruction level2 ( LEVEL 2 ), Input terminal can be masked XW mask bit(FC-42).
Refer to example 6 for this details.
NOTE 2: It is recommended that the "wait X(j)" or "wait Xw" instruction be inserted prior to
"mov" execution to finalize the signal input to X().
NOTE 3: Since the common precautions for "mov" use are presented earlier, you should also
refer to them.

6-47

Chapter 6 Instruction Word Reference

Format (4): Positioning instruction for input terminal binary indirect selection (mov Z)
This format is used to rotate the servomotor at a speed of N(j) in the direction
indicated by N(j) and accomplish positioning to reach the first phase Z. Use ACC(k)
to specify the acceleration time. When the servomotor stops at the phase Z position,
positioning is accomplished to remain in the present position without changing the
servomotor position. The resulting operating waveform is shown below.
Format (4): mov Z

N(00) ACC(0)

ACC(0)

Maximum speed Nmax

Acceleration time

ACC(k)=Nmax/N(j) × Ta

Preselected
position

First Z signal
position

N(00)
Phase Z signal

N(j):
ACC(k):

;&:

Ta
-1

Specify the move speed on the presumption that 1 dig = 1 min . Unlike Formats 1)
to 3), the direction of rotation agrees with the sign of N(j).
Specify the time of acceleration from zero speed to N(j) on the presumption that 1
dig = 0.01 s. Set this setting as the time required to reach the maximum speed
Nmax as indicated above and not as the 0-to-N(j) time setting Ta. The expression of
the relationship between Ta and ACC(k) is indicated in the above figure.
You can specify the parallel execution mode. In the parallel execution mode, the
"mov" statement begins to process the line next to the "mov" line in the cycle next to
the start of positioning. If the parallel execution mode is not specified, the statement
does not process the next line until the positioning detection range (Fb-23) is
reached.

NOTE 1: When Format (4) is used, there is a time lag between the instant at which the Z signal
is entered and the instant at which the entered Z signal is recognized by the controller.
It is therefore recommended that you use Format (4) at a low speed setting.
NOTE 2: Since the common precautions for "mov" use are presented earlier, you should also
refer to them.
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• Usage examples (mov)
Example 1) Using Format (1)
<Data Window>
ACC(0)=50[s] , DEC(0)=50[s] ,
-1
-1
N(00)=50 [min ] , N(01)=5[min-1] , N(02)=20[min ]
P(00)=6000 [pls]

… (1)

<Code Window>
entry
ort 3 N(02)
mov P(00)
end

… (2)
… (3)
… (4)

N(01)
N(00)

ACC(0) DEC(0) Achieves homing.
ACC(0) DEC(0) Accomplishes positioning.

<Description>
1) From Program Editor's Data Window, set various variable data 1).
2) The homing process (ort) is performed.
3) After completion of homing, the speed increases at a speed gradient (ratio to the
-1
maximum speed) setting of ACC(0) = 50 [s] until N(00) = 50 [min ]. When P(00) is
close to 6000 [pls], deceleration begins and positioning is accomplished to arrive at the
preselected position P(00). The deceleration rate for positioning complies with DEC(0).
4) The program ends. (Even when the program run terminates, the servo remains locked
at the 6000 [pls] position until SON = OFF.)

Speed
-1

50[min ]

6000 pls

Time(s)
-1

-20[min ]

0.5s

0.5s

SON

ORL
Instruction
executed

ort

mov
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Example 2) Using Format (2)
<Data Window>
ACC(0)=50[s] , DEC(0)=50[s] ,
-1
-1
-1
N(00)=50 [min ] , N(01)=5 [min ] , N(02)=20[min ] ,
P(02)=6000 [pls]

… (1)

<Code Window>
entry
ort 3 N(02) N(01) ACC(0) DEC(0) Achieves homing.
wait X(11)=1
Waits until X(11) = 1.
mov P(Xn) N(00) ACC(0) DEC(0) Accomplishes positioning
end

… (2)
… (3)
… (4)
… (5)

<Description>
1) From Program Editor's Data Window, set various variable data 1).
2) The homing process (ort) is performed.
3) After completion of homing, the standby state prevails with the servo locked until the
"X(11) = 1" signal is entered. When the "X(02) = 1" signal is entered in this state and
then the "X(11) = 1" signal is entered to indicate finalization, the next step is executed.
4) The speed increases at a speed gradient (ratio to the maximum speed) setting of
-1
ACC(0) = 50 [s] until N(00) = 50 [min ]. When P(00) is close to 6000 [pls], deceleration
begins and positioning is accomplished to arrive at the preselected position. The
deceleration rate for positioning complies with DEC(0).
5) The program ends. (Even when the program run terminates, the servo remains locked
at the 6000 [pls] position until SON = OFF.)

Speed
-1

50[min ]

6000 pls

Time(s)
-20[min-1]

0.5s

0.5s

0.5s

0.5s

SON

ORL

X(1)

X(2)

Instruction
executed

ort

wait

ｏｒｔ

mov
ｍｏｖ

Servo lock
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Example 3) Using Format (3)
<Data Window>
ACC(0)=50[s] , DEC(0)=50[s] ,
-1
-1
-1
N(00)=50[min ] , N(01)=5[min ] , N(02)=20[min ] ,
P(10)=6000 [pls]

… (1)

<Code Window>
entry
ort 3 N(02) N(01) ACC(0) DEC(0)

… (2)

wait X(11)=1
wait X(11)=0
mov P(Xw) N(00) ACC(0) DEC(0)
end

Achieves homing.
Waits until X(11) = 1.
Waits until X(11) = 0.
Accomplishes positioning.

… (3)
… (4)
… (5)

<Description>
1) From Program Editor's Data Window, set various variable data 1).
2) The homing process (ort) is performed.
3) After the "X(11) = 1" signal is entered upon completion of homing, the standby state
prevails with the servo locked until X(11) = 0. When the "X(00) = 0", "X(01) = 1", "X(02)
= 0", and "X(03) = 1" signals are entered in this state and then the "X(11) = 1" signal is
entered to indicate finalization, the next step is executed.

Speed
50[min-1]

6000 pls

Time(s)

-20[min-1]

0.5s

0.5s

SON

ORL

X(11)

X(3)

1

X(2)

0

X(1)

1

X(0)
Instruction
executed

0
ort

mov

wait

Servo lock
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4) The speed increases at a speed gradient (ratio to the maximum speed) setting of
-1
ACC(0) = 50 [s] until N(00) = 50 [min ]. When P(b'1010) = P(00) is close to 6000 [pls],
deceleration begins and positioning is accomplished to arrive at the preselected
position. The deceleration rate for positioning complies with DEC(0).
5) The program ends. (Even when the program run terminates, the servo remains locked
at the 6000 [pls] position until SON = OFF.)

Example 4) Using Format (4)
<Data Window>
-1
ACC(0)=50[s] , N(00)=50 [min ]
<Code Window>
entry
mov Z N(00) ACC(0)
end

… (1)

… (2)
… (5)

Accomplishes positioning.

<Description>
1) From Program Editor's Data Window, set various variable data (1).
2) The servomotor rotates in accordance with N(00). Positioning is accomplished to arrive
at the first Z signal position. (Even after the program run ends, the servo remains
locked at the 6000 [pls] position until SON = OFF.)

Speed
50rpm

Time(s)
0.5s

SON

Z signal
Instruction
executed

mov
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Example 5) Parallel execution
The "mov" instruction does not pass control to the next line until the positioning detection
range (Fb-23) is reached. However, if the parallel execution mode is specified, the "mov"
instruction starts executing the next instruction in the next execution cycle. Use the parallel
execution mode when you want to exercise output terminal control or cancel the "mov"
instruction while conducting a positioning operation.
Example 5-1) Exercising output terminal control during a positioning operation
Y(00)=0
mov P(00) N(00) ACC(0) DEC(0) ;&
Starts a positioning operation.
Y(00)=1
Sets Y(0) to 1 in the next cycle.
Example 5-2) Aborting a positioning operation when the X(00) terminal is "1"
mov P(00) N(00) ACC(0) DEC(0) ;&
while INP=0
if X(00)=0 then LBL1
stop
LBL1: wend
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Example 6) Using Xn, Xw mask bit setting in P(**) ( LEVEL2 )

Parameter No.

FC-42

Parameter
name

Xw mask bit

Setting range
[Initial value]

Contents

0~3FFF
[3FFF]

In selects program function (FA-22 = Pro), target bit of
variable Xw is equal 0 when it of this parameter is
setting to 0.

Setting

b13

b12

b11

b10

b9

0

0

0

0

0

0

b8
0

1

X(11)

X(10)

X(09)

X(08)

X(07)

X(06)

Setting

b7

b6

b5

b4

b3

b2

0

0

0

0

0

0

0

1

X(05)

X(04)

X(03)

X(02)

X(01)

X(00)

b1

b0

Not function

(0… Xw of select bit is 0 , 1…Xw of select bit is X(**) )
In selects program function (FA-22 = Pro), target bit of
variable Xn is equal 0 when it of this parameter is setting
to 0.

0~3FFF
[3FFF]

FC-43

Setting

b13

b12

b11

b10

b9

0

0

0

0

0

0

b8
0

1

X(11)

X(10)

X(09)

X(08)

X(07)

X(06)

Setting

b7

b6

b5

b4

b3

b2

0

0

0

0

0

0

0

1

X(05)

X(04)

X(03)

X(02)

X(01)

X(00)

Xn mask bit

Condition : X(00) - X(05) = 1, X(06) - X(11) =0
case1
<Code Widow>
entry
U(00)=Xw
mov P(Xw) N(00) ACC(0) DEC(0)
mov P(Xn) N(00) ACC(0) DEC(0)
end

;
;
;
;
;
;
;
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U(00) = 64
mov P(63)
mov P(00)
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b0

Not function

case2
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mov P(15)
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nchg statement

Speed change

• Format
Format
nchg P(i) N(j) [ACC(k)] [DEC(m)]

Operation overview
Changes the speed at a preselected position.

• Description
This instruction is used to change the speed at a specified position while the "mov" or "speed"
instruction is being executed. To effect such a speed change, execute "nchg" before the
positioning instruction "mov" and execute the "mov"/"speed" instruction in the end. The
execution of the "nchg" instruction affects only one instruction ("mov" or "speed") that is
executed after "nchg" execution. When executing the "nchg" instruction, you are supposed to
specify the speed change position P(i), speed change value N(j), acceleration time ACC(k), and
deceleration time DEC(m). To change the speed two or more times, execute "nchg" the same
number of times, and execute "mov"/"speed" in the end. If the ACC(k) and DEC(m) parameters
are not specified, the current settings take effect.
P(i):

Specify the position to reach on the presumption that 1 dig = 1/32768 revolution.
You must specify the position relative to the home position (second home).
P(U(j)):
P() is indirectly specified by U(j). At U(j)=80, P(80) is specified.
In this case, U(j) has to be 0 to 99. If it is not, E45 execution error occur.
-1
N(j):
Specify the new speed to use on the presumption that 1 dig = 1 min . When the
"speed" instruction is executed, the resulting direction of rotation agrees with the sign
of N(j). When the "mov" instruction is executed, the resulting direction of rotation
remains unaffected by the N(j) sign and agrees with the direction of motion invoked
by "mov".
N(U(j)):
N() is indirectly specified by U(j). At U(j)=12, P(12) is specified.
In this case, U(j) has to be 0 to 15. If it is not, E45 execution error occur.
ACC(k): Specify the time of acceleration to N(j) on the presumption that 1 dig = 0.01 s. Do
not set the time required for the speed change but set the time of acceleration to the
maximum speed Nmax.
DEC(m): Specify the time of deceleration to N(j) on the presumption that 1 dig = 0.01 s. Do
not set the time required for the speed change but set the time of deceleration from
the maximum speed Nmax to zero speed.
NOTE 1: If the ACC(k) or DEC(m) parameter is not specified for the first "nchg" instruction after
"entry", the execution error (E45) occurs. Therefore, specify the ACC(k) and DEC(m)
parameters at least once.
NOTE 2: If N(j) = 0, the execution error (E45) occurs without regard to "mov" or "speed".
NOTE 3: If the distance between the speed change position and the stop position is short, the
speed may not thoroughly change to a specified level so that deceleration occurs
prematurely to terminate the positioning operation.
NOTE 4: In the initial state prevailing upon program startup, the home coincides with the home
position (second home). However, the use of the "hpset" instruction makes it possible
to define the present position as the home position. Therefore, even if the "mov"
instruction for the same setup position is executed before and after "hpset" instruction
execution, different speed change positions result.
NOTE 5: As indicated in the operation diagram, the hp statement performs a trapezoidal
acceleration/deceleration process and issues a position command to manage the stop
position. Therefore, if a low gain is selected for speed control or position control, a
deviation may occur so that the resulting acceleration/deceleration process is not
trapezoidal.
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• Usage example
<Data Window>
P(00)=10000
P(01)=3000 : P(02)=P(01)+3000
N(00)=50
: N(01)=30
N(02)=20
ACC(0)=50
: DEC(0)=50
<Code Window>
entry
ort 3
nchg
nchg
speed
wait 1
speed
wait 1
stop
end

N(02) N(02) ACC(0) DEC(0)
P(02) N(02)
P(01) N(01)
N(00) ACC(0) DEC(0)
Waits 1 s.
N(01)
Waits 1 s.

Speed
P(1)

50[min-1]

P(2)

30[min-1]
-1

20[min ]

3000 pls
3000 pls

-20[min-1]
0.5s

1s
1s

SON

ORL

Instruction
executed

wait (1)

speed N(0)

ort

nchg

nchg
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ort statement

Homing command

• Format
ort 0 [N(j)]

Format
[ACC(l)] [DEC(m)]

ort 1 [N(j)]

[ACC(l)] [DEC(m)]

Operation overview
Rotates the servomotor in the forward direction
at a low speed to achieve homing.
Rotates the servomotor in the reverse direction
at a low speed to achieve homing.
Rotates the servomotor in the forward direction
at a high speed to achieve homing 1.
[N(j)]: Homing speed 1
[N(k)]: Homing speed 2
Rotates the servomotor in the reverse direction
at a high speed to achieve homing 1.
[N(j)]: Homing speed 1
[N(k)]: Homing speed 2
Rotates the servomotor in the forward direction
at a high speed to achieve homing 2.
[N(j)]: Homing speed 1
[N(k)]: Homing speed 2
Rotates the servomotor in the reverse direction
at a high speed to achieve homing 2.
[N(j)]: Homing speed 1
[N(k)]: Homing speed 2
Achieves arbitrary homing.

ort 2 [N(j)] [N(k)] [ACC(l)] [DEC(m)]

ort 3 [N(j)] [N(k)] [ACC(l)] [DEC(m)]

ort 4 [N(j)] [N(k)] [ACC(l)] [DEC(m)]

ort 5 [N(j)] [N(k)] [ACC(l)] [DEC(m)]

ort 6

• Description
A total of seven different homing operations can be performed in accordance with a selected
homing mode. Upon completion of homing, the present position and second home values are
set to the homing position offset values (Fb-14 and Fb-15). The "ort" instruction does not
proceed to process the next line until homing is completed. When the "ort" instruction is
executed after "chgORG" instruction execution, the homing operation starts when the ORG
terminal turns ON. However, once the ORG terminal turns ON, the homing instruction cannot
be canceled by turning OFF the ORG terminal. On the other hand, if the "ort" instruction is
executed without executing the "chgORG" instruction, the homing operation starts immediately.
For details on homing patterns, refer to the instruction manual for the servo drive main unit
because the homing patterns are the same as for ORG and ORL terminals. (Note, however,
cancellation cannot be effected by the ORG terminal.)
N(j):

N(k):

ACC(l):

DEC(m):

Set homing speed 1 (high speed) or homing speed (in the low-speed homing mode)
-1
on the presumption that 1 dig = 1 min . The direction of rotation is determined by
the homing mode and ORL terminal status and without regard to N(j).
-1
Set homing speed 2 (low speed) on the presumption that 1 dig = 1 min . The
direction of rotation is determined by the homing mode and ORL terminal status and
without regard to N(k).
Set the acceleration time for homing on the presumption that 1 dig = 0.01 s. Do not
set the time required for acceleration but set the time of acceleration to the maximum
speed Nmax.
Set the deceleration time for homing on the presumption that 1 dig = 0.01 s. Do not
set the time required for deceleration but set the time of deceleration from the
maximum speed Nmax to zero speed.
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NOTE 1: If the N(j), N(k), ACC(k), or DEC(m) parameter is not specified for the first motion
instruction after "entry", the execution error (E45) occurs. Therefore, specify the N(j),
N(k), ACC(k), and DEC(m) parameters at least once.
NOTE 2: If N(j) = 0, the execution error (E45) occurs.
NOTE 3: If the distance between a specified position and present stop position is short, the
speed may not thoroughly increase to a specified level so that deceleration occurs
prematurely to terminate the positioning operation.
NOTE 4: When homing is conducted after home position (second home) setup, the home
position (second home) coincides with the home and serves as the homing offset
position (Fb-14/Fb-15). Therefore, it is necessary to adjust the second home with
"hpset".
NOTE 5: As indicated in the operation diagram, the ort instruction performs a trapezoidal
acceleration/deceleration process and issues a position command to manage the stop
position. Therefore, if a low gain is selected for speed control or position control, a
deviation may occur so that the resulting acceleration/deceleration process is not
trapezoidal.
NOTE 6: Ensure that the movement time for homing does not exceed 30 minutes. If this limit is
exceeded, the homing operation may become erratic.
NOTE 7: Homing is required when an incremental encoder is used. If homing is conducted
during the use of an absolute encoder, the present position and second home values
coincide with the homing position offset values (Fb-14 and Fb-15).
NOTE 8: The low speed should be selected for homing because the internal process will be
delayed by ORL terminal input.

• Usage examples
Example 1) Low-speed homing
<Data Window>
ACC(0)=50 : DEC(0)=50
N(00)=5000
N(02)=50

<Code Window>
entry
ort 0 N(02) ACC(0) DEC(0)
end

<Description>
(1) The servomotor rotates in the forward direction at homing speed N(02).
(2) When the ORL turns ON, the servomotor stops and the resulting stop position becomes
the home.
(Upon completion of homing, the servomotor stops with in a servo-locked state.)
ORL

ON
Speed
Positive
Forward
rotation

(1)

(Fb-13)

(2)

Servolocked

(3)

Negative
Home
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Example 2) High-speed homing 1
<Data Window>
ACC(0)=50 : DEC(0)=50
N(00)=5000
N(01)=3000 : N(02)=50

<Code Window>
entry
ort 2 N(01) N(02) ACC(0) DEC(0)
end

<Description>
(1) The servomotor rotates in the forward
direction at homing speed 1.
(2) When the ORL turns ON, the
servomotor decelerates to a stop.
(3) The servomotor rotates in the reverse
direction at homing speed 2.
(4) When the ORL turns OFF, the
servomotor stops.
(Upon completion of homing, the
servomotor stops in a servo-locked
state.)

ORL

ON
Speed
Positive

Forward
rotation

(2)

N(01)
(1)

Forward
rotation

Positive

Home

Negative

(3) Reverse
(4)
Servolocked

Example 3) High-speed homing 2
<Data Window>
ACC(0)=50 : DEC(0)=50
N(00)=5000
N(01)=3000 : N(02)=50

(3)

rotation

N(02)
Negative

<Code Window>
entry
ort 4 N(01) N(02) ACC(0) DEC(0)
end

<Description>
(1) The servomotor rotates in the forward
direction at homing speed 1.
(2) When the ORL turns ON, the
servomotor decelerates to a stop.
(3) The servomotor rotates in the reverse
direction at homing speed 2.
(4) When the ORL turns OFF, the
servomotor decelerates to a stop.
(5) The servomotor rotates in the forward
direction at homing speed 2.
(6) The first encoder phase Z signal
position after ORL ON is located and
defined as the home.

ORL
Speed

ON

Positive
Forward
rotation

N(01)

1

Servolocked

(6)

(1)

(2)
(5)

(6)
Positive

Negative
(4)

(3)

Home

N(02)
Reverse
rotation
Negative

Example 4) Arbitrary homing
<Data Window>
ACC(0)=50 : DEC(0)=50
N(00)=5000 : P(00)=1000
N(01)=3000 : N(02)=50

Position

<Code Window>
entry
ort 4 N(01) N(02) ACC(0) DEC(0)
mov P(00)
ort 6
end

<Description>
When the ORL terminal signal is entered, the present position is homing-reset as the
homing offset position (Fb-14/Fb-15).
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LEVEL 2
restore statement

Electric cam data specification instruction

• Format
Format
restore <electric cam data name>

Operation overview
The electric cam data used is specified.

• Description
The electric cam data used is specified or re-specified. You must execute "restore" instruction
that set electric cam data before execute "cam s" instruction.
NOTE) If "cam s" instruction is executed before execute "restore" instruction, the execution error
E45 occur. In this case, ignore "cam" instruction.
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speed statement

Speed control instruction

• Format
Format
speed N(j) [ACC(k)] [DEC(m)]

Operation overview
Exercises speed control in accordance with N(j).

• Description
The "speed" instruction performs a speed-controlled operation at a constant speed. Use N(J) to
specify the speed and ACC(k) and DEC(m) to specify the acceleration time and deceleration
time. If the ACC(k) and DEC(m) parameters are not specified, the current settings take effect.
This instruction terminates when one cycle is completed after the start of an operation. In the
next execution cycle, the next line begins to be processed, allowing the program to continue
running. In the meantime, the speed changes to a specified level in accordance with the
specified acceleration and deceleration time settings. To change the speed at a specified
position, execute the "nchg" instruction immediately before "speed" instruction execution (see
under "nchg statement" for details.) If the speed needs to be changed immediately by the
"speed" instruction
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smov statement

Speed/position control changeover

• Format
Format
smov P(i)

Operation overview
Switches from speed control to position control.

• Description
When this instruction is executed during a speed-controlled operation (while the "speed"
instruction is being executed), a positioning operation is started from the point of execution to
reach a specified position P(i). The position setting P(i) for the "smov" instruction is relative to
the execution position. Since the stop position may shift due to a delay in the servo drive's
recognition of the execution, it is recommended that you use a low speed. The "smov"
instruction does not proceed to process the next line until the positioning detection range (Fb23) is reached upon positioning at P(i).
Upon execution, the "smov" instruction changes the internal control to position control and
immediately stops the servomotor at a specified position without linear deceleration. Internally,
this instruction decreases the position control speed command limiter value to N(), sets P(i) as a
position command, and switches to position control. Therefore, no deceleration time setting is
provided and the deceleration rate is mainly determined by the speed/position control gain.
Also, note that the position error prevailing at the instant at which this instruction is executed is
P(i).
P(i):

Set the distance between the "smov" execution position and stop position on the
presumption that that encoder pulse resolution. Refer to chapter 3.6 about this unit.

NOTE 1: If P(i) = 0, the execution error (E45) occurs.

• Usage example
<Data Window>
ACC(0)=50
N(00)=50
N(01)=30

: DEC(0)=50
: P(00)=1000
: P(01)=500

<Code Window>
entry
speed N(00)
wait X(00)=1
speed N(01)
U(00)=abs(NRF) : wait U(00)=N(01)
wait X(01)=1
wait X(01)=0
smov P(01)
end
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Speed
-1

50[min ]
P(0)

-1

30[min ]

500 pls

0.5s

SON

X(00)
X(01)
Instruction
executed

speed

smov
Servo lock
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LEVEL 2
son statement

Servo on instruction

• Format
Format

Operation overview

son

Execute servo on

• Description
This instruction is go to servo on, in the case of RUN terminal assigned. Because a driver is in
servo off status just after the user program is executed.
The driver is into servo lock state in position control mode when "son" instruction is executed at
the driver is in servo off or servo ready.
And at that time, the driver is into trip state if servo drive is in no ready state like under voltage
of main power.
In addition, the servo driver do earth detection about 20msec after execute "son" instruction.
The time between "son" instruction and next step instruction contain until the end of earth
detection and into servo lock state.
NOTE1) If turn off the RUN terminal in servo on by "son" instruction, the servo driver is into
servo off.
NOTE2) The "son" instruction ignore when the servo driver is in servo on.
NOTE3) The model with Modbus communication, the servo on is available via Modbus too.
Servo on and off souse can select "SON statement command source selection"(FP-43).
The relation of "son" instruction, son via modbus and FP-43setting shown following list.
son execution
source

Pro

OP

BotH

Running

program (son)

Execute son

E46 occur

Execute son

program(soff)

Execute soff

Execute soff

Execute soff

Modbus(son)

in son

in soff

Execute son

Execute son

error
response

E46 occur

normally response

normally response

Execute soff

Execute soff

Execute soff

normally response

normally response

normally response

Not execute son

Not execute son

Not execute son

error response

error response

error response

Modbus(soff)

Not execute soff

Not execute soff

Not execute soff

error response

error response

error response

program (son)

command nothing

command nothing

command nothing

program(soff)

command nothing

command nothing

command nothing

Modbus(son)

Not execute son

Not execute son

Not execute son

error response

error response

error response

Modbus(soff)

Not execute soff

Not execute soff

Not execute soff

error response

error response

error response

Modbus(son)

Not execute son

Not execute son

Not execute son

error response

error response

error response

Not execute soff

Not execute soff

Not execute soff

error response

error response

error response

RUN terminal effective

Program state

Modbus(soff)
Not
running

SON terminal effective

Running

Not
running

Modbus(son)

Modbus(soff)

FP-43 setting

error response
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•

Usage example
<code Window>
entry
wait X(11)=1
son
mov P(00) N(0) ACC(0) DEC(0)
end
[code description]
Wait X(11) to be 1, and servo on by "son" instruction. It is assumed servo ready at X(11)=1.
After "son" instruction, exec earth detection (about 20msec) and servo drive is in moving by
"mov" instruction.
About 20msec

RUN terminal

X(11) terminal
Servo drive state

ready

earth detection

servo on
N(00)

speed

"son" instruction
~~~~~~~~~~~~~~~~~~~
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LEVEL 2
soff statement

Servo off instruction

• Format
Format
soff

Operation overview
Execute servo off

• Description
When RUN terminal is assigned, servo driver become to servo off state by "soff" instruction.
After FA-24(servo off wait time ) set time, the servo driver into the state of servo off.
If you want to servo on again after the instruction, execute "son" instruction.
This instruction ignore when RUN terminal is not assigned.

• Usage example
<Code window>
entry
wait X(11)=1
son
mov P(00) N(00) ACC(0) DEC(0)
wait 0.01
soff
end
[code description]
Wait X(11) to be 1, and servo on by "son" instruction. It is assumed servo ready at X(11)=1.
After "son" instruction, exec earth detection (about 20msec) and servo drive is in moving by
"mov" instruction. After wait 10msec, servo driver into servo off.
About 20msec

RUN terminal

X(11) terminal
Servo drive state

ready

earth detection

servo on

servo off
N(00)

speed

"son" instruction
~~~~~~~~~~~~~

P(00)

"soff" instruction

~~~~~
10msec
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speed statement

Speed control instruction

• Format
Format
speed N(j) [ACC(k)] [DEC(m)]

Operation overview
Exercises speed control in accordance with N(j).

• Description
The "speed" instruction performs a speed-controlled operation at a constant speed. Use N(J) to
specify the speed and ACC(k) and DEC(m) to specify the acceleration time and deceleration
time. If the ACC(k) and DEC(m) parameters are not specified, the current settings take effect.
This instruction terminates when one cycle is completed after the start of an operation. In the
next execution cycle, the next line begins to be processed, allowing the program to continue
running. In the meantime, the speed changes to a specified level in accordance with the
specified acceleration and deceleration time settings. To change the speed at a specified
position, execute the "nchg" instruction immediately before "speed" instruction execution (see
under "nchg statement" for details.) If the speed needs to be changed immediately by the
"speed" instruction during an operation, such a speed change can be effected by additionally
executing the "speed" instruction.
When the "speed" instruction is executed, the internal control mode is changed from position
control to speed control. Therefore, the resulting stop position is shifted even when the
operation is performed at zero speed. When the "stop" instruction is executed, for instance, to
stop the servomotor in position control mode as usual, the servomotor decelerates to a stop in
accordance with the deceleration time setting specified by the "speed" instruction.
For positioning by "speed", linear acceleration/deceleration is conducted. However, smooth
acceleration/deceleration is achieved for vibration reduction purposes when a time constant is
set for the speed command filter parameter (Fd-20) or NFILT variable. For the speed command
filter parameter (Fd-20), refer to Section 6, Details of Parameters, of the instruction manual for
the servo main unit. For the NFILT variable, see the NFILT variable description in this
document.
N(j):
ACC(k):

DEC(m):

-1

Specify the speed command N(j) on the presumption that 1 dig = 1 min . The
direction of rotation agrees with the sign of N(j).
Specify the time of acceleration to N(j) on the presumption that 1 dig = 0.01 s. Do
not set the time required for the speed change but set the time of acceleration to the
maximum speed Nmax.
Specify the time of deceleration to N(j) on the presumption that 1 dig = 0.01 s. Do
not set the time required for the speed change but set the time of deceleration from
the maximum speed Nmax to zero speed.

NOTE 1: If you intend to conduct a positioning operation with "mov", "hp", or the like or a torque
control operation with "trq" or the like after "speed" instruction execution, execute the
"stop" instruction beforehand and wait until the zero-speed operation comes to a stop.
NOTE 2: The execution of the "speed" instruction continues at a breakpoint or in the single-step
mode. Therefore, exercise care to avoid machine breakage and other trouble.
NOTE 3: If the parameters are not specified for the first "speed" instruction after "entry", the
execution error (E45) occurs.
NOTE 4: When the "end" instruction is executed, the servomotor decelerates to a stop no
matter whether the "speed" instruction is executed. To let the servomotor operate
continuously, form a loop to prevent "end" from being executed.
NOTE 5: When instruction level2 ( LEVE 2 ), Real speed command value is multiply N(*) by
speed command gain (SPDG LEVE 2 ). Detail is refer to SPDG variable.
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• Usage example
<Data Window>
ACC(0)=0.5 : DEC(0)=0.5
N(00)=5000
N(01)=3000
<Code Window>
entry
speed
wait 5.0
speed
wait 2.0
stop
end

-1

'5000min
-1
'3000min

N(00) ACC(0) DEC(0)
Waits 5 s.
N(01)

Speed
5000[min-1]
3000[min-1]

0.5s

2s
5s

SON

stop

Instruction
executed

speed N(0)

wait 5
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stop statement

Motion operation cancellation

• Format
Format
stop
stop i

Operation overview
Cancels a motion instruction.

LEVEL 2

• Description
To cancel the "hp", "mov", "imov", "nchg", "smov", "speed", "tchg", "trq", "sync" or "csm s"
motion instruction, execute the "stop" instruction. When the "stop" instruction is issued during a
"mov", "speed", or like operation, the servomotor goes into a position servo-locked state. Since
the "sync" instruction immediately cancels an operation, it invokes rapid deceleration if the
servomotor is not stopped.
When there is not [i] option, next step after "stop" instruction is executed at the position is into
imposition range.
When there is [i] option, next step after "stop" instruction is executed after an internal position or
the speed instruction ends without the confirmation whether the position is into imposition range.
[i]: This is the option that is ignore the confirmation whether the position is into imposition range.
NOTE 1) To execute the "imov","mov","hp","nchg","smov",sync","trq" or "tchg" instructions after
execute these instructions again, confirm stop status (0 speed) after execute "stop" instruction.
NOTE 2) There is the position error after "stop i". this error is not cleared at "stop i" instruction.
Therefore, it is necessary to clear it by writing actual position (POS) into PRF variable.
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sync statement

Synchronization control command

• Format
Format

Operation overview
Exercises synchronization control (without providing an
analog bias).
Exercises synchronization control (while providing an
analog bias).
Conducts a speed-controlled operation in compliance
with a speed command from analog input 1.

sync 1
sync 2
sync s

• Description
Use this instruction when synchronizing the servomotor with another or when operating the
servomotor with a pulse train or analog input signal as is the case with the standard model.
When you execute this instruction and enter a synchronization signal (pulse train input signal)
into the drive's position command input (PLSP-PLSN/SIGP-SIGN), the servomotor is
synchronized with the synchronization signal. When executed, this instruction operates in the
position control mode and proceeds to process the next line in the next execution cycle. The
control block diagram is shown below.
To revert to the normal control mode (in which the "mov" and other instructions can be used),
execute the "stop" instruction. To switch from one "sync" instruction to another, execute the
"sync" instruction again without executing the "stop" instruction. When you switch from sync s
to sync 1/sync 2, the position error automatically clears upon instruction execution.

Speed bias or speed command
(analog input AI1)
Input to PLSP-PLSN/SIGPSIGN (in a signal form
specified by FA-11)
Synchronization
position pulse

sync 2 , s

sync 1

0

+

Position
control

-

sync 1, 2
sync s

+
Speed
control

-

Position detection

0
[Example of applying synchronous driving]

+

Speed
detection

Highly accurate synchronous driving
Master axis servo driver(speed control)
can using speed controlled master
Master axis servo Motor servo driver and position controlled
servo driver. Master is controlled
AI1
Line speed
M
speed control by analog input with
Speed control
setting
"sync s" instruction. And slave is
controlled position control by 90deg
phase difference pulse train input
EC
with "sync2" instruction.
AI1
Slave axis servo Motor The driver has a variable that adjust
PLSP,N
synchronous point both driver. (It is
+
SIGP,N
PBIAS variable.)
M
Speed control
Position control
Pulse train input.
90deg phase
difference signal.

+

EC
Slave axis servo driver(position control)
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Format (1): sync 1 (synchronization control without an analog bias)
Use the "sync 1" format when operating the servomotor with a pulse train as is the case
with the standard model or when simply synchronizing the servomotor with another. This
format provides simple synchronization with a pulse train. It also allows you to correct the
synchronization position with a position bias (PBIAS) added. Positive/negative position
corrections can be made by writing a numerical value into the PBIAS variable. PBIAS adds
a setting (1 [dig] = 1 [pls]) at 140 [µs] intervals.
Format (2): sync 2 (synchronization control with an analog bias)
Use the "sync 2" format when rapidly synchronizing the servomotor with another. In
addition to synchronization provided by "sync 1", the "sync 2" format adds a speed bias in
accordance with analog input 1 (AI1) to correct a position delay. Although this format
makes it necessary to add a pulse train's frequency in analog form, it achieves
synchronization rapidly. It can also correct the synchronization position by adding a
position bias (PBIAS). Positive/negative position corrections can be made by writing a
numerical value into the PBIAS variable. PBIAS adds a setting (1 [dig] = 1 [pls]) at 140 [µs]
intervals.
Format (3): sync s (speed-controlled operation with an analog input)
The "sync s" format provides a speed-controlled operation in compliance with a speed
command from analog input 1. In this instance, no acceleration/deceleration time is
provided so that the resulting operation is the same as the standard speed-controlled
operation. Note, however, that analog acquisition is conducted at 1.12 [ms] intervals.
Therefore, the response cannot be made at shorter intervals even if the response speed is
raised.
NOTE: Synchronization may not rapidly be achieved if a low gain is selected for position/speed
control.

• Usage example
Example 1) Synchronization without a speed bias
<Data Window>
<Code Window>
ACC(0)=50 : DEC(0)=50
entry
N(00)=5000
sync 1
P(00)=10000
……
stop
end
Example 2) Synchronization without specifying the position
<Data Window>
<Code Window>
ACC(0)=50 : DEC(0)=50
entry
N(00)=5000
sync 2
P(00)=10000
……
stop
end
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tchg statement

Torque command change

• Format
Format
tchg P(i) T(k) [N(l) N(m)]

Operation overview
Exercises torque control to change the torque command
at a preselected position. The speed limiter values are to
be set in the [N(l) N(m)] position.

• Description
While "speed" or "trq" is being executed after the "tchg" instruction, torque control is exercised
to issue the instruction for a torque command change. Torque control will be exercised from the
P(i) position with the torque command changed to T(k) and the speed limit values specified N(l)
and N(m). The "tchg" instruction affects only one instruction ("speed" or "trq") after "tchg"
instruction execution. To change the torque control two or more times, execute "tchg" the same
number of times before "speed"/"trq". The execution of the "tchg" instruction is completed in
one cycle so that the next line begins to be processed in the next cycle. To abort a torque
control operation and revert to the normal state (in which the "mov" and other motion
instructions can be executed), execute the "stop" instruction to abort the torque control
operation.
P(i):
T(k):
N(l):

N(m):

Specify the torque control change position on the presumption that 1 dig = 1/32768
revolution. The position setting is relative to the home position (second home).
Specify the torque command value that is to prevail after a torque control change.
Note that 1 dig = 1% torque.
Specify the speed limit value for forward rotation on the presumption that 1 dig = 1
-1
min . Make this entry with a positive sign. The speed prevailing after a torque
control change will be determined by the balance with the load. Therefore, you must
specify the speed limit value for forward rotation to prevent the servomotor from
going out of control.
Specify the speed limit value for reverse rotation on the presumption that 1 dig = 1
-1
min . Make this entry with a negative sign. The speed prevailing after a torque
control change will be determined by the balance with the load. Therefore, you must
specify the speed limit value for reverse rotation to prevent the servomotor from
going out of control.

NOTE 1: If the speed limiter value is set to 0, the execution error (E45) occurs.
NOTE 2: The speed limiter inhibits the servomotor from going out of control in accordance with
the balance between the load and servomotor torque. Since the limit value does not
work as a speed command, the servomotor speed slightly differs from the limit value
depending on the load balance. This speed limit is adjustable by varying the P-control
gain (Fd-04), which provides speed control. Increasing the P-control gain (Fd-04)
decreases the deviation from the speed limit value. However, an excessive P-control
gain would cause hunting.
NOTE 3: The N(l) and N(m) speed limit values can be omitted for the second and subsequent
"tchg" instruction executions. However, if they are omitted for the first "tchg"
instruction execution, the execution error (E45) occurs.
NOTE4: The N(l) and N(m) speed limit values becomes absolute values internally.
NOTE5: Set speed limit values more than speed value of "speed" instruction.
If occur hunting, set speed limit values again after stopping motor.
Still, when it is occurred, lower the value of speed P gain (Fd-04).
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• Usage example
<Data Window>
P(00)=10000
P(01)=3000
P(02)=P(01)+3000
T(00)=10
ACC(0)=50
<Code Window>
entry
ort 3
nchg
tchg
speed
wait 10
stop
end

: N(00)=50
: N(01)=30
: N(02)=20
: DEC(0)=50

N(02) N(02) ACC(0) DEC(0)
P(01) N(01)
P(02) T(00) N(02) N(02)
N(00) ACC(0) DEC(0)

Speed
P(1)

50[min-1]

P(2)

30[min-1]

Torque control
10% torque

3000 pls
3000 pls

0.5s

-20[min-1]

10s

SON

ORL
Instruction
executed

Torque control

Speed N(0)

ort
nchg

tchg
wait
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trq statement

Torque control

• Format
Format
trq T(j) [N(k) N(l)]

Operation overview
Controls the torque in accordance with T(j).

• Description
Execute the "trq" instruction when performing an operation while controlling the torque. This
instruction exercises torque control with a torque command specified by T(k) and the speed limit
values specified by N(l) and N(m). If the torque command is changed during a torque-controlled
operation, execute the "trq" instruction again. To change the torque command at a specific
position, use "tchg". For details, see the page on "tchg". The execution of the "trq" instruction is
completed in one cycle so that the next line begins to be processed in the next cycle; however,
a torque-controlled operation continues. To abort a torque-controlled operation and revert to
the normal state (in which the "mov" and other motion instructions can be executed), execute
the "stop" instruction to abort the torque-controlled operation.
T(k):
N(l):

N(m):

Specify the torque command value for torque control on the presumption that 1 dig =
1% torque.
Specify the speed limit value for forward rotation on the presumption that 1 dig = 1
-1
min . Make this entry with a positive sign. The speed prevailing during a torquecontrolled operation will be determined by the balance with the load. Therefore, you
must specify the speed limit value for forward rotation to prevent the servomotor from
going out of control.
Specify the speed limit value for reverse rotation on the presumption that 1 dig = 1
-1
min . Make this entry with a negative sign. The speed prevailing during a torquecontrolled operation will be determined by the balance with the load. Therefore, you
must specify the speed limit value for reverse rotation to prevent the servomotor from
going out of control.

NOTE 1: If the speed limiter value is set to 0, the execution error (E45) occurs.
NOTE 2: The speed limiter inhibits the servomotor from going out of control in accordance with
the balance between the load and servomotor torque. Since the limit value does not
work as a speed command, the servomotor speed slightly differs from the limit value
depending on the load balance. This speed limit is adjustable by varying the P-control
gain (Fd-04), which provides speed control. Increasing the P-control gain (Fd-04)
decreases the deviation from the speed limit value. However, an excessive P-control
gain would cause hunting.
NOTE 3: The N(l) and N(m) speed limit values can be omitted for the second and subsequent
"trq" instruction executions. However, if they are omitted for the first "trq" instruction
execution, the execution error (E45) occurs.
NOTE4: The N(l) and N(m) speed limit values becomes absolute values internally.
NOTE5: Set speed limit values more than speed value of "speed" instruction.
If occur hunting, set speed limit values again after stopping motor.
Still, when it is occurred, lower the value of speed P gain (Fd-04).
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• Usage example
<Data Window>
P(00)=1000
ACC(0)=50
DEC(0)=50
T(00)=10

10% torque command

<Code Window>
entry
mov P(00) N(00) ACC(0) DEC(0)
trq T(00) N(00) N(00)
wait 1
stop
end
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6.6

Input/Output Instructions

X()/Xw variable

Contact input variable access

• Format
Format
<variable> = X(i)
(i=0 to 11)
(2) <variable> = Xw
(1)

Operation overview
<variable> ← X(i)
<variable> ← Xw

• Description
This variable enables you to monitor the states of contact input terminals X(00) to X(11). It is for
read only and cannot be written into. The available formats are detailed below:
Format (1): Causes the <variable> to acquire the contact input information about each bit.
(0=OFF, 1=ON)
Example) When X(00) is OFF: X(00)=0
When X(01) is OFF: X(01)=1
Format (2): Causes the <variable> to acquire the contact input information as word data. The
bit information X(0) is the least significant bit data.
Example) When X(00) to X(03) = ON and X(04) to X(11) = OFF: Xw=7
When X(00) to X(02) = OFF and X(03) to X(11) = ON: Xw=4088
NOTE 1: The input terminal polarity cannot be changed by varying the input terminal polarity
setting (FC-01). To effect such a polarity change, use a user program.
NOTE 2: Since this variable internally performs an input terminal read two times (two execution
cycles), the read operation is delayed by at least two cycles. If there is a problem with
such a delay, create a user program in consideration of the resulting delay time.
NOTE 3: The read values may be erroneously entered due, for instance, to wiring or switch
chattering. To avoid such a problem, create a user program that checks the read
values before starting an operation.
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• Usage example
Example 1: Terminal judgment with X(01)terminal
<Code Window>
entry
U(00)=X(01)
ifs U(00)=1
then
Yw=4095
else
Yw=0
end if

X(01)terminal data acquisition
Branching with ‘if

<Description>
X(01) terminal is output to Y() terminal as the table shown below.
X(01) terminal state

All terminal Y() terminal

OFF

OFF

ON

ON

Example 2: Utilize X(07) to X(03) only with Xw.
<Code Window>
entry
MAIN: U(00)=Xw
U(00)=U(00) /16
U(00)=U(00) and 15
Yw=U(00)
goto MAIN
end

X()terminal data acquisition
X(11) to X(03) → b7 to b0
Masks ‘X(11) to X(8)
Outputs ‘processed data to Y() terminal

<Description>
Terminals from X(07) to X(93) are echo-output to terminals from Y(03) to Y(00).
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Y()/Yw variable

Contact output variable access

• Format
Format
Y(i) = <variable>
(i=0 to 7)
(2) Yw = <variable>
(1)

Operation overview
Y(i) ← <variable>
Yw ← <variable>

• Description
This variable enables you to control contact output terminals Y(00) to Y(07) with a user program.
The available formats are detailed below:
Format (1): Delivers an ON/OFF output to the contact output on an individual bit basis (0 = OFF,
1 = ON).
Example) When Y(00) is OFF:
When Y(01) is ON:
Format (2): Delivers ON/OFF word data to the contact output. The bit information Y(0) is the
least significant bit data.
Example) When Y(00) = ON and Y(01) to Y(07) = OFF: Yw = 1.
When Y(00) to Y(06) = OFF and Y(07) = ON: Yw = U(00).
However, U(00) must be set to 128.
NOTE 1: The output terminal polarity cannot be changed by varying the output terminal polarity
setting (FC-02). To effect such a polarity change, use a user program.
NOTE 2: Bits cannot selectively be masked. For selective bit masking, create and use a user
program shown in the usage example below.

• Usage example
Example 1: usage example of Yw and Y()
<Code Window>
entry
Yw=0
MAIN: Y(00)=1
mov P(00) N(00) ACC(0) DEC(0)
Y(00)=0
mov P(01) N(00) ACC(0) DEC(0)
Yw=2
mov P(02) N(00) ACC(0) DEC(0)
Yw=3
hp N(00) N(00) ACC(0) DEC(0)
goto MAIN
end
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<Data Window>
P(00)=32768*10 [pulse] ,P(01)=32768*20[pulse]
P(02)=32768*30 [pulse] ,P(03)=32768*30[pulse]
-1
N(00)=1000[min ]
,ACC(0)=0.1[s]
,DEC(0)=0.1[s]
<Description>
This statement describes orderly as follows. The following number from (1) to (5)
corresponds with the comment numbers of the above program.
(1) Turns all terminals OFF.
(2) Turns Y(00) terminal ON and starts a positioning operation.
(3) Turns Y(00) terminal OFF and starts the next positioning operation.
(4) Turns Y(01) terminal ON, other terminals OFF and starts the next positioning operation.
(5) Turns Y(01), Y(00) terminals ON, other terminals OFF and starts to move home position.

Example 2: Mask Y(06) terminal only
<Code Window>
entry
Yw=0
U(04)= not U(05)
for U(02)=0 to U(07)
U(03)=Yw
U(03)=U(03) and U(05)
U(02)=U(02) and U(04)
U(02)=U(02) or U(03)
Yw=U(02)
wait 1.0
U(06)=Y(06)
U(06)= not U(06)
Y(06)=U(06)
next
end
<Data Window >
U(07)=256,

All output bit is 0
not &H40=4031
Acquires ‘Y() terminal data
(1) Acquires only b6 of Y() terminal (All is 0 clear other than b6)
(2) Clears only b6 of original data before masking.
(3) Merges original data before masking and Y() terminal data

Reverses ‘Y(06)

U(05)=64

<Description>
This statement performs code-output to Y() terminal at for loop. Y(06) terminal performs
reverse-output every time with another control. Mask part procedure is from (1) to (3) of
the above program and describes orderly.
(1) To perform 0 clear all except b6 of Y() terminal,
6
(2) Operate AND by 2 =64 to perform 0 clear only b6 of original data before masking.
(3) Operate OR to merge data operated at above (1) and (2)
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XA() Variables

Analog input monitor variable

• Format
Format
<Variable> = XA(i)
(I=0 to 1)

Operation overview
<Variable> ← XA(i)

• Description
This statement monitors the state of the analog input terminal AI1 and AI2. It is read-only
statement so that write is impossible. The relation between subscript i and analog input terminal
is described below. Both terminals are quantized for 10V=100%=10000dig. On the other hand,
the relation of input voltage can be changed if you set gain or offset of FC-05 to FC08. For
details, see a Servo Drive instruction manual.
XA(0): Monitors AI1’s voltage input value
Quantization 10V= 100%= 10000dig
-10V=-100%=-10000dig
XA(1): Monitors AI2’s voltage input value 10V=100=10000dig
Both XA(0) and XA(1) are the same quantization

• Usage example
Speed instruction of the positioning operation from ZA(00) Input a speed instruction from
XA(01) when controlling speed.
<Code Window>
entry
MAIN: U(00)=XA(0)
U(00)=U(00)*N(00)
N(01)=U(00)/U(02)
if N(01)<>0 then RUN

(1) Acquires the data from AI1
(2) Speed operation
(3) Adjusts the quantization for 100%=10000dig
(4) Under-limiter for occurrence of execution
error (E45) when positioning in N(01)=0
(5)

N(01)=1
RUN: hp N(01) ACC(0) DEC(0)
mov P(00) N(01) ACC(0) DEC(0)
U(00)=XA(1)
(6) Acquires the data from AI12
U(00)=U(00)*N(00)
(7) Speed operation
N(01)=U(00)/U(02)
(8) Adjusts the quantization for 100%=10000dig
speed N(01) ACC(0) DEC(0)
wait 5.0
stop
goto MAIN
end
<Data Window>
N(00)=3000
U(02)=10000
P(00)=327680[pls]

100% speed instruction
100%=10000dig
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<Description>
This statement describes orderly as follows. The following number from (1) to (5)
corresponds with the comment numbers of the above program.
(1) Acquires the analog data from AI1.
(2)(3) Operates a speed instruction.
-1
Operates 3000min as 100% because analog data is 10V=100%=10000dig.
(4)(5) In positioning instruction, execution error (E45) occurs when making the speed
-1
instruction 0. Therefore setting 1min as under limit.
(6) to (8) Acquires data from AI2 and Operates as is the case with (2) and (3).
However, no problem occur even if making 0 entry in the speed instruction so that
under-limit operation is not necessary.
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chg instruction

Special terminal allocation change

• Format
chg FOT
ROT
chg SRD
ALM
INP
SA
SZD
BRK
TLM
OL1
chg ORL
ORG

Format
= X(i)
non
= Y(i)
non

= X(i)
default

Operation overview
X(i): Allocation change of the terminal
non: Invalids the terminal allocation
Y(i): Allocation change of the terminal
non: Invalids the terminal allocation

X(i): Allocation change of the terminal
non: Sets the terminal allocation to the initial value

• Description
Declares chg instruction when the input terminals FOT, ROT, ORG, ORL and all the output
terminals such as SDR installed in the standard Servo drive are used at program operation.
Allocation change turns valid from the point of instruction execution. When executing allocation
change, the function of each terminal operates even though making Servo OFF. The function of
the allocated terminal continues until changing allocation by a program or turning power off. For
details of the function of each terminal, see a Servo Drive instruction manual.
non:
Specifies when invalidating an input/output terminal.
default: Return allocation of ORL and ORG terminal to the initial value.
X(i):
Specifies input terminal to be changed allocation
Y(i):
Specifies output terminal to be changed allocation
Note 1: The table below shows the operation and allocation terminal at the chg instruction
execution in homing instruction.
Terminal name
ORG terminal
ORL terminal

chg instruction execution time
Allocation specifications terminal (Starts
homing operation after allocation terminal
is ON in homing instruction execution.)
Allocation specifications terminal

Not 2:
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Non-execution time
No allocation (Starts homing
operation in homing
instruction execution.)
X(08) terminal (initial value)

Chapter 6 Instruction Word Reference

Note 3: Allocate of polarity of specific function terminal and Allocate of specific function at
power supply are different in instruction LEVEL. Refer to below table.
Item
LEVEL 2 servo driver
not LEVEL 2 servo
driver
Polarity of specific input
Possible to change
Impossible to change.
terminals
.(Parameter FC-01)
Polarity of specific output
Possible to change.
Possible to change.
terminals
(Parameter FC-02)
(Parameter FC-02)
Allocate specific input/output
Possible to set.*Note4
Impossible to set.
terminal just after power supply. (Parameter FC-41 and FC-46)
*Note5

Note 4: In the case of use ARD and ALM terminals when just after power supply and
doing an interlock of the high-order system, Set Input / output terminal priority function
(FC-41 and FC-46).

Note 5: SDR and ALM terminals turn valid after Servo is ON and a program is executed. SRD
and ALM terminals are not provided until power is on and then Servo is ON. Therefore
the system does not start if an interlock of the high-order system is removed in this
signal. Remove the interlock after putting power ON and Servo ON.
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• Usage example
Example 1: No specify ORG terminal
<Code Window>
entry
ORL input is allocated to X(8) in ‘reset time.
chg ORL=X(00)
Allocation change of ORL terminal is made at X(0)
ort 4 N(01) N(02) ACC(0) DEC(0) High speed homing 2 is executed without waiting
for ‘ORG terminal ON.
end
<Data Window>
-1
-1
N(01)=1000[min ] , N(01)=10[min ]
ACC(0)=0.1[s]
, DEC(0)=0.1[s]
<Description>
Allocation change of ORL terminal is made at X(00). Ort instruction starts immediately
homing operation for not declaring ORG terminal.

Example 2: Specified ORG terminals
<Code Window>
entry
chg ORL=X(00)
chg ORG=X(01)
ort 4 N(01) N(02) ACC(0) DEC(0)

ORL input is allocated to X(8) in ‘reset time.
Allocation change of ORL terminal is made at X(00)
Allocation change of ORG terminal is made at X(01)
High speed homing 2 is executed with waiting for
‘ORG terminal ON.

end
<Data Window>
-1
-1
N(01)=1000[min ] , N(01)=10[min ]
ACC(0)=0.1[s]
, DEC(0)=0.1[s]
<Description>
Allocation change of ORL terminal is made at X(00). For declaring ORG terminal, Ort
instruction does not start immediately homing operation and does not make homing if ORG
terminal=X(01) does not turn ON.
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6.8

Other Reserved Variables
Numerical
value range

Variable name
ACC(0) to
ACC(1)

Initial value

Unit

Size

Attribute

0.01*Note
s/dig

unsigned
1w

Read
Write

0 *Note

Setup memory
variable of
acceleration time

0 to 9999

(0.00)
(Set by Data
Window)

0.00 to 99.99

Note: The UNIT is 1dig = 0.01s on <Code window> and 1dig = 1s on <Data Widow>.

• Description
This statement sets acceleration time at the time of motion control operation. Setup is
0.01=1dig, which sets acceleration time up to top speed. The time of Acceleration replaces from
between 0 speed and command speed (Nj) with between 0 speed and Maximum speed (Nmax).
The time from Data Window or program code can define the value of starting program. Also,
when acceleration/declaration time is not specified at motion instruction, it accelerates at the
time specified immediately before.

Top speed Nmax
Setup speed

ACC(0)

Acceleration
time

N(00)

Ta
ACC(k)=Nmax / N(j) × Ta

Note 1: When the time is specified by motion instruction at the setting beyond the numerical
value range, it operates the same operation as the setting of the maximum setting time
99.99s.
Note 2: Execution error (E45) occurs when acceleration/declaration time is not specified at the
time of motion instruction after starting program.

• Usage example
<Code Window>
entry
ACC(0)=100
U(00)=ACC(0)/10
ACC(1)=U(00)
ort 2 N(00) N(01) ACC(0) DEC(0)
speed N(00) ACC(0) DEC(0)
wait 1.0
stop
mov P(00) N(00) ACC(1) DEC(0)
end

‘100 dig=1s
‘100/10dig=0.1s
‘Homing
Accelerate by ‘1s

Accelerate by ‘0.1s

<Date Window>
-1
-1
P(00)=0[pls], N(00)=3000[min ], N(01)=10[min ], DEC(0)=0.1[s]
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Variable name
ACCEL

Setup variable of
acceleration time
(Fb-04)

Numerical
value range

Initial value

Unit

Size

Attribute

0 to 9999

Fb-04

0.01
s/dig

unsigned
1w

Read
Write

• Description
This statement can read and write acceleration time specified at the speed acceleration time
(Fb-04). The contents of data are identical to ACC() variables. For details, see ACC() variables.
When Fb-04 is set to1.00s, 100 returns if acceleration time is readout.
Note 1: Execution error (E45) occurs if you write the value beyond the numerical value range.

• Usage example
<Code Window>
entry
ACC(0)=ACCEL
mov
P(00) N(00) ACC(0) DEC(0)
end
<Data Window>
-1
P(00)=0[pls], N(00)=3000[min ], DEC(0)=0.1[s]
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Variable name

Numerical
value range

Initial value

Unit

Display character

0 to 255

0

-

CHR1 to
CHR5

Size

Attribute

unsigned

Read

1W

Write

• Description
Display characters on d-17 at digital operator. CHR1 to CHR5 corresponds to each digit of
7segLED on digital operator shown below.

CHR4
CHR5

CHR2
CHR3

CHR1

Note1: When CHR1to CHR5 are wrote into the data without below table data, 7segLED display
abnormally.
Note2: The effective data is wrote data at last.
<LED display code>
Char
ASCII
7segLED

32

0
48

1
49

2
50

3
51

4
52

5
53

6
54

7
55

8
56

9
57

Char
ASCII
7segLED

A
65

b
66

C
67

d
68

E
69

F
70

G
71

H
72

i
73

J
74

L
76

文字
ASCII
7segLED

o
79

P
80

q
81

r
82

S
83

t
84

U
85

v
86

Y
89

45

_
95
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•

Usage example
<Code Window>
entry
DATR=0
wait
1.0
DATR=6
DISP=12345
wait
1.0
CHR5=67
wait
1.0
CHR4=72
wait
1.0
CHR3=82
wait
1.0
CHR2=32
wait
1.0
CHR1=49
end

Monitor d-17
Turn off
;Display "12345"
;Display "C"
;Display "H"
;Display "r"
;Display SPACE
‘Display "1"
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Variable name

Numerical
value range

Initial value

Attribute 7segLED
display

0 to 12

0

Unit

DATR

Size

Attribute

unsigned

Read

1byte

Wrirte

• Description
Set attribute of 7segLED on digital operator. The attributes are small number of point positions
and blinking or not.
below table is example of d-17's display at DISP=99999.
DATAR
data
0
1
2
3
4
5
6
7
8
9
10
11
12

Description
Turn off all
It is a decimal point in the first digit. Turn on.
It is a decimal point in the second digit. Turn on.
It is a decimal point in the third digit. Turn on.
It is a decimal point in the forth digit. Turn on.
It is a decimal point in the fifth digit. Turn on.
Decimal point in not the exist. Turn on.
It is a decimal point in the first digit. Blinking.
It is a decimal point in the second digit. Blinking.
It is a decimal point in the third digit. Blinking.
It is a decimal point in the forth digit. Blinking.
It is a decimal point in the fifth digit. Blinking.
Decimal point in not the exist. Blinking.

Display
"
"
"99999."
"9999.9"
"999.99"
"99.999"
"9.9999"
"99999"
"99999." All digit blinking.
"9999.9" All digit blinking.
"999.99" All digit blinking.
"99.999" All digit blinking.
"9.9999" All digit blinking.
"99999" All digit blinking.

Note 1: Execution error (E45) occurs if you write the value beyond the numerical value range.
Note 2: The effective data is wrote data at last.

• Usage example
<Code Wiondow>
entry
DATR=0
wait 1.0
DATR=6
DISP=1
wait
1.0
DATR=1
wait
1.0
DATR=2
wait
1.0
DISP=99999
wait
1.0
DATR=8
end

Turn off

Blinking
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Numerical
value range

Variable name
DEC(0) to
DEC(1)

Initial value

Unit

Size

Attribute

0.01*Note
s/dig

unsigned
1w

Read
Write

0 *Note

Setup memory
variable of
deceleration time

0 to 9999
0.00 to 99.99

(0.00)
(Set by Data
Window)

Note: The UNIT is 1dig = 0.01s on <Code window> and 1dig = 1s on <Data Widow>.

• Description
This statement sets deceleration time at the time of motion control operation. Setup is
0.01=1dig, which sets acceleration time up to top speed. The time of deceleration replaces from
between speed N(j) and 0 speed with between Maximum speed (Nmax) and 0 speed. The time
from Data Window or program code can define the value of starting program. Also, when
acceleration/declaration time is not specified at motion instruction, it decelerates at the time
specified immediately before.

Top speed Nmax
Setup speed
N(j)
DCC(m)=Td × Nmax / N(j)

Td
DEC(m)

Deceleration time

Note 1: When the time is specified by motion instruction at the setting beyond the numerical
value range, it operates the same operation as the setting of the maximum setting time
99.99s.
Note 2: Execution error (E45) occurs when acceleration/declaration time is not specified at the
time of motion instruction after starting program.

• Usage example
<Code Window>
entry
DEC(0)=100
U(00)=DEC(0)/10
DEC(1)=U(00)
ort 2 N(00) N(01) ACC(0) DEC(0)
speed N(00) ACC(0) DEC(0)
wait 1.0
stop
mov P(00) N(00) ACC(0) DEC(1)
end

‘100 dig=1s
‘100/10dig=0.1s
‘Homing
'Decelerate by ‘1s

'Decelerate by ‘0.1s

<Date Window>
-1
-1
P(00)=0[pls], N(00)=3000[min ], N(01)=10[min ], ACC(0)=0.1[s]
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Variable name
DECEL

Setup variable of
acceleration time
(Fb-05)

Numerical value
range

Initial value

Unit

Size

Attribute

0 to 9999

Fb-05

0.01
s/dig

unsigned

Read
Write

1W

• Description
This statement can read and write acceleration time specified at the speed acceleration time
(Fb-05). The contents of data are identical to DEC() variables. For details, see CDEC()
variables. When Fb-05 is set to1.00s, 100 returns if acceleration time is readout.
Note 1: Execution error (E45) occurs if you write the value beyond the numerical value range.

• Usage example
<Code Window>
entry
DEC(0)=DECEL
mov
P(00) N(00) ACC(0) DEC(0)
end
<Data Window>
-1
P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s]
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Variable name

Numerical
value range

Initial value

Unit

7segLED display
data

-9999 to 99999

0

-

DISP

Size

Attribute

signed

Read

1w

Write

• Description
Setting the value that is displayed d-17 on digital operator. The DISP value only displayed on
digit that CHR1 to CHR5 is set to 0. At CHR1 to CHR5 is not set to 0, its digit displayed
according to it. And decimal point and blinking are according to DATR.
Note 1: Execution error (E45) occurs if you write the value beyond the numerical value range.
Note 2: The effective data is wrote data at last.

• Usage example
<Code Window>

entry
DATR=0
wait
1.0
DATR=6
DISP=12310
wait
1.0
CHR3=45
wait
1.0
DISP=10620
wait
1.0
DISP=10730
wait
1.0
DISP=20810
wait
1.0
DISP=30920
end

Turn off
‘Display "12345"
‘Display "-"
‘Display "10-20"
‘Display "10-30"
‘Display "20-10"
'Display ‘30-20"
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Variable name
LEVEL 2
EGRAN

Numerical
value range

Initial value

1 to 65535

Numerator of
electric gear

-32768 to 32768

(FA-12)

*Note3

1
(FA-12)

Unit

Size
unsigned 1w

-

signed 1w
*Note3

Attribute
Read
Write

• Description
EGRAN variable is numerator of electric gear at executing "sync" instruction. Initial data of
EGRAN at just after power supply is FA-12. EGRAN can be changed by program, but at that
time FA-12 is not changed. At next power restore, EGRAN is initialized by FA-12.
Initial EGRAN value is according to FA-12 at program mode (FA-22 is Pro). (But, at non
program mode (FA-22 is not Pro), Numerator of electric gear is changed FA-12 to FA-32 by
EGR2 terminal.)
Note 1: Execution error (E45) occurs if you write the value beyond the numerical value range.
Note 2: When you want to keep the compatibility of user program, don't change EGRAN, FA-12
and FA-13 from initial value 1.
Note 3: At using electric cam function, the value range is changed signed 1word
(-32768 to 32767).
Note 4: Take care that the Z terminal serial output is result of calculation of EGRAN and EGRAD
when FC-12(Phase Z output selection) = "Ecount",

Variable name
LEVEL 2
EGRAD

Denominator of
electric gear
(FA-12)

Numerical
value range
1 to 65535

Initial value
1
(FA-13)

Unit

-

Size

Attribute

unsigned

Read

1w

Write

• Description
EGRAD variable is denominator of electric gear at executing "sync" instruction. Initial data of
EGRAD at just after power supply is FA-13. EGRAD can be changed by program, but at that
time FA-12 is not changed. At next power restore, EGRAD is initialized by FA-13.
Initial EGRAN value is according to FA-13 at program mode (FA-22 is Pro). (But, at non
program mode (FA-22 is not Pro), Numerator of electric gear is changed FA-13 to FA-33 by
EGR2 terminal.)
Note 1: Execution error (E45) occurs if you write the value beyond the numerical value range.
Note 2: When you want to keep the compatibility of user program, don't change EGRAD, FA-13
and FA-33 from initial value 1.
Note 3: Take care that the Z terminal serial output is result of calculation of EGRAN and EGRAD
when FC-12(Phase Z output selection) = "Ecount",
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•

Usage example
Example of winding up side of winding up machine
<Code Window>
entry
TWAIT:
wait X(11)=1
EGRAN=1
EGRAD=1
if TBF < U(00) then TWAIT
U(1) = POS
sync 1
RUNSYNC: U(02) = POS - U(01)
U(02) = U(02) * U(14)
U(02) = U(02) / U(15)
EGRAD =U(02)
if X(11)=1 then RUNSYNC
goto TWAIT
end

;Wait start
;initial EGRAN
;initial EGRAD
;Wait tension evolution
;Get position of tension evolution
;Start synchronous control
;mount of rolling
;U(14) numerator of winding ratio
;U(15) denominator of winding ratio

<discription>
The program waited to be generated of the tension after X(11) is to be 1.When detect the
tension generation, the program into synchronous control, calculates amount of winding up from
the distance between the position just after tension generated and the position that has
synchronized and enlarge the denominator of an electronic gear. Therefore, electric gear ratio is
changed and the rolling overweight can control synchronizing.
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ERR(0) to
ERR(3)

Variable name
Trip factor code (d11, d-12)

Numerical
value range

Initial value

Unit

Size

Attribute

0 to 99

Depends on
the past trip

−

−

Read

• Description
This statement can read the past trip factor code, whose numerical value displays ** of E as
error in this digital operation unit. For the relation between the contents of error factor and the
factor code, see “Section 9 Error Occurrence Action” described in this servo drive Instruction
Manual. The following contents are ERR() subscript.
ERR(0): Latest trip factor code (d-11 means a display of E**-1)
ERR(1): Trip factor code before one (The first of d-12 means a display of E**-2)
ERR(2): Trip factor code before two (The second of d-12 means a display of E**-3)
ERR(3): Trip factor code before three (The third of d-12 means a display of E**-4)

• Usage example
<Code Window>
entry
Yw=0
if ERR(0)=U(00) then MATCH
if ERR(1)=U(00) then MATCH
if ERR(2)=U(00) then MATCH
if ERR(3)=U(00) then MATCH
Y(0)=0
goto SKIP
MATCH: Y(0)=1
SKIP:
Y(1)=1
end

‘E01=When over-current is generating Y(0)=1
‘E01=When over-current is generating Y(0)=1
‘E01=When over-current is generating Y(0)=1
‘E01=When over-current is generating Y(0)=1
‘E01=When over-current is not generating Y(0)=0

<Data Window>
U(00)=1

LEVEL 2
EXD

Variable name
External encoder
ratio

‘1=E01 The over-current is flowing

Numerical
value range

Initial value

Unit

0,1,2,8,16

0

-

Size

Attribute

unsigned

Read

1w

Write

• Description
-EXD

Multiply external encoder input pulse by 2
is to be electric cam position.
Detail of electric cam function, refer to chapter 6.
Note 1: Defined EXD variable before execute "cam s" instruction.
Note 2: Execution error (E45) occurs if you write the value beyond the numerical value range.
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Numerical
value range

Variable name
HPOS
Home position

-2

31

Initial value

Unit

0

2
rev/dig

-15

31

to 2 -1

Size

Attribute

2w with
sign

Read

• Description
The statement can read the second home position set with hpset instruction. 32768dig is one
rotation of the position data. The following diagram shows the relation between the second
home position and the first home position at power ON.

The second
home position
Home position

HPOS=
10000

POS=0

POS=
10000

POS=
20000

Position

mov P(00)
(P(00)=10000)
Before hpset
(Power ON)

mov P(00)
(P(00)=10000)
After hpset

hpset

• Usage example
<Code Window>
entry
mov
P(00) N(00) ACC(0) DEC(0)
hpset
mov
P(00) N(00) ACC(0) DEC(0)
P(01)=HPOS+P(00)
Calculate the position from the first home position at ‘P(01).
end
<Data Window>
-1
P(00)=10000[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]

6-96

Chapter 6 Instruction Word Reference

Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Current feedback
(d-02)

0 to 32768

0

1/50
%/dig

1w without
sign

Read

IFB

• Description
This statement can read the instantaneous value of motor current value (monitor d-02) in
operation, whose value is read value of 1%=50dig and without sign (absolute value).

• Usage example
<Code Window>
entry
speed N(00) ACC(0) DEC(0)
MAIN: ifs IFB > U(00)
then
Y(0)=1
When the current value is larger than U(00), Y(0) terminal is ON.
else
Y(0)=0
When the current value is less than U(00), Y(0) terminal is OFF.
end if
goto MAIN
end
<Data Window>
-1
U(00)=100*50[100%], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
INP
Positioning
completion

Numerical
value range

Initial value

Unit

Size

Attribute

0, 1

−

−

0, 1

Read

• Description
This statement can judge if positioning is completed. INP is read-only instruction and operates
0 and 1 as follows.
INP=0: During positioning or operation other than positioning control such as speed or trq.
INP=1: Positioning completion (when positioning deviation is entered within positioning
completion range (Fb-23)).
The above instruction is used to check if positioning is completed during parallel operation of
mov instruction.

• Usage example
<Code Window>
entry
MAIN:
mov P(00) N(00) ACC(0) DEC(0) ;&
Y(00)=0
U(00)=0
BLINK:
inc U(00)
if U(00)<100 then NOBLINK
U(00)=not Y(00)
Y(00)=U(00)
U(00)=0
NOBLINK: if INP=0 then BLINK
stop
Y(00)=0
hp N(01) ACC(0) DEC(0)
goto MAIN
end

Parallel execution

Blink time judgment
Blink processing

Check if positioning is completed

<Data Window>
-1
-1
P(00)=327800[pls], N(00)=100[min ], N(01)=3000[min ]
ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
IRF
Torque current
instruction (d-03)

Numerical
value range

Initial value

Unit

Size

Attribute

-32768 to
32767

0

1/50
%/dig

1w without
sign

Read

• Description
This statement can read the instantaneous value of motor current value (monitor d-02) in
operation. With read value of 1%=50dig and with sign, forward run is positive.

• Usage example
<Code Window>
entry
speed N(00) ACC(0) DEC(0)
MAIN: ifs IRF > U(00)
then
Y(0)=1
When torque current instruction is larger than U(00), Y(0) terminal is ON.
else
Y(0)=0
Shen torque current instruction is less than U(00), Y(0) terminal is OFF.
end if
goto MAIN
end
<Data Window>
-1
U(00)=100*50[100%], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
J
Inertia moment
(Fd-00)

Numerical
value range

Initial value

Unit

Inertia moment
ratio of motor
unit is 1 to 128
times

Fb-00 setting
value

0.01 kgm
-h
*
× 10 /dig

Size

Attribute

−

Read
Write

2

*Less than 200W if n=5 and larger than 400W if n=4

• Description
This statement can read and write inertia moment setting value (Fd-00). Adding value of
(inertial moment of motor unit) and (loading motor shaft conversion inertia moment) is set as
inertia moment. For setting of inertia moment, unit varies with the capacity as shown above.
You can set the range from inertia moment value of motor unit to that of 128 times. When you
write numerical value with substitute instruction, setting value becomes effective from that point
and is memorized in Fd-00. Therefore, the last written value will be effective from the time of
power ON next time.
When you change inertia moment in switching the load shaft with clutch and making alternation
inertia moment drastically, excellent servo characteristics can always be maintained. Its usage
example is as follows.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing J statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing J statement. If you rewrite J statement during motor
rotation, the machine may be damaged by the delay because of rewrite or switch shock,
and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
The applicable example in case of switching load shaft with clutch and changing inertia moment
drastically
<Code Window>
entry
MAIN: J=100
Y(00)=0
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(00) N(00) ACC(0) DEC(0)
J=300
Y(00)=1
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(01) N(00) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
P(00)=3276800[pls], P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
KFC
Speed response
frequency (Fd-01)

Numerical
value range

Initial value

Unit

Size

Attribute

1 to 5000

300

0.1 Hz/dig

−

Read
Write

• Description
This statement can read and write speed response frequency (Fd-01). 1dig=0.1Hz is set.
When you write numerical value with substitute instruction, setting value becomes effective from
that point and is memorized in Fd-01. Therefore, the last written value will be effective from the
time of power ON next time.
When you execute setup change in switching the load shaft with clutch and making alternation
machine stiffness drastically, excellent servo characteristics can always be maintained. Its
usage example is as follows.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing KFC statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing KFC statement. If you rewrite KFC statement during
motor rotation, the machine may be damaged by the delay because of rewrite or switch
shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
The applicable example in case of switching load shaft with clutch and changing machine
stiffness drastically
<Code Window>
entry
MAIN: J=100
KFC=300
Speed response 30Hz
Y(00)=0
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(00) N(00) ACC(0) DEC(0)
J=300
KFC=100
Speed response 10Hz
Y(00)=1
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(01) N(00) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
P(00)=3276800[pls], P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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KP

Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Position control
response frequency
(Fd-09)

1 to 9999

500

0.1 Hz/dig

−

Read
Write

• Description
This statement can read and write position control response frequency (Fd-09). 1dig=0.01Hz is
set. When you write numerical value with substitute instruction, setting value becomes effective
from that point and is memorized in Fd-09. Therefore, the last written value will be effective
from the time of power ON next time.
When you execute setup change in switching the load shaft with clutch and making alternation
machine stiffness drastically, excellent servo characteristics can always be maintained. Its
usage example is as follows.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing KP statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing KP statement. If you rewrite KP statement during
motor rotation, the machine may be damaged by the delay because of rewrite or switch
shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
The applicable example in case of switching load shaft with clutch and changing machine
stiffness drastically
<Code Window>
entry
MAIN: J=100
KFC=300
Speed response 30Hz
U(00)=KFC*10
KP=U(00)/6
Set the position control response to 1/6 of speed response
Y(00)=0
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(00) N(00) ACC(0) DEC(0)
J=300
KFC=100
Speed response 10Hz
U(00)=KFC*10
KP=U(00)/6
Set the position control response to 1/6 of speed response
Y(00)=1
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(01) N(00) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
P(00)=3276800[pls], P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Position control feed
forward gain (Fd-10)

0 to 100

0

0.01/dig

−

Read
Write

KPF

• Description
This statement can read and write position control feed forward gain (Fd-10). 1dig=0.01Hz is
set. When you write numerical value with substitute instruction, setting value becomes effective
from that point and is memorized in Fd-10. Therefore, the last written value will be effective
from the time of power ON next time.
When you execute setup change in switching the load shaft with clutch and making alternation
machine stiffness drastically, excellent servo characteristics can always be maintained. Its
usage example is as follows.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing KPF statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing KPF statement. If you rewrite KPF statement during
motor rotation, the machine may be damaged by the delay because of rewrite or switch
shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
The applicable example in case of switching load shaft with clutch and changing machine
stiffness drastically
<Code Window>
entry
MAIN: J=100
KFC=300
U(00)=KFC*10
KP=U(00)/6
KPF=90

Speed response 30Hz

Set the position control response to 1/6 of speed response
Fd-10=0.9 is set (Improve characteristic with feed forward
because of slow response)
Y(00)=0
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(00) N(00) ACC(0) DEC(0)
J=300
KFC=100
Speed response 10Hz
U(00)=KFC*10
KP=U(00)/6
Set the position control response to 1/6 of speed response
KPF=0
Fd-10=0.0 is set
Y(00)=1
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(01) N(00) ACC(0) DEC(0)
goto MAIN
end

<Data Window>
-1
P(00)=3276800[pls], P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Speed control
integral gain (Fd-03)

1 to 30000

10000

0.01 %/dig

−

Read
Write

KSI

• Description
This statement can read and write speed control integral gain (Fd-03). The setting value is set
by 1dig=0.01%, using the setting value at the time of setting up inertia moment and speed
response appropriately as 100%. When you write numerical value with substitute instruction,
setting value becomes effective from that point and is memorized in Fd-03. Therefore, the last
written value will be effective from the time of power ON next time.
When you execute setup change in switching the load shaft with clutch and making alternation
machine stiffness drastically, excellent servo characteristics can always be maintained. Its
usage example is as follows.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing KSI statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing KSI statement. If you rewrite KSI statement during
motor rotation, the machine may be damaged by the delay because of rewrite or switch
shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
The applicable example in case of switching load shaft with clutch and changing machine
stiffness drastically
<Code Window>
entry
MAIN: J=100
KSI=10000
Y(00)=0
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(00) N(00) ACC(0) DEC(0)
KSI=8000
Quantity is reduced
Y(00)=1
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(01) N(00) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
P(00)=3276800[pls], P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
KSP

Speed control
proportional gain
(Fd-02)

Numerical
value range

Initial value

Unit

Size

Attribute

1 to 30000

10000

0.01 %/dig

−

Read
Write

• Description
This statement can read and write speed control proportional gain (Fd-02). The setting value is
set by 1dig=0.01%, using the setting value at the time of setting up inertia moment and speed
response appropriately as 100%. When you write numerical value with substitute instruction,
setting value becomes effective from that point and is memorized in Fd-02. Therefore, the last
written value will be effective from the time of power ON next time.
When you execute setup change in switching the load shaft with clutch and making alternation
machine stiffness drastically, excellent servo characteristics can always be maintained. Its
usage example is as follows.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing KSP statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing KSP statement. If you rewrite KSP statement during
motor rotation, the machine may be damaged by the delay because of rewrite or switch
shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
The applicable example in case of switching load shaft with clutch and changing machine
stiffness drastically
<Code Window>
entry
MAIN: J=100
KSP=10000
Y(00)=0
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(00) N(00) ACC(0) DEC(0)
KSP=8000
A response is delayed
Y(00)=1
Clutch switching by Y(00) terminal
wait 0.15
Clutch switching time & wait for J to be effective (150ms)
mov P(01) N(00) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
P(00)=3276800[pls],P(00)=0[pls], N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
MODE
Control mode

Numerical
value range

Initial value

Unit

Size

Attribute

0 to 2

2

−

−

Read

• Description
This statement can read the control mode of the internal servo drive. The following value is
returned.
Mode 0: Torque control case (trq and tchg instructions time)
1: Speed control case (speed and nchg instructions time)
2: Position control case (execute instruction other than above)

• Usage example
You can check with the upward machine if you set the control mode as follows.
<Code Window>
entry
MAIN: wait X(11)=1
speed N(00) ACC(0) DEC(0)
Yw=MODE
wait X(11)=0
stop
mov P(00) N(00) ACC(0) DEC(0);&
Yw=MODE
wait INP=1
wait X(11)=1
trq T(00) N(01) N(02)
Yw=MODE
wait X(11)=0
stop
goto MAIN
end

Speed control

Position control

Torque control

<Data Window>
-1
P(00)=3276800[pls], P(00)=0[pls], N(00)=3000[min ], T(00)=5[%]
-1
-1
N(01)=100[min ], N(02)=100[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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Variable name
LEVEL 2
MODL

Modulo value of
electric cam

Numerical
value range

Initial value

Unit

1 to 3072

1

−

Size

Attribute

unsigned

Read
Write

1w

• Description
Define modulo value of electric cam function. In general, module value is the number of data
between "cdata" and "end "cdata" or less.
"cam s" instruction reading the value the top data of "cdata" table that defined "restore"
instruction. After reading the number of MODL, the reading data is from top of the "cdata" table
again. And at that time ( reading data is returned top of "cdata"), electric cam function datas are
all cleard.
Note 1: Defined MODL variable before execute "cam s" instruction.
Note 2: Execution error (E45) occurs if you write the value beyond the numerical value range.
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N(00) to N(15)
N(U(00)) to N(U(15))

Variable name

Numerical
value range

Initial
value

Unit

Speed command
variables

0 to ±max.
speed

0

min

-1

Size

Attribute

1w with
sign

Read
Write

• Description
This statement is used to specify speed command value of motion instruction such as mov or
-1
speed limit value. Specify variable of speed by 1dig=1min . The forward of direction specified
by forward setup FA-14 serves as positive, and the reverse serves as negative. The forward
serves as positive and the reverse serves as negative, however, depending on a motion
command, signs may be disregarded and it may operate. See respective motion instruction for
operation in that case.
N(i):
Specify the direct speed command variable. i should be from 0 to 15.
N(U(j)): Specify indirectly N() set forth the value of U(j). Specify N(11) when U(j) is 11.
Note 1: The range of numerical value to be able to write this variable can be specified up to 2w
with sign by program code. When speed command variable exceeding the max. speed
is set, and specified by motion instruction, limiter is operated at top speed.
Note 2: When N() is set to O by positioning instruction such as mov, the execution error (E45)
occurs. Initialize N() in advance, and specify it other than 0.

• Usage example 1
-1

Here is the example of increasing speed instruction by 1000min , and positioning it.
<Code Window>
entry
for U(00) 0 3 1
mov P(00) N(00) ACC(0) DEC(0)
P(00)=P(00)+U(00)
N(00)=N(00)+U(01)
‘Speed command addition
next
end
<Data Window>
-1
P(00)=327680[pls], U(00)=327680[pls], U(01)=1000[min ] ,
-1
N(00)=1000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]

• Usage example 2
Here is the example of specifying speed instruction indirectly, and positioning it.
<Code Window>
entry
for U(00) 0 2 1
mov P(00) N(U(00)) ACC(0) DEC(0)
hp N(U(00)) ACC(0) DEC(0)
next
end
<Data Window>
P(00)=327680[pls], , ACC(0)=0.1[s], DEC(0)=0.1[s]
-1
-1
-1
N(00)=1000[min ], N(01)=2000[min ], N(02)=3000[min ]
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Variable name
NFB
Current speed

Numerical
value range

Initial value

Unit

0 to ±32768

0

min

-1

Size

Attribute

1w with
sign

Read

• Description
-1

This statement can refer to the current speed. Unit of the speed is 1dig=1min . The forward of
direction specified by forward setup FA-14 serves as positive, and the reverse serves as
negative.

• Usage example
The false creation of the speed attainment signal can be carried out using NFB.
<Code Window>
entry
Y(00)=0
mov P(00) N(00) ACC(0) DEC(0);&
MAIN: ifs NFB>U(00)
then
Y(00)=1
else
Y(00)=0
end if
if INP=0 then MAIN
hp N(00) ACC(0) DEC(0)
end

Speed attainment
Speed unreaching
Positioning complete check

<Data Window>
-1
-1
P(00)=3276800[pls], U(00)=1000[min ], N(00)=3000[min ],
ACC(0)=1[s], DEC(0)=1[s]
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NLM
NLM(0),
NLM(1)

Variable name

Numerical
value range

Initial value

Unit

Speed limit variables
(Fb-21, Fb-22)

0 to ±32768

Max. speed

min

-1

Size

Attribute

1w with
sign

Read
Write

• Description
-1

This statement sets the speed limit value, and data with sign whose set unit is 1dig=1min .
NLM:
Batch setup the speed limit of forward and reverse direction (Write Fb-21 and Fb22)
NLM(0): Separate setup the speed limit of forward direction only (Write Fb-21)
NLM(1): Separate setup the speed limit of reverse direction only (Write Fb-22)
When NLM, NLM(0) and NLM(1) are written by the substitution instruction, the above
parameters are written. A speed limit starts rapidly at the next cycle after writing. Execute the
speed limit all at once regardless of accelerate/decelerate time if starting the speed limit during
operation by speed instruction. Writing NLM, NLM(0) and NLM(1) by the substitution instruction
makes them have the absolute value of setup value, and save them in parameter Fb-21 and Fb22 as NLM and NLM(1) are positive value, and NLM(1) is negative value. Therefore, the
different polarity from the specified sign may be read at substitution instruction.
Note 1: If you execute the speed limit during the motion instruction such as speed or mov,
speed limit starts rapidly so that trip may occurs because of speed error fault (84),
position error fault (E83) and overspeed error (E85) and the like.

• Usage example
The example which executes a speed limit is show below.
<Code Window>
entry
MAIN: U(00)=XA(0)
U(00)=U(00)*N(01)
N(00)=U(00)/10000
NLM=N(00)
speed N(01) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
-1
N(00)=3000[min ], N(01)=3000[min ], ACC(0)=0[s], DEC(0)=0[s]
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Variable name
NRF
Current speed
command

Numerical
value range

Initial value

Unit

0 to ±32768

0

min

-1

Size

Attribute

1w with
sign

Read

• Description
This statement can refer the speed command value entered in the speed control unit. Unit of
-1
the speed is 1dig=1min . The forward of direction specified by forward setup FA-14 serves as
positive, and the reverse serves as negative. The speed command, entered by the speed or
the mov instruction in the current speed control unit, can be read.

• Usage example
The following example shows creation of the release timing of brake by the speed command.
<Code Window>
entry
Y(00)=0
mov P(00) N(00) ACC(0) DEC(0);&
MAIN: ifs NRF>U(00)
then
Y(00)=1
else
Y(00)=0
end if
if INP=0 then MAIN
hp N(00) ACC(0) DEC(0)
end

‘

‘Releases a brake
‘Puts a brake on
‘Positioning complete check

<Data Window>
-1
-1
P(00)=3276800[pls], U(00)=1000[min ], N(00)=3000[min ],
ACC(0)=1[s], DEC(0)=1[s]
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Variable name
LEVEL 2
OP0 to OP4

Multipurpose
variable
OP0 to OP4

Numerical
value range

Initial
value

-9999

Fb-50

to

to

99999

Fb54

Unit

-

Size

Attribute

signed

Read
Write

2w

• Description
OP0 to OP4 initial data just after power supply is Fb-50 to Fb-54. As for OP0 to OP4 and Fb-50
to Fb-54, the reference and writing can be done mutually.
However, When OP0 to OP4 are wrote, these not memorized to nonvolatile memory.
Therefore, when the power supply shutdown and turn on again, OP0 to OP4 data are initialized
by Fb-50 to Fb-54.
When change data to Fb-50 to Fb-54, the data are memorized to nonvolatile memory.
Note 1: There is a delay of about between 10msec and 100msec up to becoming after it
writes it effective.
Note 2: Execution error (E45) occurs if you write the value beyond the numerical value range.
Note 3: OP0 to OP4 data range is -9999 to 99999. If you want to other limited about there
values, please do it user program.
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P(00) to P(99)
P(U(00 to P(U(15))

Variable name
Position command
variables

Numerical
value range
-2

31

to 2

31

Initial
value

Unit

0

2
pls/rev

15

Size

Attribute

2w with
sign

Read
Write

• Description
This statement sets the position command such as the mov instruction. Its unit is 1/32768
dig/rev. The forward of direction specified by forward setup FA-14 serves as positive, and the
reverse serves as negative. The encoder overflows and execution error (E45) occurs if you set
the value other than C00000000 to 40000000 (hexadecimal number) and execute an instruction
such as the mov instruction when position command variables are the absolute position encoder
and encoder type (FA-80=Abs). Initial number is set in Code Window.
P(i):
Specifies the direct position command variable. The i should be from 0 to 99.
P(U(j)): P() set forth by the value of U(j) is specified indirectly. Specify P(11) when U(j)=11.
Execution error (E45) occurs if U(j)=0 to 99 is not specified.
Note 1: Execution error (E45) occurs if overflow occurs at operation

• Usage example 1
Example of forward constant measure feed
<Code Window>
entry
MAIN: U(01)=U(00)
if P(00)<=0 then SKIP
‘Reverse constant measure feed case “<=” → “>”
U(01)=U(15)-P(00)
U(01)=U(01)-U(00)
ifs U(01)>0
‘Reverse constant measure feed case “>” → “<”
then
U(01)=U(00)
else
P(00)=U(14)+U(00)
P(00)=P(00)-2
‘’Reverse constant measure feed case” “-2” → “+2”
U(01)=U(01)*-1
end if
SKIP: P(00)=P(00)+U(01)
mov P(00) N(00) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
P(00)=3276800[pls], N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]
U(15)=7FFFFFFF{pls}, U(14)=80000001{pls}
U(00)=65536[pls] Feed quantity
< Reverse constant measure feed case >
U(14)=7FFFFFFF[pls], U(15)=80000001[pls]
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• Usage example 2
Specify a position indirectly and execute a positioning operation.
<Code Window>
entry
MAIN: wait X(11)=1
U(00)=Xw
U(00)=U(00) and 63
mov P(U(00)) N(00) ACC(0) DEC(0)
wait X(11)=0
goto MAIN
end
<Data Window>
-1
N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]
P(00) to P(63)= Prior definition necessity
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‘Acquire X() data
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‘Wait for X(11)=OFF

Chapter 6 Instruction Word Reference

Variable name
PBIAS
Position command
bias

Numerical
value range

Initial value

Unit

Size

Attribute

-128 to 128

0

pls

−

Read
Write

• Description
This statement is set when the position command bias is applied at the time of the sync
instruction and added the number of setup pulse by every 140µs. The position command bias
is used when adjusting phase at synchronization control. If a setting value is made into a
positive value, it rotates in the forward direction.

• Usage example
Phase adjustment at synchronization control
<Code Window>
entry
U(00)=100
U(01)=10
sync 2
MAIN: U(15)=Xw
U(15)=U(15) and 7
select case U(15)
case 1
PBIAS=U(00)
case 2
PBIAS=-1*U(00)
case 5
PBIAS=U(01)
case 6
PBIAS=-1*U(01)
case else
PBIAS=0
end select
goto MAIN
end

‘Rough adjustment value
‘Fine tuning value
‘Synchronization instruction

‘X(02) X(01) X(00)
‘ 0
0
1

FWD rough adjustment

‘

0

1

0

REV rough adjustment

‘

1

0

1

FWD fine tuning

‘

1

1

0

REV fine tuning

‘

Other
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Variable name
PFILT
Position command
filter (Fd-36)

Numerical
value range

Initial value

Unit

Size

Attribute

0 to 60000

0

ms

1w without
sign

Read
Write

• Description
This statement is used when a primary delay filter is set to the position command value entered
in the position control unit. Unit of this filter is 1dig=1ms. When numerical value is written by
the substitution command, not only setting value turns effective from the point, but setting value
is memorized into Fd-36 as well. Therefore, the value written in at the end is effective from the
time of a next power supply injection. Moreover, the position command filter will lose its effect if
zero is set.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing PFILT statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing PFILT statement. If you rewrite PFILT statement
during motor rotation, the machine may be damaged by the delay because of rewrite or
switch shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
<Code Window>
entry
PFILT=10
mov P(00) N(00) ACC(0) DEC(0)
end

‘Sets 10ms

<Data Window>
-1
P(00)=3276800[pls],, N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]
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Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

0

refer to
chapter 3.6

signed

Read
Write

POS
Current position
(d-08)

-2

31

to 2

31

2w

• Description
This statement can read and write the current position (d-08). Specify variable of the current
-15
position by 1dig=2 rev. The forward of direction specified by forward setup FA-14 serves as
positive, and the reverse serves as negative. When the encoder type selection (FA-80) is inC
setup, even if it overflows by 7FFFFFFF or 80000000 (hexadecimal number), ring counter
operation is carried out. Also it will be first home when the position is 0 at the time of the power
supply injection.
Note 1: Execution error (E45) occurs when overflow occurs at operation.
Note 2: The current position will be rewritten when POS is written even if encoder type
selection (FA-80) is absolute position encoder and AbS

• Usage example 1
Position attainment signal occurrence
<Code Window>
entry
mov
P(00) N(00) ACC(0) DEC(0);&
MAIN: ifs
POS>U(00)
Then
Y(00)=1
else
Y(00)=0
end if
if INP=0 then MAIN
end

If the MAIN of the code window is larger
than ‘POS U(00), Y(00) will be equal to 1.

<Date Window>
-1
P(00)=3276800[pls], N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]
U(00)=3276800/2[pls]
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LEVEL2

Numerical
value range

Variable name

PRB1H
PRB1L

Capture1 and 2

PRB2H

up edge and down
edge

PRB2L

-2

31

Initial value

Unit

Size

Attribute

0

refer to
chapter 3.6

signed

Read
Write

31

to 2 -1

2w

• Description
Capture actual position value when specific terminal PRB1 or PRB2 at input up or down edge
as shown below table.

Variable name

terminal

Edge

PRB1H
PRB1L
PRB2H
PRB2L

PRB1

On edge
Off edge
On edge
Off edge

PRB2

The maximum
detection delay time
(Tdekay)
250µS
350µS
200µS
350µS

The data are changed always when input edge signal in PRB1 or PRB2 terminal. Please judge
whether to have changed from compare copied captured data at last to U(**) with new captured
data. The edge watch timing of capture is done at the positional detection cycle.
Therefore, These data is not a moment it when the edge signal entered, and becomes data in
the positional detection processing after the PRB1 or PRB2 signal enters, and the delay occurs
as shown in the above table.
Note 1) The gap is caused in the capture data high-speed moving. Capture in low-speed
operation is recommended.
The standard of the gap ∆pulses can be calculated by the following expressions.
∆pulses = N / 60 x Tdelay x Np
-1

N: speed(min ) Tdelay: shown above table Np: pulse number of encoder
The table below shows the example of 17Bit encoder of the AD series.
-1

N(min )
ON edge delay (µS)
∆pulses
OFF edge delay (µS)
1 rotation = 32768 pulses

10
1.1
1.9

50
5.5
9.6

100
10.9
19.1

Note 2) When chattering happens, the taking mistake of the capture data is caused.
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•

Usage example

The sensor is connected with PRB1.
The servo is moved in low speed, and the position where the sensor is detected is
automatically memorized, and it makes it to the target position when driving automatically.
<Code Window>
entry
MAIN: wait X(11)=0
wait X(11)=1
if X(10)=0 then
call MAPPING
else
call AUTO_MOV
end if
goto MAIN
end

;Mapping start if X(10) is 0.
;Automatic driving if X(10) is 1.

;Subroutine mapping
sub MAPPING
mov P(98) N(14) ACC(0) DEC(0)
U(15) = -1
U(14) = PRB1L
mov P(99) N(15) ACC(0) DEC(0);&
MAP_WAIT: if INP=1 then MAP_END
U(13)=PRB1L
if U(14)<>U(13) then MAP_WAIT
inc U(15)
P(U(15))=U(13)
U(14)=U(13)
goto MAP_WAIT
MAP_END: end sub

; Move home position of Mapping.
; reset position index.
;Start mapping.
;Stack buffer of capture data
;Capture data change waiting.
; Increment position index.
;Capture data is stored in a P(**) variable.
; Old data is updated to new data.
; U(15) value is the number of captured.

;Subroutine automatic driving
sub AUTO_MOV
U(14) =0
AUTO_MAIN: mov P(U(14)) N(0) ACC(0) DEC(0)
wait 1.0
if U(15) = U(14) then AUTO_END
inc U(14)
goto AUTO_MAIN
AUTO_END: mov P(98) N(14) ACC(0) DEC(0)
end sub
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; Move to automatic driving position.
; Check move to end position.

; Move to home position.

(1)
(2)
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< description >
The figure below shows the image of the example program.
The position of the tray is senshinged, and the position is automatically memorized.
At X(11) of ON edge, Judgment behavior with X(10).
X(10)=0
Start mapping.
X(10)=1
Auto positioning.
Subroutine of mapping:
In this example, it is assumed to be a position of PRB1 OFF edge to
automatically positioning drive.
It is confirmed whether the capture data was updated by (1).
The capture position is memorized by (2) as an automatic driving position.
Subroutine automatic driving:
Only the number of data of U(15) does the positioning driving.

sensor

PRB1

6-120

Chapter 6 Instruction Word Reference

Variable name
PRF

Numerical
value range

Position command
monitor (d-07)

-2

31

to 2

Initial value

Unit

Size

0

refer to
chapter 3.6

signed

31

2w

Attribute
Read
Write
LEVEL 2

• Description
PRF variable is the monitor of position comm. Positive numerical is Forward rotation and
negative numerical is reverse by Direction of rotation (FA-14 ). (Initial value of FA-14 is "CC". It
means forward is counter clock wise in the motor axis side.) .
The overflow is not occurred in this variable at incremental encoder used or incremental mode
with absolute encoder used. And the variable becomes 0 (it is home position.) just after power
supply.
In the case of language is selected LEVEL 2 , To write a value in this variable is possible
(Please Note3 ).
Note 1: Execution error (E45) occurs when overflow occurs at operation.
Note 2: Writing is invalid when the servo driver is moved. It is necessary to wait for the operation
end. The figure below shows the instruction that rewriting this variable becomes
invalid and the end condition.
Note 3: Be care the steep movement to the position when this variable is rewritten while the
servo drive is stopping ( Just after servo on, end of moving instruction and so on).
( Only LEVEL 2 )

Instruction in which PRF writing
competition happens
Positioning command mov &

Operation end condition

Write POS timing
"stop" instruction
ends.

Synchronous control
Electric cam control

sync
cam s

Torque command
change
Torque control
Speed command

tchg

All below condition Approval
* Generate internal position ends.
* Into imposition range. (INP = ON)
Stopping just after "stop" instruction.
Stopping just after "stop" or "cam r"
instruction.
Stopping just after "stop" instruction.

trq
speed

Stopping just after "stop" instruction.
When NRF is 0 by "stop" instruction.
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•

Usage example
Example 1: Generating attainment signal of positional instruction
<Code Window>
entry
mov P(00) N(00) ACC(0) DEC(0);&
MAIN: ifs PRF>U(00)
then
Y(00) =1
else
Y(00) =0
end if
if INP=0 then MAIN
end

;Y(00) = 1 when U(00) is grater than PRF

;Branch MAIN when don't end positioning.

<Data Window>
-1
P(00) = 3276800[pls] , N(00) = 3000[min ] , ACC=1[s] , DEC(0)=1[s], U(00) = 3276800/2[pls]

Example 2 LEVEL 2 : Back farmer position after bump and stop by "mov" instruction.
<Code window>
entry
MAIN: mov P(00) N(00) ACC(0) DEC(0)
ATACK: if TFB<U(00) then ATACK

;&
; Wait bump and stop
; It is judged that it knocked against when the
; torque becomes 30% or more.
; Stop mov instruction.
; Clear position error.

stop i
PRF = POS
mov P(01) N(01) ACC(0) DEC(0)
goto MAIN
end
<Data Window>
-1
-1
P(00)=3276800[pls], P(01)=0[pls], N(00)=50[min ], N(01)=1000[min ],
ACC(0)=1[s], DEC(0)=1[s],U(00)=30*50(30% torque)
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Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

S-shaped curve ratio
(Fb-30)

0 to 3

0

−

−

Read
Write

SCV

• Description
This statement is specified when making acceleration/declaration pattern at the time of the
positioning instruction into S-shaped curve. For making acceleration/declaration pattern into Sshaped curve, its vibration becomes low. A curvilinear pattern serves as a straight line by 0 and
a number becomes large, so that curvature becomes large. When numerical value is written by
the substitution command, it is written in parameter Fb-30, and this value will be maintained
after the next power supply injection. The following table shows the relation between parameter
Fb-30 and the setting value.
Fb-30 setup

SCV setting value

non

0

SHArP

1

rEgLAr

2

LooSE

3

Note 1: Changing SCV statement is rewritten in servo lock stop state. Even if SCV change is
written in by substitution command during the mov instruction, it becomes effective
from the next mov instruction
Note 2: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
<Code Window>
entry
SCV=1
mov P(00) N(00) ACC(0) DEC(0)
end
<Date Window>
-1
P(00)=3276800[pls], N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]

6-123

Chapter 6 Instruction Word Reference

Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Speed command
filter (Fd-20)

0 to 60000

0

ms

1w without
sign

Read
Write

SFILT

• Description
This statement is used when a primary delay filter is set to the speed command value entered in
the speed control unit. Unit of this filter is 1dig=1ms. When numerical value is written by the
substitution command, not only setting value turns effective from the point, but setting value is
memorized into Fd-36 as well. Therefore, the value written in at the end is effective from the
time of a next power supply injection. Moreover, the speed command filter will lose its effect if
zero is set.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing SFILT statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing SFILT statement. If you rewrite SFILT statement
during motor rotation, the machine may be damaged by the delay because of rewrite or
switch shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
<Code Window>
entry
SFILT=10
mov P(00) N(00) ACC(0) DEC(0)
end

‘Sets 10ms

<Date Window>
-1
P(00)=3276800[pls],, N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]
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LEVEL 2
SPDG

Variable name

Numerical
value range

Initial value

Unit

1 to 10

1

−

Speed command
gain

Size

Attribute

unsigned

Read

1byte

Write

• Description
This statement can set the speed command gain for “speed” statement.
When a “speed” statement is executed, the speed variable N(j) will be automatically divided by
the value of SPDG statement.
Speed Command for “speed” statements = N(j) / SPDG
With this statement, minimum 0.1 min-1 step of speed command can be used for the “speed”
statement.
Note 1: SPDG statement is only effective for the “speed” statement.
Note 2: The actual speed can be different from the speed command as the result of the various
road specification, etc.
Note 3: The value of SPDG will be kept even after the execution of the “end” statement.
Please execute “SPDG=1” when you want to reset this function.
Note 4: This statement is available from ADAX4 series and AHF Version 6.
<Control Block Diagram>

N(j)

/

N(j)
SPDG +

Speed Control
Block

-

Speed detection value

SPDG

• Usage example
<Code Window>
entry
SPDG=10
N(00)=U(00)
speed N(00) ACC(0) DEC(0)
Wait X(00)=1
stop
end

‘ N(00) = -12345[min-1]
‘ speed command=N(00)/SPDG= -1234.5[min-1]
‘ wait until X(00) terminal turns ON

<Data Window>
ACC(0)=0.1[s]
DEC(0)=0.1[s]
U(00)=-12345
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LEVEL 2
STS

Variable name
Drive status

Numerical
value range

Initial value

Unit

0 to 5

0

−

Size

Attribute
Read

• Description
You can get inform of drive by this variable. The statuses shown blow.
STS = 0:
1:
2:
3:
4:
5:

Not servo ready (servo off).
Servo ready (servo off).
Searching magnetic pole ( Only linear driver ).
In servo on.
Waiting time of servo off (servo on).
Tripping.

• Usage example
<Code Window>
entry
MAIN:
wait
STS=1
son
NMOV: mov P(00) N(00) ACC(0) DEC(0)
if STS=3 then NORMAL
rs
goto MAIN
NORMAL: P(00)= -1*P(00)
goto NMOV

;Waiting servo ready.

;Check whether to drive normally.
;In case tripping, trip release.
;In case drive normally, change target position.
;And moving again.

< description >
Do servo on after STS is to be servo ready.
In case that a trip is occurred, trip release at first. Next servo on again by "SON" instruction,
and operate next position, and move again.
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Variable name
SZD
Zero speed
detection

Numerical
value range

Initial value

Unit

Size

Attribute

0, 1

−

−

0, 1

Read

• Description
This statement can discriminate if speed detection value is less than zero speed detection value
(Fb-22). SZD is read-only parameter and returns 0 or 1 as follows.
SZD=0: case that speed detection value is larger than zero speed detection value (Fb-22)
1: case that speed detection value is less than zero speed detection value (Fb-22)

• Usage example
<Code Window>
entry
mov
P(00) N(00) ACC(0) DEC(0); &
MAIN: Y(00)=SZD
if INP=0 then goto MAIN
end
<Date Window>
-1
-1
P(00)=327800[pls], N(00)=100[min ], N(01)=3000[min ]
ACC(0)=0.1[s], DEC(0)=0.1[s]
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T(00) to
T(15)

Variable name
Torque command
variable

Numerical
value range

Initial value

Unit

Size

Attribute

-32768 to
32767

0

%

1w with
sign

Read
Write

• Description
This statement is used to specify torque command of motion instruction such as trq or tchg..
-1
Torque variable is specified with 1dig=1min . The forward of direction specified by forward
setup FA-14 serves as positive, and the reverse serves as negative.
Note 1: Execution error (E45) occurs if you set torque command value beyond the max. torque
and specify with motion instruction although the range of the numerical value for writing
variable is possible to be set until 2w with sign of program code.

• Usage example
<Code Window>
entry
T(00)=50
trq T(00) N(00) N(01)
wait 10
end

‘50% torque

<Date Window>
-1
-1
N(00)=1000[min ] , N(01)=1000[min ]
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Variable name
TFB
Torque output

Numerical
value range

Initial value

Unit

Size

Attribute

-20000 to
20000

0

1/50
%

1w with
sign

Read

• Description
This statement can refer output torque. Its unit is 1dig=1/50%. The forward of direction
specified by forward setup FA-14 serves as positive, and the reverse serves as negative.

• Usage example
The following example shows that creation of a brake release signal with TFB parameter.
<Code Window>
entry
Y(00)=0
mov P(00) N(00) ACC(0) DEC(0);&
BRKOFF: U(01)= abs TFB
ifs U(01)<U(00) then BRKOFF
Y(00)=1
BRKON: Y(00)=SZD
if INP=1 then BRKON
Y(00)=0
end if
end

‘

‘Releases a brake
‘Waits for positioning complete
‘Puts a brake on

<Date Window>
-1
P(00)=3276800[pls], U(00)=50[%], N(00)=3000[min ]
ACC(0)=1[s], DEC(0)=1[s]
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Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Torque command
filter (Fd-06)

0 to 50000

0

0.01 ms

1w without
sign

Read
Write

TFILT

• Description
This statement is used when a primary delay filter is set to the current command value entered
in the current control unit. Unit of this filter is 1dig=0.01ms. When numerical value is written by
the substitution instruction, not only setting value turns effective from the point, but setting value
is memorized into Fd-06 as well. Therefore, the value written in at the end is effective from the
time of a next power supply injection. Moreover, the torque command filter will lose its effect if
zero is set.
Note 1: The extent of delay for about 10 to 100ms may occur after substituting until inertia
moment becomes actually effective.
Note 2: Changing TFILT statement is rewritten in servo lock stop state. Internal control gain
changes to step state by changing TFILT statement. If you rewrite TFILT statement
during motor rotation, the machine may be damaged by the delay because of rewrite or
switch shock, and the like.
Note 3: Execution error (E45) may occur if you write the value beyond the setting range. It is
necessary to change the program within the setting range.

• Usage example
<Code Window>
entry
TFILT=1000
mov P(00) N(00) ACC(0) DEC(0)
end

‘Sets 10ms

<Date Window>
-1
P(00)=3276800[pls],, N(00)=3000[min ], ACC(0)=1[s], DEC(0)=1[s]
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LEVEL 2
TIMER1

Variable name
Free running timer

Numerical
value range

Initial value

Unit

0

By 4ms

31

0 to 2 -1

Size

Attribute

unsigned

Read
Write

2w

• Description
31

This variable increases at each 4msec, and returns to 0 when it exceeds 2 -1.
In fact, it operates as a free running timer in 31 bits.
You can manage by adjusting this value to 0 first, and monitoring becoming the value for which
you hope at the time of each 4ms.
Note 1: 4ms is management time among a servo driver, and it is not completely accurate.
When this variable is counted to a big value, the error margin is caused.
Therefore, this variable cannot be used in a long time by the application for which the
accurate time management is necessary.
Note 2: This variable increases at Program mode (FA-22=Pro), and the running state of the
user program is not related.
Therefore, please initialize it when you use this variable.

• Usage example
Change pressing torque as time passes.
<Code Window>
entry
MAINT:
wait X(11)=1
mov P(00) N(00) ACC(0) DEC(0) ;&
SETPOS:
if X(11)=0 then GOHOME
if INP=0 then SETTOP
TIMER1=0
trq T(00) N(01) N(02)
PUSHTRQ1: if X(11)=0 then GOHOME
if TIMER1<U(00) then goto PUSHTRQ1
trq T(01) N(01) N(02)
PUSHTRQ2: if X(11)=0 then GOHOME
if TIMER1<U(01) then PUSHTRQ2
trq T(02) N(01) N(02)
PUSHTRQ3: if X(11)=0 then GOHOME
if TIMER1<U(02) then PUSHTRQ3
GOHOME: stop
mov P(01) N(00) ACC(0) DEC(0)
go to MAIN
end

;move to pressing position.
;if X(11) is to be 1, abort program.
; Waiting imposition.
; Initialize timer.
;Start pressing by T(00).
; if X(11) is to be 1, abort program.
; Waiting of passage of U(00)*4ms time.
; Start pressing by T(01).
; Waiting of passage of U(01)*4ms time.
;Start pressing by T(01).
; Waiting of passage of U(01)*4ms time.

<Date Window>
P(00)=327680[pls], P(01)=0[pls], N(00)=1000[min-1], N(01)=100[min-1], N(02)=100[min-1]
ACC(0) = 0.1[s], DEC(0)=0.1[s], T(00)=10*50, T(01)=20*50, T(03)=30*50
U(00)=10, U(01)=30, U(02)=50
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TLM
TLM(0) to
TLM(3)

Variable name

Numerical
value range

Initial value

Unit

Size

Attribute

Torque limit variable
(Fd-07 to Fb-10)

0 to max.
torque × 50

15000

1/50%

1w without
sign

Read
Write

• Description
This statement sets the torque limit value, and data without sign whose setting unit is
1dig=1/50%. TLM to TLM(3) are operated as follows. See the following diagram as well.
TLM:
Bulk sets torque limits of four quadrants (Write Fb-07 to Fb-10)
TLM(0): Sets individually a torque limit of forward direction and forward torque (Write Fb-07)
TLM(1): Sets individually a torque limit of reverse direction and forward torque (Write Fb-08)
TLM(2): Sets individually a torque limit of reverse direction and reverse torque (Write Fb-09)
TLM(3): Sets individually a torque limit of forward direction and reverse torque (Write Fb-10)
When NLM to NLM(3) are written by the substitution instruction, the above parameters are
written in command. However, these are not memorized in Fb-07 to Fb-10. Set data returns to
an initial value when the power supply is shut downed. Execute the torque limit all at once
regardless of accelerate/decelerate time if starting the speed limit during a motion operation.
Writing NLM to NLM(3) by the substitution instruction makes them have the absolute value of
setup value, and save them in parameter Fb-07 to Fb-10. Therefore, the different polarity from
the specified sign may be read at substitution instruction.
Note 1: It is about 10 to 100msec late until becoming effective to set the value.
In the case of selected LEVEL2 , a torque limit starts rapidly at the next step of user
program after writing them.
Note 2: If you execute a torque limit during the motion instruction such as speed or the mov
instruction, the torque limit starts rapidly so that trip may occurs because of speed error
fault (84), position error fault (E83) and overspeed error (E85) and the like.
Note 3: When you write numerical value of less than 50 from NLM to NML(3), the writing value
is 0.

• Usage example
The example, which executes a torque limit, is show below.
<Code Window>
entry
MAIN: U(00)=XA(0)
U(00)=U(00)*T(01)
T(00)=U(00)/10000
TLM=T(00)
speed N(01) ACC(0) DEC(0)
goto MAIN
end
<Date Window>
T(01)=15000
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Variable name
TRF
Current torque
command

Numerical
value range

Initial value

Unit

Size

Attribute

-400 to 400

0

1/50%

1w with
sign

Read

• Description
This statement can refer the torque command during operation. Its unit is 1dig=1/50%. The
forward of direction specified by forward setup FA-14 serves as positive, and the reverse serves
as negative. You can refer the torque command before executing a torque limit and covering
the torque command filter.

• Usage example
The following example shows that creation of a brake release signal with TRF parameter.
<Code Window>
entry
Y(00)=0
mov P(00) N(00) ACC(0) DEC(0);&
BRKOFF: U(01)= abs TRF
ifs U(01)<U(00) then BRKOFF
Y(00)=1
BRKON: Y(00)=SZD
if INP=1 then BRKON
Y(00)=0
end if
end

‘

‘Releases a brake
‘Waits for positioning complete
‘Puts a brake on

<Date Window>
-1
P(00)=3276800[pls], U(00)=50[%], N(00)=3000[min ]
-1
-1
N(00)=3000[min ], N(01)=3000[min ], ACC(0)=0[s], DEC(0)=0[s]
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U(00) to
U(15)

Variable name
User variable

Numerical
value range
-2

31

to 2

Initial value

Unit

Size

Attribute

0

−

2w with
sign

Read
Write

31

• Description
This statement is a variable for user to use in general-purpose. As temporary memory like
arithmetic operation, you can use this variable. Without being conscious of variable forms, such
as a position and speed, you can use them as a variable of 2 words with a sign.
Note 1: Execution error (E45) occurs if overflow occurs at operation of the four fundamental
process of arithmetic.

• Usage example
Positioning of rotation coordinates specification of a table
<Code Window>
entry
chgORL=X(10)
U(14)=U(15)/2
‘Operates 180 degree data
P(00)=0
ort 0 N(00) ACC(0) DEC(0)
‘Achieves homing
MAIN: wait X(11)=1
wait X(11)=0
U(00)=Xw
‘Specifies a table one by one
U(00)=U(00) and 511
ifs U(00)>=U(13)
‘Operates limiter at 360 degree or more
then
U(00)=U(13)
end if
U(01)=U(15)*U(00)
U(01)=U(01)/360
‘Creates the instruction position in one rotation
U(02)=P(00) mod U(15)
‘Creates the instruction position in one rotation
of .the last position
ifs U(01)=U(02) then MAIN
U(01)=U(01)-U(02)
‘Calculates the amount of movements
U(02)= abs U(01)
P(00)=P(00)+U(01)
ifs U(02)>U(14)
‘Selects a shortcut
then
ifs U(01)>0
‘Discriminates a rotation direction
then
P(00)=P(00)-U(15)
‘Returns by one rotation.
else
P(00)=P(00)+U(15)
‘Proceeds by one rotation.
end if
end if
mov P(00) N(00) ACC(0) DEC(0)
goto MAIN
end
<Date Window>
U(15)=3276800[pls]
… The number of encoder pulses of table one rotation
-1
N(00)=3000[min ], ACC(0)=0.1[s], DEC(0)=0.1[s]
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CONTROL (RS-232C) AND
MODBUS
COMMUNICATION
This chapter describes communication control (RS-232C) and the MODBUS communication of
option function.

7.1 Communication Control (RS-232C) ........................ 7-2
7.2 MODBUS Communication and
All Variables ,Input/Output Terminals .................... 7-8
7.3 Servo ON by MODBUS Communication ................ 7-8
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7.1

Communication Control

open com statement

Communication port(RS-232C) use declaration

• Format
Format
open com

Operation overview
Declares to use the communication port

• Description
Declares to use the communication port after executing this instruction. For this reason,
transmission instruction, reception instruction and reception status variable become available.
Note 1: Use end declaration instruction is not prepared. Automatically open the communication
port by execution termination with Servo OFF.
Note 2: For connection between Servo drive and RS-232C(PC), see the item described in
“Appendix personal computer connection cable” of this instruction manual of program
operation function Servo drive.

• Usage example
<Code Window>
entry
open com
end

The main program ends.
The main program ends.

<Description>
Declares to be able to access the communication port from a user program.
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print # statement

Data output from the communication port(RS-232C)

• Format
Format
print #0 <Variable>
print #1 <Variable>
print #2 <Variable>

Operation overview
Outputs variable specified to the communication command 80H
from Servo drive.
Outputs variable specified to the communication command 81H
from Servo drive.
Outputs variable specified to the communication command 82H
from Servo drive.

• Description
Communication command 80 to 82H outputs serially specified variable through RS-232C.
Variable transmission is transmitted with a signed long format (4 bytes). Variable such as byte
data is converted automatically to a long form. print command does not move to the next line
procedure of the program operation before completing data transmission. Transmission time
varies with the setting of communication baud rate, stop bit and start bit. The following is the
time required for transmission only. Further, process delay is added to the transmission time.
Communication format is described at next page.
Example:
Baud rate 19200bps, 8bits, stop bit 2, no parity
(1+8+2+0) × 16/19200=9.17ms
#0 to #2:
Specifies the communication command. #0 corresponds with 80H and #2
corresponds with 82H.
<Variable>: Specifies variable name entered numerical value to be output from RS-232C.

• Usage example
<Code Window>
entry
open com
U(15)=65536
print #0 P(00)
U(00)=N(00)*U(15)
U(00)=U(00)+ACC(0)
print #1 U(00)
U(01)=Xw
print #2 U(01)
end

Transmits ‘positioning instruction

Transmits ‘speed instruction (high-order) and
acceleration/declaration time (low-order)
Transmits ‘terminal information

<Data Window>
-1
P(00)=32768 [pls] , N(00)=3000[min ] , ACC(0)=0.10[s] (0.01s=1dig)
<Description>
The communication output of positioning instruction, acceleration/declaration time, speed
instruction and input terminal information is provided.
Communication command 80H data…positioning instruction
Communication command 81H data…high order 16 bits: speed instruction
Low order 16 bits…acceleration/declaration time
Communication command 82H data…input terminal information
Speed
instruction
16 bits
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Communication format by print instruction

1
STX
Example: 02

2

2

8

2

1

3031H

Command

Variable

BCC

CR

30 31

38 30

46 46 46 46 46 42 32 45

37 41

0D

Number of byte

ASCII characters converting numerical number to
hexadecimal number
Example: -1234 case
FFFF FB2EH → 46 46 46 46 46 42 32 45
(hexadecimal number)
80H: 38H and 30H converting print #0 to ASCII character
81H: 38H and 31H converting print #1 to ASCII character
82H: 38H and 32H converting print #2 to ASCII character

BBC: Exclusive OR of byte data right before second data (30H) to BCC.
Example: BCC=30 ⊕ 31 ⊕ 38 ⊕ 30 ⊕ 46 ⊕ 46 ⊕ 46 ⊕ 46 ⊕ 46 ⊕ 42 ⊕ 32 ⊕ 45= 7AH
Characterize 7A and converts 37H 41H to BCC

The following table shows the available character code.
High order
Low order

0

1

2

3

0

0

1

1

2

STX

4

A

2

B

3

3

C

4

4

D

5

5

E

6

6

F

7

7

8

8

9

9

A
B
C
D

CR

E
F

Note: Available character code is in common with print # and input # instructions
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input # statement

Inputs data from communication port (RS-232C)

• Format
Format
input #0 <Variable>
input #1 <Variable>
input #2 <Variable>

Operation overview
Inputs variable of communication command 90H to the specified
variable
Inputs variable of communication command 91H to the specified
variable
Inputs variable of communication command 92H to the specified
variable

• Description
Communication command 90 to 92H inputs serially variable to the specified variable through
RS-232C. Variable reception is input with a signed long format (4 bytes). input command does
not move to the next line procedure of the program operation before receiving new data. You
can check if new reception data is entered by LOC function. When new reception data has
entered, substitute input value to variable and move to the next line procedure of the program
operation. When new reception data is input one after another, old reception data is overwritten
to new data.
#0 to #2:
Specifies communication command. #0 corresponds with 90h and #2 corresponds
with 92H.
<Variable>: Specifies variable name to be input from RS-232C.

• Usage example
<Code Window>
entry
open com
U(15)=65536
MAIN input #1 P(00)
input #2 U(00)
N(00)=U(00)/U(15)
ACC(0)=U(00) mod U(15)
DEC(0)=ACC(0)
mov P(00) N(00) ACC(0) DEC(0)
goto MAIN
end
<Description>
Positioning operation starts as soon as the following data is input to Servo drive from SR232C (PC).
Communication command 91H data…positioning instruction
Communication command 92H data…high order 16 bits: speed instruction
low order: acceleration and declaration time
Speed
instruction
16 bits
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Communication format by print instruction

1

2

2

8

2

1

BCC

CR

37 42

0D

STX

3031H

Command

Variable

02

30 31

39 30

46 46 46 46 46 42 32 45

Number of byte

ASCII characters converting numerical number to
hexadecimal number
Example: -1234 case
FFFF FB2EH → 46 46 46 46 46 42 32 45
(hexadecimal number)
90H: 39H and 30H converting print #0 to ASCII character
91H: 39H and 31H converting print #1 to ASCII character
92H: 39H and 32H converting print #2 to ASCII character

BBC: Exclusive OR of byte data right before second data (30H) to BCC.
Example: BCC=30 ⊕ 31 ⊕ 39 ⊕ 30 ⊕ 46 ⊕ 46 ⊕ 46 ⊕ 46 ⊕ 46 ⊕ 42 ⊕ 32 ⊕ 45=7BH
Characterize 7B and converts 37H 42H to BCC
The following table describes in explanation of print # instruction.
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LOC function

Reception distinction of communication port (RS-232C)

• Format
Format
LOC(0)

LOC(1)

LOC(2)

Operation overview
Returns 1 when new data is received with communication command 90H, or
returns 0 when new data is not received or is readout with input #0 after new
data is received.
Returns 1 when new data is received with communication command 91H, or
returns 0 when new data is not received or is readout with input #1 after new
data is received.
Returns 1 when new data is received with communication command 92H, or
returns 0 when new data is not received or is readout with input #2 after new
data is received.

• Description
This LOC function discriminates if new reception data is updated with communication command
90 to 92H. Returns 1 when new data has been received and is not readout with input #
command. Returns o when new data has not been received, or is readout with input #
command after new data. This function returns variable to each command (90H to 92)
individually.

• Usage example
<Code Window>
entry
open com
SWAIT if LOC(0)=1 then MOVGO
Y(0)=0
wait 0.1
Y(0)=1
wait 0.1
goto SWAIT
MOVGO input #1 P(00)
mov P(00) N(00) ACC(0) DEC(0)
goto SWAIT
end

Waits for ‘reception

Inputs ‘data and starts operation.

<Description>
This function monitors communication command 90H and reverses Y(00) terminal until it is
input.
When communication command 90H has been input, positioning operation for this data
would start as positioning instruction.

7-7

Chapter 7 Communication Control (RS232C) and MODBUS Communication

The following content is targeted in the servo driver with the MODBUS communication
option.

7.2

MODBUS Communication and All Variables ,Input/Output Terminals
It is possible to write and refer all variables(The reservation variable is included) that can
be used by the program operation as a register of MODBUS. (Partially, it is not possible
to write it. ) Moreover, the I/O terminal can be set, and be reset as a coil of MODBUS.
Please refer to the manual of the servo driver with these assignments.
Note 1) Writing becomes postscript priority in principle. Please do not write it from both
the program and MODBUS communication.

7.3

Servo ON by MODBUS Communication
As for servo ON from the program and MODBUS ccommunication, the operation is
limited by SON statement command source selection (FP-43) as shown in the table
below.
parameter parameter settings
explanation
No
name
[default]
FP-43
SON
Pro,
The command source of “SON” statement can be
statement
OP,
selectable.
command
botH
Setting
Operation
source
[Pro]
Pro
Only
the
SON
command
from the user
selection
program is effective.
OP
Only the SON command from MODBUS
communication is effective.
botH
Only the SON command from both the
user program and MODBUS
communication is effective.
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Program state

RUN terminal effective

Running

Not
running

son execution
source

Pro

OP

botH

program (SON)

Execute SON

E46 occur

Execute SON

program(SOFF)

Execute SOFF

Execute SOFF

Execute SOFF

Modbus(SON)

in SON

in SOFF

Execute SON

Execute SON

Error
response

E46 occur

Normally response

Normally response
Execute SOFF

Execute SOFF

Execute SOFF

Normally response

Normally response

Normally response

Modbus(SON)

Not execute SON

Not execute SON

Not execute SON

Error response

Error response

Error response
Not execute SOFF

SON terminal effective

Not execute SOFF

Not execute SOFF

Error response

Error response

Error response

Command nothing

Command nothing

Command nothing

program(SOFF)

Command nothing

Command nothing

Command nothing

Modbus(SON)

Not execute SON

Not execute SON

Not execute SON

Error response

Error response

Error response
Not execute SOFF

program (SON)

Modbus(SOFF)
Not
running

Error response

Modbus(SOFF)

Modbus(SOFF)
Running

FP-43 setting

Modbus(SON)
Modbus(SOFF)

Not execute SOFF

Not execute SOFF

Error response

Error response

Error response

Not execute SON

Not execute SON

Not execute SON

Error response

Error response

Error response

Not execute SOFF

Not execute SOFF

Not execute SOFF

Error response

Error response

Error response
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CHAPTER 8 PROTECTION DURING
ERROR AND
TROUBLESHOOTING
This chapter describes the protection contents added by programming and appropriate action
during display error.

8.1 List of Protection in Program Operation.................. 8-2
8.2 Appropriate Action in Error...................................... 8-3
8.3 Contents of Error and Action in Compiling.............. 8-6
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8.1

List of Protection during Program Operation
The following table shows a protection list peculiar to program operation.
For other error, see “Servo drive with program operation in AD series” described in the
instruction manual.
No.
1

Name of function
Invalid instruction error

2

Nesting error

3

Execution error

Error display
E43

E44
E45
Note 1)

Contents of error
E43 is displayed when there is a code not
corresponded with the instruction in downloaded
program. When the terminal SON is turned on with no
program or destroyed program, E43 is displayed.
E44 is displayed when nesting such as the subroutine,
for and next exceeds eight levels.
• E45 is displayed when there is no nesting start such
as the for in the jump place of the goto and
preceded with the nesting end of the next etc.
• E45 is displayed when there is no applicable
variable at double reference of “P(U(xx)) etc.
• E45 is displayed when there is a default format by
first-time motion instruction after executing the entry
instruction.
• E45 is displayed when the speed command is
specified to 0 by the mov instruction.
• E45 is displayed when the position command is
specified to be P(Xn) by the mov instruction and
X(00) to X(11) is 0.
• E45 is displayed when a position command is 0 in
the smov instruction.
• E45 is displayed when a speed limit value is 0 in the
trq and tchg instructions.
• E45 is displayed when overflow and underflow
occur in four-arithmetical-operation instruction or 0
division occurs.
• E45 is displayed when a write value is beyond the
control variable setup range in control variable
writing.

Note 1) The detailed content of execution error (E45) can be confirmed with program
error information (d-46) in function enhancing version servo driver (ADAX4). Please refer
to "8.2(2)" for details.
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8.2

Appropriate Action in Error
This section describes an appropriate action in error peculiar to program operation.
For other error, see “Servo drive with program operation in AD series” described in the
instruction manual.
(1) Trip number
Trip
Name of trip
number
E43
Invalid
instruction
error

E44

Nesting error

E45

Execution
error

Cause

The contents of check

• Turn ON servo without
uploading a program.
• A program on the
memory of subroutine
was destroyed.
• The nesting level of the
subroutine exceeded 8.
• The nesting level of the
for-next exceeded 8.
• The nesting level of the
if exceeded 8.
• For end instruction
(next) etc. were
executed in the jump
destination of "goto".
• No applicable variable
at double reference of
“P(U(xx)) etc.

• The mov or nchg
instruction specify the
speed command 0.

Check if a program read
from the servo drive is
accordant with a original
program.

Recreate a program and
reload it to the servo
drive.

The nesting level of a
program is checked
visually.

Modify a program so as
to be 8 levels or less.

･ It is confirmed whether
there is nest end
instruction at the jump
destination of goto.
• Check a numerical
variable of U(xx).

• The jump destination
is corrected.

• Check a numerical
variable of N(xx).

• There is a default format • Check the motion
by first-time motion
instruction using a
instruction after
default format.
executing the entry
instruction.
• When the position
• Check a status of X(00)
command is specified to
to X(11).
be P(Xn) by the mov
instruction, X(00) to
X(11) is 0.
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Appropriate action

• Limit the range for
U(xx) value not to
exceed the range of
U(xx) value or modify
the appropriate value
for U(xx).
• The speed command
is programmed so as
not to be 0 in the mov
or nchg instruction.
• The program is
changed so as to stop
the default format.

• When the position
command is P(Xn),
the position command
value is specified by
either of X(00) -X(11).
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Trip
Name of trip
number
E45
Invalid
instruction
error

Cause

The contents of check

• The position command
value is set to 0 in the
smov instruction

• Check a position
command value.

• The speed limit value is • Check a speed limit
set to 0 in the trq or tchg
value.
instruction.
• Overflow and underflow • Check if there are any
occurred in fourinstructions which may
arithmetical-operation
generate the division by
command or 0 division
overflow, underflow and
occurred.
0.
• A write value is beyond • Check a write value.
the control variable
setup range in control
variable writing.

E46

Invalid SON
command
error

• When already assigned
to a special terminal by
the chg instruction, it
assigned it to another
terminal again.

• The program is
confirmed, and the
terminal number and the
function name are
confirmed.

• The SON command
was executed from the
place different from the
setting of FP-43.

• It is confirmed whether
the place of the SON
instruction execution
origin and the FP-43
parameter is the same.
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Appropriate action
• A program is changed
so that a position
instruction value may
not be set to 0.
• A program is changed
so that a speed limit
may not be set to 0.
• A program is prepared
so that overflow,
underflow and 0 may
not to be occurred
division.
• A program is prepared
so that a write value
may be within the
control variable setup
range.
• The program is
corrected.

• The setting of FP-43 is
correctly set.
• The program is
corrected. Or
specification from
MODBUS is
corrected.
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(2) Program error information (d-46)
The content of the execution error that occurred at the end can be confirmed with
program error information (d-46) for the servo driver that corresponds to language
LEVEL2 ( LEVEL2 ). The content is shown on the next page.
The content of "Program error information"(d-46).
Monitor
No.

Monitor name

Indication range

Contents

0~14

The detailed content of execution error
(E45) that occurred at the end when
the program is running is displayed.

code
0
1
2
3
4
5
d-46

program
error
information

6
7
8
9
10
11
12
13
14

means of error
no error
Nest finish instruction (e.g next) is found
without nest start instruction (e.g for).
No applicable variable at double reference of
“P(U(xx)) etc.
There is a default format by first-time motion
instruction after executing the entry instruction.
The mov or nchg instruction specify the speed
command 0.
When the position command is specified to be
P(Xn) by the mov instruction, X(00) to X(11) is
0.
The position command value is set to 0 in the
smov instruction.
The speed limit value is set to 0 in the trq or
tchg instruction.
Overflow and underflow occurred in fourarithmetical-operation command.
0 division occurred.
A write value is beyond the control variable
setup range in control variable writing.
terminal function is already allocated by chg
instruction
Communication port is not opened.
Cam instruction is executed before restore
instruction is executed.
Critical error.

Note ) This content is not memorized.

(3) Error line monitor (d-47)
The execution error (E45) and the execution address of and the trip occurrence can be
confirmed by (d-47). According to the procedure of "5.14 Function to display step where
error occurs ", the number of execution steps can be displayed based on this address.
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8.3

Contents of Error and Action in Compiling
The following table shows editor numbers and the contents (actions) compiled by a
program editor.

Err No
Message
1
”No entry at the head of Code Window!!”
2
No end of subroutine exits!!”

3
4
5

”No specification of subroutine name!!”
”Subroutine name is duplicated!!”
”No end sub of subroutine exits!!”

6
7
15

”An instruction has already exited before the start
line of subroutine!!”
”Label name is duplicated!!”
”Parameter of motion instruction is error!!”

103
105

“Parameter for the position command is error!!”
“Parameter for a speed command is error!!”
“Parameter for the acceleration time command is
error!!”
“Parameter for the declaration time command is
error!!”
“Parameter for the torque command is error!!”
”No associated subroutine name!!”
”No associated label name!!”
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Contents (Actions)
No entry at the head of Code Window
Entry is duplicated
Subroutine starts without end
End sub exists instead of end
No end of subroutine exit
No subroutine name is specified
The same subroutine name is duplicated.
No end sub of subroutine exits.
‘Entry is duplicated.
Subroutine starts without end.
End exits instead of end sub.
An instruction other than “sub” exits after “end”/”end
sub”.
The same label name is duplicated and declared.
Parallel execution specification of motion instruction is
error
Parameter for the position command is error
Parameter for the speed command is error
Parameter for the acceleration time command is error
Parameter for the declaration time command is error
Parameter for the torque command is error
No subroutine name of sub statement.
No label corresponded with the label name of the goto
statement.
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Err No
Message
107 ”An instruction exists in the position which
cannot be compiled!!”
“Comparison sign is error!!”
“Comparison data is error!!”

“Comparison instruction is error!!”

“Corresponding instruction!!”
108

“Comparison sign is error!!”
”No associated label name!!”
“Comparison data is error!!”

110

112

”No associated label name!!”
”An instruction exists in the position which
cannot be compiled!!”
“Comparison sign is error!!”
“Start variable is error!!”
“Start value is error!!”
“The end value is error!!”
“Step value is error!!”
“The for loop instruction is error!!”
“No next instruction corresponding with for!!”
“No for instruction corresponding with next!!”
”An instruction exists in the position which
cannot be compiled”
“Comparison sign is error”
“Comparison data is error”
“The while loop instruction is error”
“No wend corresponding with while”
“No while instruction corresponding with
next”

Contents (Actions)
Pneumonic field in the right column of
“if(s)”/”then”/”else”/”end if” is not null
Comparison sign of the structured if statement is error
Comparison variable of the structured if statement is error
Comparison real number of the structured if statement is
outside of the range
An instruction other than the “then”/”else” exists underneath
the line of “if(s)” in the structured if statement
The “then”/”else”/”end if” instruction exist underneath the
line of “then” in the structured if statement
The “then”/”else”/”end if” instruction exist underneath the
line of “else” in the structured if statement
The “then” instruction exists before the “else”/”end if”
instructions below the line of “then” in the structured if
statement
The “then”/”else”/”end if” instruction exist underneath the
line of “else” in the structured if statement
The “then”/”else” instruction exist before the ”end if”
instruction below the line of “else” in the structured if
statement
The “if(s)” instruction corresponding with the “else” does not
exit
Comparison sign of the if statement is error
The label corresponding with the label name of the if
statement does not exit
Comparison variable of the if statement is error
Comparison real number of the structured if statement is
outside of the range
Existence check of the label name in the if structure
Pneumonic field in the right column of “for”/”next” is not null
Comparison sign of the for statement is error
Start variable of the for statement is error
Start value of the for statement is error
The end value of the for statement is error
The step value of the for statement is error
The “next” instruction exists beneath the line of “for”
The “next” instruction corresponding with “for” does not exist
The “for” instruction corresponding with “next” does not exist
Pneumonic field in the right column of “while”/”wend” is not
null
Comparison sign of the for statement is error
Comparison variable of the while statement is error
Comparison real number of the while statement is error
The “wend” instruction exists beneath the line of “while”
The “wend” instruction corresponding with “while” does not
exist
The “while” instruction corresponding with “wend” does not
exist

8-7

Chapter 8 Protection during Error and Troubleshooting

Err No
Message
113 ”An instruction exists in the position which
cannot be compiled!!”
“Comparison sign is error!!”
“Comparison data is error!!”

114

“The until loop instruction is error!!”
“No loop instruction corresponding with
until!!”
“No until instruction corresponding with
loop!!”
”An instruction exists in the position which
cannot be compiled”
“Comparison data is error!!”
“Select case instruction is error!!”

115

“No end select instruction corresponding
with the select case!!”
”No corresponding instruction!!”

116

”No associated subroutine name!!”

117
118
123

“Variable is error!!”
“Variable is error!!”
”The wait time is error!!”
“Comparison variable is error!!”

208
211
213
303

“Comparison sign is error!!”
”Parameter is error!!”
“Parameter is error!!”
“Parameter is error!!”
”The operator is error!!”
“The numerical number is set to the
parameter!!”
“Parameter is error!!”

Contents (Actions)
Pneumonic field in the right column of ”until”/”loop” is not
null
Comparison sign of the until statement is error.
Comparison variable of the until statement is error.
Comparison real number of the until statement is error.
The “loop” instruction exists beneath the line of “until”
The “loop” instruction corresponding with the “until” does not
exist
The “until” instruction corresponding with the “loop” does not
exist
Pneumonic field in the right column of ”select
case”/”case”/”case else”/”end select” is not null
Comparison variable of the select case statement is error
Comparison variable of the case statement is error
An instruction other than the “case” exists underneath the
line of “select case” in the structured if statement
The “case”/”case else”/”end select” instruction exist
underneath the line of “case” in the structured if statement
The “case”/”case else”/”end select” instruction exist
underneath the line of “case else” in the structured if
statement
The “case”/”case else” instruction exist below the line of
“case else”
The “end select” instruction corresponding with “select case”
does not exist
The “select case” instruction corresponding with “case” does
not exit
The “select case” instruction corresponding with “case else”
does not exit
The “select case” instruction corresponding with “end select”
does not exit
The subroutine corresponding with the subroutine name of
the go sub statement
Variable of the inc statement is error
Variable of the dec statement is error
The wait time of the wait statement is error
“Comparison variable of the wait statement is error!!”
“Comparison real number of the wait statement is error!!”
“Comparison sign of the wait statement is error!!”
The rise/fall specification of the smov statement is error
Specifying the existence of the speed offset of the synv
statement is error
Return mode specification of the ort statement is error
The operator other than “=” at the contact output operator
The real number is specified to the contact output
Variable setting to the contact output is error
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Err No
Message
301 ”Variable is error!!”
“Operator is error!!”
305

“Operator is error!!”
“Parameter is error!!”

400

401
402

2048
2049
2050

“Variable is error!!”
“Operator is error!!”
“The numerical number is set to the
pneumonic!!”
“The instruction is error!!”
”The numerical number is set to the
pneumonic string!!”
”The instruction is error!!”

”The level of nesting is too deep”
”The total step number of intermediate code
exceeds 512 lines”
”Compiler detects the error”

Contents (Actions)
Variable setting to the contact input is error
The operator other than “=” exists at the contact input
operator
The operator other than “=” exists at the special terminal
allocation modification operator
Variable setting to the special terminal allocation
modification is error
Variable of arithmetic is error
Operator is error
The real number exists in pneumonic string
Incorrect character string exists in pneumonic string
The numerical number exists in the pneumonic string
The data, which is neither instruction nor variable, exists in
the pneumonic string
Parameter exists in the line without instruction in the
pneumonic string
The level of nesting exceeds the maximum level.-+
The total step number exceeds the maximum number of line
Error was detected in the compile process
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